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Chapter 1

Introducing the Munsys Management Console User Manual

Introduction

The Munsys Management Console is a standalone application that allows users with relevant
privileges to manipulate objects and components within a Munsys schema in a structured and
user-friendly way.

The Munsys Management Console can be activated by any authorized database user, but the
functionality that will be available to a user is dependent on the roles that have been assigned
to the user.

The following components can be managed from the Munsys Management Console:

The Munsys Schema — creating, dropping, exporting, importing and validating a schema
(including importing demo data).

Applications — used to manage Munsys application settings

Locks — used to maintain record/object locking

Query Categories — used to maintain query categories and query privileges

Security — used to manage users and roles

Privilege — used to assign roles to tables and views

Tables/Views — maintenance of Munsys-related spatial tables, lookup tables and indexes

Lineage — used primarily to implement triggers in the Oracle database to track and archive
changes made to records in spatial tables

Scheduled Tasks — Used to manage and optimize Scheduled Tasks



What’s in this manual

The Munsys Management Console User Manual consists of the following chapters:

Chapter 1 — Welcome to the Munsys Management Console User Manual gives an overview of this
manual, and provides the typographical conventions used throughout the Munsys documentation
set.

Chapter 2 — Getting acquainted with the Munsys Management Console gives an overview of the
concepts of the application.

Chapter 3 — Managing the Munsys Schema discusses the various schema management options in
the Munsys Management console.

Chapter 4 — Import Demo Data shows the administrator how to add modify or delete Munsys demo
data within the Munsys Management Console.

Chapter 5 — Working With Munsys Applications shows the administrator how to add modify or
delete Application settings within the Munsys Management Console.

Chapter 6 — Record locking describes record locking management in the Munsys Management
Console.

Chapter 7 — Query Categories describes the concept of query categories and query category
management in the Munsys Management Console.

Chapter 8 — Security in the Munsys Management Console describes the creation and maintenance
of database users and roles.

Chapter 9 — Privilege describes the maintenance of all Munsys spatial and lookup tables, as well as
indexing.

Chapter 10 — Working With tables and indexes describes the maintenance of all Munsys spatial,
lookup and attribute tables as well as indexing,.

Chapter 11 — Munsys Lineage describes the creation and maintenance of lineage.

Chapter 12 — Scheduled Tasks describes the creation and maintenance of database scheduled tasks.

Conventions in this manual

The following table lists the typographical conventions used in this manual.

Text element ‘ Example

Keys you press on the keyboard CTRL, ENTER, DEL

Screen buttons Click Close.

Folder paths C:\Program Files\Open Spatial
Menu paths choose File > Validate Schema.
Hypertext links to more information http://www.openspatial.com

Dialog box/screen names The New Query Category dialog box
Application functions The Validate Schema function

Table 1 Munsys typographical conventions
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Finding the information you need
To get help on

general issues, select Help from the Munsys Management Console menu bar.
an operation in progress, click the Help button on the dialog box.

the latest support options, visit http://www.openspatial.com
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Chapter 2

I?ﬁ:tting acquainted with the Munsys Management Console

Introduction

This chapter provides an introduction to the Munsys Management Console interface, as well
as the way that the Console is structured. You will also be shown how to start the Munsys
Management console and connect to the database.



Munsys Management Console structure

The Munsys Management Console consists of a window divided into two panes: the Tree Pane
and the Content Pane.

The left pane (the tree pane) shows the main components supported by the MMC.

Figure 1

The Munsys Management Console content pane contains the following components:

H Munsys Management Console (MCITY15INT)

{38 Applications

File Action  Help

----- {';5 General Settings
-3 CFS - Cable Fiber
[j--fi_.' CM5 - Cadastral
[-{38 CRS - Cable Route
EJ"ii' DMS - Drainage
G-{3 EMS - Electricity
#-(38 MBK - Map Books
£

£

£

£

H-(30 QRY - Query
5-{38 RMS - Roads
]--fi_.' 5DM - Spatial Data Manager
o-(8 SMS - Sewer

{38 WMS - Water

jﬂl Locks

]...133,' Query Categoeries
]:D Security

j% Privilege

B Tables/Views
% Lineage

) Scheduled Tasks

Tree Pane

Applications
Locks

Query Categories
Security

Privilege
Tables/Views
Lineage

Scheduled tasks

----- 4% General Settings
H-{38 CFS - Cable Fiber
7-(38 CMS - Cadastral
o-(38 CRS - Cable Route
H-{38 DMS - Drainage
{38 EMS - Electricity
7130 MBK - Map Books
7-(38 QRY - Query
H-{38 RMS - Roads
:l"ii' S5DM - Spatial Data Manager
o[ SMS - Sewer

(8 WMS - Water

Munsys Management Console: Tree Pane
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The right pane (the content pane) contains the content of the function that has been selected

in the tree pane.

Ei Munsys Management Console (MCITY15IMT]

File Action  Help

ey

@30 Applications

B} Locks
[y .
-5 Query Categories
5 Categories !

g Security
[]—-% Privilege
-y Tables/Views

% Lineage

-4 Scheduled Tasks

Tree Pane

Figure 2

-85 <<Llineage Cueries>>

i << Uncategorized Queries> »

&5 Cable Fibers 7

= MUNSYS_ADMIN

=| MUNSYS_CFS_EDIT —

=| MUNSYS_CF5_QUERY

=| MUNSYS_POWER

#-35 Cable Routes

#-35 Cadastral

[=-85 Drainage
B2 MUNSYS_ADMIN

=| MUNSYS_ALL_EDIT

= MUMNSYS_ALL_QUERY

=| MUNSYS_DMS_EDIT

= MUMSYS_DMS_QUERY
G2 MUNSYS_POWER

t-F Electricity

t-35 Roads

135 Sewer

135 Water

t-35 Water (Abandoned)

15 Water (Potable)

135 Water (Raw)

r-3= Water (Reclaimed)

s OO e OO oy OO s OO e IO o SO ey WO

Munsys Management Console: Content Pane

Contents of the
Selected function

Contents of the
Selected function

Content Pane

= Both the content pane and the tree pane allow context-sensitive menus to be activated on

selected items.
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Bl Munsys Management Console (MCITY15INT) = O X
File  Action Help

E Applications #-35 <«Lineage Queries»>

08 Locks i <<Uncategorized Queries> >

=133 Query Categories

-85 Cable Fibers

i..B5 Categories = MUMSYS_aDMIN
B Queries MUNSYS_CFS_EDIT
= Roles = MUMSYS_CFS_QUERY
& Secuty B s+ Powis
E]--ﬁ Privilege 125 Cable Routes |7x Remove Role from Category
-y Tables/Views (-5 Cadastral Collapse Al
% Lineage -3 Drainage Expand Al
\} Scheduled Tasks 35 Electricity
#-35 Roads e
52 Sewer Context sensitive
-35 Water (right-click) menu
-35 Water (Abandoned)
-5 Water (Potable)
-35 Water (Raw)
-5 Water (Reclaimed)

Revoke access from category

Figure 3 Munsys Management Console: Context-sensitive menu

m  The same items that appear on the context-sensitive menu will also appear on the main
menu under the Action menu. The Action menu is therefore not static, but varies according
to the context-sensitive items related to the function that has been selected.

Bl Munsys Management Consale (MCITY15INT) = O ¥
i Action | Help
'gr Refresh 35 <<Llineage Queries> >
<<Uncategorized Queries>»
Rename .
S+ Cable Fibers
J X Delete 5= Cable Routes
Collapse All 35 Cadastral
= D H
N Expand Al =5 Drainage
iy S : S5 Electricity
B Pr Privileges B E—"-'ﬁ
- By TablEsrwiEws """ G MUNSYS_ADMIN
- M Lineage =| MUNSYS_ALL_EDIT

T Scheduled Tasks =/ MUNSYS_ALL_QUERY
LG MUNSYS_POWER
#-35 Roads

-5 Sewer

-85 Water

-85 Water (Abandoned)
-3 Water (Potable)

#-35 Water (Raw)

-5 Water (Reclaimed)

Figure 4 Munsys Management Console: Action menu
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»  The File menu contains the functionality that is used to maintain and manipulate the
database and schema. Some functionality may be disabled depending on your login
authentication.

H Munsys Management Console (I

File Action  Help

New Schema...

Drop Schema...
Export Schema...

Validate Schema...
Schema Data Models..,

Schema Properties...
Import Demo Data...

Disconnect

Change Password...

Exit

Figure 5 Munsys Management Console: File menu

Logging in to the Munsys Management Console

To start the Munsys Management Console, do the following:

1  Choose Start > Program Files > Open Spatial > Munsys 15.1> Munsys Management Console
15.1

2 or Double-click the Munsys Management Console 15.1 icon on the Windows desktop.

Munsys
Management
Console15.1

The Connect to Database dialog box is displayed.

Enter your logon details below, and then click OK.

User Name::

Password :

Schema:

Database:

Cancel Help

Figure 6 The Connect to Database dialog box
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3  Enter the following information:
User Name and Password (note that the user name and password are case sensitive)
Schema

Database

eCl 0 L'atabase

Enter your logon details below, and then click OK.

User Mame: MCITY15INT

Password : ik

Schema: MCITY15INT

Database : XE

Figure 7 The Connect to Database dialog box

Tip Use the Disconnect menu item on the File menu to change schema, database and user information if you
are already logged in to Munsys Management Console and you want to log in with different credentials.

4  Ifyoulog in to the Munsys Management Console without specifying a schema name, only limited
functionality will be available on the File menu, and none of the other functionality will be available.
This is normally the case when you want to create a new schema.

Note The opening position of the Munsys Management Console application window is recorded in the registry
settings. The screen position, height and width parameters, as well as the with of the content pane, are
applied when opening the application.

Changing your password

1  You can change the password used to connect to the Munsys Management Console with the
File > Change Password menu item.

Old Pagsword:
Mew Pazsword:

Retype Mew Password:

114 Cancel

Figure 8 The Change Password dialog box

2 Change the password as required, and then click OK.

Getting acquainted with the Munsys Management Console



Chapter 3

Schema management

Introduction

Using the Munsys Management Console, the database administrator can perform the

following schema management functions:

create a new schema

drop an existing schema

export a schema

validate a schema

install available data models in a schema

change properties of a schema

10



Creating a new Munsys Schema

Note

To be able to create a new schema, you will need to have the following roles assigned:
Munsys role: MUNSYS_ADMIN

Database privileges: CREATE USER, CREATE TABLESPACE, GRANT ANY ROLE,
GRANT ANY PRIVILEGE

You will need to log in as SYSTEM with DBA privileges.
A Munsys schema is created by following five steps:

Specifying a schema name and password. The schema name is the owner or default user that is used
to connect and manipulate the contents of the schema.

Specifying the database extents and coordinate tolerances. The database extents provide an area of
coverage for the data that is expected to be captured in the schema. Coordinate tolerances are set to
enforce expected data accuracy.

Specifying regional information: The locale, units, AutoCAD Map coordinate system and Oracle
coordinate system (SRID). Regional information provides the system with information as to which
part of the world the data represents. Locality provides information that is used when the data models
are created, as various locations have different data expectations. The AutoCAD Map coordinate
system code identifies the relevant coordinate projection system to use when referring to the data in
the schema in an AutoCAD Map environment. The code represents the coordinate system that is
associated with the geometry stored throughout the schema. The Oracle SRID is used when new or
modified objects are posted to the database.

Installing the relevant data models.

Creating the necessary Tablespaces in the database.

Schemamanagement
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To create a new Munsys Schema

1  Choose File > New Schema...

The Create New Schema — Step 1 of 5 dialog box is displayed:

Create New Schema - Step 1 of 5 X

Schema Info

Creating a new Munsys schema requires various parameters. The Schema
Name is also the owner {or default user) one would use to connect and
manipulate the content within the schema.

Schema Name: |

Schema Password: l

Confirm Password: |

e

Figure 1 Create new Schema — Step 1 of 5: Schema Name

2 Enter a name for the schema with a maximum of 30 (thirty) characters.

3  Enter and confirm a password for the schema. The maximum length for the password is 30 (thirty)
characters.

4  Click Next to continue to the second step of the schema creation process. (The Next button remains
unavailable until all the required fields have been completed.)

Schemamanagement 12



In the second step of the schema creation process, the database extents and tolerances are

specified:

Create New Schema - Step 2 of 5 X

Extents & Tolerances

Database extents provide an area of coverage for the data that is expected to
be captured in the schema. Set coordinate tolerances to enforce expected

data accuracy.
Database Extents
Minimum X: 0.000 &
Minimum Y- 0.000 5
Maximum X: 0.000 2]
Maximum Y: 0.000 &

Coordinate Tolerances

SDO Precision: 0.001000000

4

Snap Tolerance:  |0.001000000

ik

< Back Next > Cancel Help

Figure 2 Create New Schema — Step 2 of 5: Extents and Tolerances

In the Database Extents group, specify the minimum and maximum X and Y values.

Next, specify the SDO Precision and Snap Tolerance values.

Click Next to continue to the third step of the schema creation process.

Schemamanagement
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Note

10

In the third step of the schema creation process, the regional info for the schema is specified.
The regional info provides the system with information about which part of the world the data
represents. The locality part of the regional info is used when the data models are created, as
different locations have different data expectations.

Create New Schema - Step 3 of 5 X

Regional Info

Select the region and relevant coordinate system that applies to the spatial
data that will be stored in this schema

Locality
Locale: Int w
Units: Meters v

AutoCAD Map Coordinate System

Coordinate System Code:

Oracle Coordinate System (SRID)
[[] Enable SRID

< Back Next > Cancel Help

Figure 3 Create New Schema — Step 3 of 5: Regional Information

In the Locality group, select the Locale and Units. The default values are United States and Feet.

Next, enter the AutoCAD Map Coordinate System Code. This is the code that identifies the
relevant coordinate projection system to use when referring to the data in the schema in an AutoCAD
Map environment. This code represents which coordinate system is associated with the geometry
stored throughout the schema. The coordinate system is especially important in an environment
where multiple projections systems are used, so that if necessary data may be transformed between
various systems.

Select the Enable SRID check box if you want to you want to see the existing Oracle SRIDs in the
database, and then enter the appropriate code. Click the button next to the Code field to display the
existing SRIDs in the Oracle database.

The Oracle SRID is not currently used by the Munsys system; however, other systems require an SRID
stored as part of the geometry. The SRID value is used when posting new objects or updating others to the
database from the AutoCAD environment, where every geometry record includes the SRID as one of the
elements. The SRID is obtained from the Oracle list.

Schemamanagement
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11 Click Next to continue to the fourth step of the schema creation process, in which the data models
for the new schema are specified:

Create New Schema - Step 4 of 5 X

Data Models

Various data models are supported but require many database objects.
Select the ones you are most likely to use in the schema.

[] Include All Data Models

Cadastral Data Model (CMS)
[[] Cable Route Data Mode! {CRS)
[[] Cable Fiber Data Model (CFS)
[[] Drainage Data Model (DMS)
[] Bectricity Data Model (EMS)
] Mapbooks Data Model (MBK)
[C] Roads Data Model (RMS)
[[] Sewer Data Model (SMS)
[] Water Data Model (WMS)

cock | [Not> || Caoel || Hop

Figure 4 Create New Schema — Step 4 of 5: Data Models

12 Select the data models that you want to install. To install all the available data models, select the
Include All Data Models option. The Cadastral data model is installed by default.

Schemamanagement
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Click Next to continue to the fifth and last step of the schema creation process, in which the
necessary tablespaces for the new schema are created:

Create New Schema - Step 5 of 5 X

Tablespaces

The Temporary tablespace can be renamed from the default TEMP. The
MUNDATA and MUNINDEX tablespaces are created by default.

Tablespace Creation Details

The following tablespaces will be created (size in brackets):
MUNDATA (500MB)
MUNINDEX (250MB)

Note: AUTOEXTEND will be set ON
Temporary Tablespace

Tablespace Name:
TEMP ]

Datafile Location
Folder Location:
DAAPPAORACLENORADATAVORCL

< Back Create Cancel Help

Figure 5 Create New Schema — Step 5 of 5: Data Models

The Tablespace Creation Details information area shows the tablespaces that will be created. The
respective tablespace sizes are displayed next to the tablespace names.

Enter a name for the temporary tablespace (the default temporary tablespace name is TEMP).

The Datafile Location field displays the location of the data files that will be used by the schema.

The location cannot be changed.
Click Create to create the new schema.

The Schema Create Progress dialog box is displayed.

Create Schema X

Creating Munsys System Tables

.
ot || e

Figure 6 The Schema Create Progress dialog box

Schemamanagement
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Tip Click the More Details button to expand the dialog box and display details of the schema creation process.
Click the Abort button if you want to abort the schema creation process at any stage. If the schema
creation process is aborted before it has been completed, the items created up to the point of the abort will
be left in the schema.

When the schema has been created, the following dialog box is displayed:

Creation Complete X

Creation process completed.

Verify the content of the output and check for any warning
messages.

Figure 7 Schema Creation Complete

Schemamanagement 17



Dropping an existing schema

3

In order to drop a schema from the database, you will need to have the MUNSYS_ADMIN
role assigned, as well as the DROP USER and DROP TABLESPACE database privileges. A list
of all the schemas in the database is displayed on the Drop Schema dialog box, from where you
can select the schema that you want to drop. If you are logged on as a schema owner, the name
of that schema will not be displayed in the list of schemas that can be dropped, as an owner
cannot drop their own schema.

To drop a schema from the database, do the following:

Choose File > Drop Schema.
The Drop Schema dialog box is displayed.

Drop Schema d

Existing Schemas

Select schema to drop: | MCITY14INT ~

Drop Cloze Help

Figure 8 The Drop Schema dialog box

Select the schema that you want to drop, and then click the Drop button.

The following message is displayed:

Drop Schema

Are you sure you want to drop the "MCITY14INT' schema from
the database?

This will permanently remove all the database structures
owned by this schema.

Figure 9 Drop Schema confirmation message

Click Yes to drop the schema from the database.

Schemamanagement
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The following confirmation message is displayed when the schema has been dropped successtully:

Schema Dropped *

Schema 'MCITY14INT" was dropped successfully from the
database.

Figure 10 Schema Dropped

Exporting a schema

This function is used to export the contents of a schema to a dump file. To be able to export a
schema, you will need to have the MUNSYS_ADMIN role assigned, as well as the
EXP_FULL_DATABASE database privilege.

To export a schema, do the following:
1  Choose File > Export Schema...

2 The Export Schema dialog box is displayed.

Export Settings

Database Directory:
DATA_PUMP_DIR ~

Dump Filename:

MCITY15INT_dp.drmp

B Export Grants

B Export Table Data

Export Close Help

Figure 11 The Export Schema dialog box

3  Enter a name for the dump file that you are going to export the schema to, and the click Browse... to
specify the destination folder for the file.

The Dump File field is populated with the destination information of the schema.
4  Select or clear the following check boxes to specify export options:
Export Grants — select this option to include the grants when exporting the schema

Export Table Data — select this option to include the table contents when exporting the schema

Compress Extents — select this option to compress the data in the schema when it is exported

5  Click the Export button to export the schema to the file that you specified.
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8

The Export Schema: Progress Log dialog box is displayed, showing details of the export process.

Progress Log
.. exported “MCITY15INT"."LU_RMS_DWGNO" 0KB  Orows
.. exported "MCITY15INT"."MBK_PROCESS™ OKB  Orows
.. exported "MCITY15INT"."MDXT_176315" O0KB Orows
.. exported "MCITY15INT"."MDXT_176385" OKB Orows
.. exported “MCITY15INT"."MDXT_176485" 0KB Orows
.. exported "MCITY15INT","MDXT_19DE8S" 0KB  Orows
.. exported "MCITY15INT"."MDXT_19DF85" O0KE  Orows
.. exported "MCITY15INT"."MDXT_19E11§" 0KB  Orows
.. exported "MCITY15INT","MDXT_19€188" OKE  Orows
. exported "MCITY15INT","MDXT_19E985" OKB  Orows
.. exported “MCITY15INT"."MDXT_19E9F5" OKBE Orows
.. exported "MCITY15INT"."MDXT_19EA6S" 0KB  Orows
.. exported "MCITY15INT"."MDXT_19EADS" OKB  Orows
.. exported "MCITY15INT","MDXT_19EBCS" OKE  Orows
.. exported "MCITY15INT"."MDXT_19FF95" OKE  Orows
.. exported "MCITY15INT"."MDXT_1A0005" 0KB  Orows
.« exported "MCITY15INT"."MUNSYS_LINEAGE_COLUMNS" OKB  Orows
.. exported "MCITY15INT"."MUNSYS_LINEAGE_CONFIG* OKB  Orows
. exported "MCITY15INT"."MUNSYS_MONITOR_LOG" OKB  Orows
.. exported "MCITY15INT"."MUNSYS_RELATE" OKB  Orows
.« exported "MCITY15INT"."MUNSYS_SCHEDULED_TASKS™ 0KEB  Orows
.. exported "MCITY15INT"."SP_CRTDIM" OKB  Orows
.. exported "MCITY15INT"."SP_CRTLABEL" OKB  Orows
.. exported "MCITY15INT"."SP_CRTNOTE" OKB  Orows
.. exported "MCITY15INT"."SP_CRTSYM™ OKB  Orows
.. exported "MCITY15INT"."SP_FIBDIM" OKE  Orows
.. exported "MCITY15INT"."SP_FIBNOTE" OKB  Orows
.. exported "MCITY15INT"."SP_FIBSERV" OKB  Orows
.. exported "MCITY15INT"."SP_FIBSYM" OKB  Orows
.. exported "MCITY15INT"."SP_GEOSCAN_BNDRY" OKB  Orows
.. exported "MCITY15INT"."SP_SWSERV™ OKB  Orows
.. exported "MCITY15INT"."SP_SWSYM" OKB  Orows
Master table "MCITY15INT"."SYS_EXPORT_SCHEMA_01" successfully loaded/unloaded
Dumip file set for MCITY15INT.SYS_EXPORT_SCHEMA 01 is:
CAORACLEXE\ADMINYXE\DPDUMP\3BDCD14C10AF4AQFBIEBIIDTI275BICH\3BDCD14C10AF4ADFBIERIODTI2TSBICF
AMCITY15INT_DP.DMP
Job "MCITY15INT"."5Y5_EXPORT_SCHEMA_01" successfully completed at Mon Sep 16 12:25:30 2024 elapsed 0 00:02:01

Close

Figure 12 Export Schema: Progress Log

Click Close when the schema export has been completed successfully.

In the event the user logged into MMC does not have the necessary privileges to write to the

DATA PUMP_DIR folder they will get the following error:

Export Schema

Progress Log

Export: Release 18.0.0.0.0 - Production on Mon Sep 16 12:02:18 2024
Version 18.4.0.0.0

Copyright (c) 1982, 2019, Oracle and/or its affiliates. All rights reserved.

Connected to: Oracle Database 18c Express Edition Release 18.0.0.0.0 - Production
ORA-39002: invalid operation

ORA-39070: Unable to open the log file.

ORA-3908T: directory name DATA_PUMP_DIR is invalid

The Oracle DBA (SYSTEM user) can login via SQLPlus and grant the necessary access to the user

by running the following SQL script.

GRANT READ, WRITE ON DIRECTORY DATA_PUMP_DIR TO [username];

Schemamanagement
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Validating a schema

The schema validation function validates the Munsys system model tables against rules defined
to ensure the integrity of Munsys system tables. You need to have the MUNSYS_ADMIN role
assigned and be logged in as the schema owner to be able to validate a schema. The results of
the validation are shown on the Validation Results dialog box.

To validate a schema, do the following:
1  Choose File > Validate Schema...

The Validation Results dialog box is displayed. This dialog box consists of the following three
tabs:

= Summary — this tab lists the main category of the tests that were performed, and whether
the entire category failed or passed the schema validation test:

Validation Results X
Summary Emors Validation Log
Summary of validation:

Validation Test Result

¢ Munsys Spatial Tables Passed
q’ Munsys Geometry Metadata Passed
' Munsys Columns Passed
v Munsys System Queries Passed
o Munsys Link Tables Passed
0 Munsys Lookup Tables Failed

v Munsys GSCs Passed
v Munsys Aftribute Templates Passed
q' Munsys Spatial Indexes Passed
’ Munsys Sequences Passed
v Munsys Integrity Passed
q’ Munsys Geometry Types Passed
e Munsys Lookup Values Failed

w Munsys Null Values Passed
' Munsys GID Unique Values kipped
e Invalid Schema Objects Failed

q’ Munsys Lineage Passed

Close Help

Figure 13 Validation Results dialog box: Summary tab

= Errors — this tab contains a list of all the errors that were encountered during the schema
validation. The results are grouped under the validation category that was performed, as
seen in the following example:

Schemamanagement
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Validation Results

£

Invalid Schema Objects
<Object Name: ALL_MUNSYS_SP_TAB...
<Object Name: ALL_MUNSYS_APPLICA...

Summary Emors  Validation Log
Validation results:

Error Description

<Table: SP_WATPIPE> <PIPE_DIA: 0> ... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 32>... Value found in spatial table does not exist in lookup table.
<Table; SP_WATPIPE> <PIPE_DIA: 40>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 50>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 63>.. Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 75>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 80>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 205... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 225... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 230... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 255... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE: <PIPE_DIA: 305... Value found in spatial table does not exist in lookup table.

Invalid Schema Object found.
Invalid Schema Object found.

Figure 14

Validation Results dialog box: Errors tab

= Validation Log — this tab contains a list of the tests that were performed, as well as a
detailed account of the outcome. The validation log can be saved as a text file.

Schemamanagement
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2

Validation Results

Summary Emors Validation Log
Validation log:

 Test Successful

*** Category: Munsys Geometry Metadata ***
Test #1: Validating metadata of Munsys spatial tables
Test Successful

“** Category: Munsys Columns ***
Test #1: Verifying existence of Spatial tables found in MUNSYS_SP_COLUMNS
Test Successful

Test #2: Verifying existence of columns in MUNSYS_SP_COLUMNS
Test Successful

Test #3: Validating column descriptions in MUNSYS_SP_COLUMNS
Test Successful

Close

Save Log... '

Figure 15  Validation Results dialog box: Validation Log tab

Click the Save Log... button to save the validation results as a text file, and then click Close to exit

the Validation Results dialog box.

Schemamanagement
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Installing additional data models in a schema

With this function, you can install additional data models in a Munsys schema. You will need
the following roles/privileges assigned to be able to execute this function:

Munsys: MUNSYS_ADMIN

Database Privileges: CREATE ANY TABLE, ANY VIEW, ANY SEQUENCE and
CREATE TABLE, CREATE VIEW and CREATE SEQUENCE

To install additional data models, do the following:
1  Choose File > Schema Data Models...

The Data Models dialog box is displayed, showing a list of the data models that are available for
installation.

2 Select the data models that you want to install, and then click Install.

Data Models X

Data Models

Data models available for installation:
("] Drainage Data Model

[ | Blectricity Data Model
[] Mapbooks Data Model

(] Cable Route Data Model
[[] Cable Fiber Data Model

Cancel Help

Figure 16  The Data Models dialog box

The Schema Create Progress dialog box is displayed, and the schema is updated with the new data
models.

Schemamanagement
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Create Schema

Creating Spatial Indexes

=

Figure 17 Importing Data Models dialog box

You can do the following on this dialog box:

= Click the More Details button to expand the dialog box and show details of the data model

installation process.

= Click Abort to abort the installation of the data models if required.

Once the data models have been installed successfully, the following message is displayed:

Update Complete X

Data Model process completed.

Verify the content of the output and check for any warning
messages

Figure 18  Update Complete: data models installed

Schemamanagement
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Changing the properties of a Munsys schema

With this function, you can change basic properties of a Munsys schema, which are generally
stored in the MUNSYS DB _SETTINGS table. You will need the MUNSYS_ADMIN role

assigned to be able to change schema properties.
To change the properties of a schema, do the following:
1  Choose File > Schema Properties...

2 The Schema Properties dialog box is displayed. This dialog box consists of four tabs: General,
Schema, Lineage and Scheduled Tasks.

The General Tab

1  Onthe General tab, you can change database settings such as the Snap Tolerance, SDO Precision
and the Database Coordinate System. Once changes have been made, the OK button becomes
available.

General Schema Lineage Scheduled Tasks

Schema Information

Schema Mame: MCITY15INT
Version: 15.0

Locale: INT

Units: Meters

Database Settings

Snap Tolerance: 0.01
SDO Precision: 0.01
Database Coordinate Systern: RSA-LO29

Cancel Help

Figure 19 Schema Properties: General
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Note

1

The Schema Tab

On the Schema tab, you can change the Database Extents and the Oracle SRID.

General Schema lineage Scheduled Tasks

Any changes on this tab will require the spatial indexes to be rebuilt.

Database Extents

Minimum X: -84000.0 Maximum X:

%
=
!

Cracle Coordinate System (SRID)
Enable SRID SRID Code:

Spatial Index
(OR O vz Rebuild Spatial Indexes

Cancel Help

Mirimum " -2855000.0 Maximum : -28753000.0

Figure 20  Schema Properties: Schema

Changes that are made on the Schema tab (the database extents and the Oracle coordinate system) have a
direct effect on spatial indexing, and therefore the indexes will have to be rebuilt if you make any changes

on this tab. The OK button remains unavailable until you have rebuilt the spatial indexes.

Oracle has made significant improvements to the partitioning methods which allows for
enhanced performances and allows for spatial indexes to be system-managed.

Spatial Indexes V1 and V2

The main benefit of using V2 Spatial Indexing is because of the simplified spatial index

management. Effective with Oracle Release 12.2 and all subsequent versions, spatial indexes can
be system-managed by specifying INDEXTYPE=MDSYS.SPATIAL_INDEX_V2 at index
creation. You are strongly encouraged to use the V2 index type for all new spatial indexes you
create, regardless of whether the spatial table or the spatial index is partitioned, and you may
also want to use it if you decide to re-create legacy spatial indexes.

The old INDEXTYPE=MDSYS.SPATTIAL_INDEX (V1) is still available for use, It may
provide slightly better index creation performance, especially with small data sets and no

partitioning involved. You might also want to use the old type if you need to drop a legacy

spatial index and then want to re-create it in exactly the same form as it was before.

We recommend that you consult the Oracle documentation before deciding which method of
spatial indexing is more suited to your requirements.

https://docs.oracle.com/en/database/oracle/oracle-database/19/spatl/indexing-querying-
spatial-data. heml#GUID-6BBF58C4-10D0-4993-8 DF2-60C3157412D7

Schemamanagement
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2

3

Rebuilding Spatial Indexes after updating Database Extents

If you have only made changes to any of the Database Extents X and Y parameters on the Schema

tab, you are required to Rebuild Spatial Indexes, however, the SRID will not be updated.

The following confirmation message is displayed:

Rebuild All Spatial Indexes

0 Are you sure you want to rebuild all spatial indexes?

This step is mandatory when changing any property on the
'Schema’ tab, but you should be aware that this may take
several minutes to complete,

1l w

Figure 21 Rebuild All Spatial Indexes

Click Yes to rebuild the spatial indexes.
The Spatial Index Rebuild Progress dialog box is displayed.

Spatial Index Rebuild Progress X
All indexes rebuilt.
Close bot Help

Figure 22 Spatial Index Rebuild Progress

Select the More Details button to display more information.

Note the SRID update was skipped.

All indexes rebuilt.

Detailed Results:

Creating Spatial Indexes |
Executing: sqlplus -5 /NOLOG @SQL_Init.sql MCITY15INT/*****@XE mun_spidx.sql SKIP_SRID

Processing MUNSY5_GSC
Successfully completed

Processing FIBCABLE_GEOM
Successfully completed

Processing FIBPATH_GEOM
Successfully completed

Processing 5P_BLOCK
Successfully completed

Processing SP_BUILDING
Successfullv completed

Save As... Close \bort Help

Figure 23 More Details when Rebuilding Spatial Index
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4

The buttons on the dialog box allow you to save the results as a text file, display details of the index
rebuilding process or abort the process.

When the indexes have been rebuilt successfully a confirmation message is displayed:

Rebuild Complete e

Index Rebuild process completed.

Verify the content of the output and check for any warning
messages.

Figure 24 Rebuild complete

Click OK to return to the Properties dialog box.

Once you have made all the necessary changes to the schema, click OK.

Rebuilding Spatial Indexes after updating SRID

If you made changes to the Use SRID check box, or updated the SRID Code, you are also required
to Rebuild Spatial Indexes, and will result in Lineage updates for all geometries if Lineage is
enabled. You will need to disable the Lineage Triggers if you do not want the Lineage updates for
all geometries.

The following confirmation message is displayed:

update SRID values? This will result in lineage updates for all
geometries if lineage is enabled on spatial tables. If you do
not want this update to affect lineage then disable lineage
triggers first before rebuilding indexes.

9 Are you sure you want to rebuild all spatial indexes and

This step is mandatory when changing any property on the
‘Schema’ tab, but you should be aware that this may take
several minutes to complete,

Yes Mo

Click Yes to rebuild the spatial indexes.

The Spatial Index Rebuild Progress dialog box is displayed.

Spatial Index Rebuild Progress e

All indexes rebuilt.

[ More Detais | | Cose Help

Figure 25  Spatial Index Rebuild Progress

Select the More Details button to display more information.

Note the SRID update was run.
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Creating Spatial Indexes

Detailed Results:

Creating Spatial Indexes

Executing: sqlplus—S /NOLOG @SQL_lnit.sgl MCITYLISINT/*****@XE mun_spidx.sql RUN_SRID

Less Details Abort Help
Figure 26 More Details when Rebuilding Spatial Index

The buttons on the dialog box allow you to save the results as a text file, display details of the index

rebuilding process or abort the process.

When the indexes have been rebuilt successfully a confirmation message is displayed:

Rebuild Complete e

o Index Rebuild process completed.

Verify the content of the output and check for any warning
messages.

Figure 27 Rebuild complete

Click OK to return to the Properties dialog box.

Once you have made all the necessary changes to the schema, click OK.
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The Lineage Tab

On the Lineage tab, you can enable/ disable Lineage functionality and select Lineage editing
behavior for the logged in schema.

Filling out the Lineage tab in the schema Properties dialog box is the is the first essential step in
setting up Munsys Lineage.

Properties X

General Schema Lineage Scheduled Tasks

Munsys Lineage
[[] Enable Lineage

Editing Behaviour:

The "Prompt’ behaviour setting will prompt the user to either post all
pending edits to the database or continue the break./join
operation.

OK Cancel Help

Figure 28  Schema Properties. Lineage

Select Enable Lineage, and click OK.
Select the Editing Behavior of Lineage

Editing behavior affects how Munsys Lineage will respond to multiple break
or join operations on line objects. In the available drop down, the following options can be selected:

Continue Editing: This setting will continue the break/join operation without posting any
pending edits to the database. Note that, if more than one split is made and changes are not
posted to the database in between splits, the splits will all be linked to the same Lineage
parent ID of the line that was broken.

Automatic Posting: This setting will post all pending edits to the database and then
continue the break/join operation.

Prompt: This setting will prompt the user to either Post all pending edits to the database
or Continue the break/join operation. Note that, if the same line object is broken more
than once and changes ARE posted to the database in between breaks, each line segment
will be linked to the Lineage parent of the last line that was broken.

| Lineage Implication: Continue editing or post current changes |

e Continue
Post

Figure 29  Lineage Implication prompt message displayed in Munsys Applications.
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Note

Click OK, or continue making changes in the schema Properties dialog box.

To continue setting up Lineage refer to the chapter Munsys Lineage.

The Scheduled Tasks Tab

On the Scheduled Tasks tab, you can enable/ disable the Scheduled Tasks functionality and select
Scheduled Tasks process time to run Scheduled Tasks on the schema.

Filling out the Scheduled Task tab in the schema Properties dialog box is the is the first essential

step in setting up Munsys Scheduled Tasks.

Properties

General Schema Lineage Scheduled Tasks

Munsys Scheduled Tasks
[C] Enable Scheduled Tasks

Set Process Time:

0K Cancel Help

Figure 30  Schema Properties: Scheduled Tasks

You will need the ‘Create Job’ Privilege to enable Munsys Scheduled Tasks.

Select Enable Scheduled Tasks.

Select the preferred Process Time when you want the Scheduled Task to run, and click OK.

To continue setting up Scheduled Tasks refer to the chapter Munsys Scheduled Tasks.
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Chapter 4
Import Demo Data

Introduction

The demo data included in Munsys contains more than 14000 land parcels with associated
data complementary to each application. The data contained within the demo data has been
specifically captured to represent typical practical requirements. New users can make use of the
demo data for training and to familiarise themselves with the Munsys applications. Existing
users can experiment with new features and enhancements. The demo data will assist in
testing/training or presenting Munsys to users and clients without actually having to capture
data. Be aware that the demo data contains errors for testing purposes.

The Munsys Demo Data is installed along with the Munsys Management Console. There are
two demo schemas for the United Sates (MCITY15US) and International (MCITY15INT)
locales.

The MCITY15 schema has spatial and attribute data that can be used for training purposes to
familiarise the users with the concepts of Munsys, or it can be used to test functionality before
running on the live database.

Munsys Demo Data contains data for all the Munsys applications. Once the database
administrator has imported the demo data, users will be able to retrieve the data from the
database.
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Importing Munsys Demo Data

Be aware that the demo data schema will automatically be created in the import demo data
process. To recreate an existing demo data schema, the schema will first need to be dropped
before the import can begin.

1  Open the Munsys Management Console
2 Complete the ‘Connect to the Database’ dialog that appears.

The database administrator must login as SYSTEM with DBA privileges and specify the database to
which the demo data will be imported. Leave the Schema field blank. Click OK.

3 On the menu, select File > Import Demo Data.

The Import Demo Data dialog box will appear.

Import Demo Data X

Demo Data
Locality
® Intemational (INT)

(O United States (US)

Database Directory:

Cancel Help

Figure 1 Import Demo Data dialog box

4 In the Import Demo Data dialog box, select the appropriate Locality: International (INT) or
United States (US).

5 Select an Database Directory to import the Demo Data.
By default oracle should have a directory already called DATA_ PUMP_DIR. To dis-

cover where this directory is located on the server, you will need to run the following
sql statement on the database that will be hosting the Munsys demo data:

SELECT DIRECTORY_NAME,DIRECTORY_PATH FROM DBA_DIRECTORIES
WHERE DIRECTORY_NAME="DATA_PUMP_DIR’;

To create a new directory you will need to run an sql statement similar to the one
below:

CREATE DIRECTORY “NAME OFTHE DATA DIRECTORY” AS ‘/ust/apps/data-
files’;

This path must exist and be accessible on the Oracle server. You will need to copy the data
pump files located on the Munsys install directory:

(E.g. Copy the files MCITY15INT_DP.dmp and MCITY15US_DP.dmp from
C:\Program Files\Open Spatial\MunConsole15.1\DumpkFiles) to the directory path on

the Oracle server.
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= Ifyoulog on to the Oracle database with a user other than the one that will be used
to create the Munsys schema you will need to grant permissions to the directory using
an sql statement similar to the one below:

GRANT READ, WRITE ON DIRECTORY [directoryname] TO [username];
for example:

GRANT READ, WRITE ON DIRECTORY DATA_PUMP_DIR TO MCITY15INT;

= To see the new directory, repeat steps 1-4 and you should see the new directory in the
‘Database Directory’ drop down of the Import Demo Data dialog.

Click Proceed.

The Import Demo Data Progress dialog will appear:

Import Demo Data Progress X

Inttiate Data Pump

Mot | [ b

Figure 2 Import Demo Data Progress

The required tablespaces and demo data schema are created. Munsys imports the Oracle dump
file that populates the schema with the demo data.

When the Import Demo Data Progress is done a confirmation message will be displayed.
Click OK to go back to the Import Demo Data Progress dialog.

Import Complete X

Import process completed,

Verify the content of the output and check for any warning
messages.

Figure 3 Import Complete

When the import process is completed, verify the content of the output and check for any
warning messages in the More Details tab of the Import Demo Data Progress dialog.

Import Demo Data
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Log on defaults

Note

During the import process of the demo data, the user will be notified of the schema name that
will be created. This information will be required to log on to Munsys Applications and Munsys
Management Console. The user logs on to Munsys using the following default log on detail:

US locale
Username MCITY15US
Password MCITY15US
Schema MCITY15US
Database Database name configured with Oracle client

International locale

Username MCITY15INT
Password MCITY15INT
Schema MCITY15INT
Database Database name configured with Oracle client

Once a schema is created for the demo data, the database administrator should change the
password from its default value. The database administrator should use Munsys Management

Console to create users and grant the required roles.

Passwords are case sensitive when connecting to an Oracle database.

Import Demo Data
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Chapter 5
Working with Munsys Application Settings

Introduction

Each Munsys application has its own default capture settings that are set by the database
administrator in the Munsys Management Console. In the Munsys Management Console, the
Applications tree contains a list of all the available Munsys applications and their respective
application settings.

This chapter provides information about application setting management in the Munsys

Management Console. The following functions can be performed from the Applications tree:

Creating a new Application Setting

Modifying an existing Application Setting
Deleting an Application Setting

Adding a new Integrity Setting

Modifying an new Integrity Setting

Deleting an existing Integrity Setting

Creating a new Network Check Notification
Editing an existing Network Check Notification
Deleting an existing Network Check Notification
Creating a new Network Node Integrity
Editing an existing Network Node Integrity
Deleting an existing Network Node Integrity
Creating a new Object Attribute Integrity
Editing an existing Object Attribute Integrity

Deleting an existing Object Attribute Integrity
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The Applications tree: overview

The Applications main tree consists of list of all the Munsys application with their respective

application settings.

Using the Action menu or context-sensitive (right-click) menu that is activated when an item
is selected, settings for the various applications are created and maintained.

B Munsys

File  Action Help

{3 Applications

..... {} General Settings
[-(@} CFS - Cable Fiber
r-]--ff! CMS - Cadastral

&lx Integrity
f-f3? CRS - Cable Route
[-{@8 DMS - Drainage
{38 EMS - Electricity
[-(38 MBK - Map Books
-(3? QRY - Query
[x-(38 RMS - Roads
.jj--f‘j:! SDM - Spatial Data Manager
[-(38 SMS - Sewer
[-[30 WMS - Water
-G Locks

3:33 Query Categories

i Security
% Privilege

% Tables/Views

m Lineage

i1 Scheduled Tasks

133 =)

"

Figure 1

Variable
Building

49 *CMS_BUILDING_TYPE*
Density

4% *CMS_DENSITY_TYPE*
Easement

4#*CMS_EASEMENT_TYPE*

£ *CMS_EASEMENT_OFFSET*

¥ *CMS_EASEMENT_TSIZE*
Integrity

¥ *CMS_SRCH"

£#*CMS_SHORT_OBJECTS*
Land Use

4% *CMS_LANDUSE_TYPE*
Mote

4% *CMS_NOTE TSIZE*
Parcel

4#+CMS_PARCEL_TYPE®

£ *CMS_PARCEL_WSTATUS

Value

RESIDENTIAL

1P1000

GEMERAL
2
5

UNKNOWN

Munsys Management Console: Applications tree

Description

Building Type

Density Type

Easement Type
Easement Offset distance
Easement Tag Height

Cadastral Search Tolerance
Short Objects

Land Use Type

Mote Tag Height

Parcel Type
Parcel Work Status
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Creating a new application setting

Each Munsys application has its own default settings that are used when data is captured, for
example the snap tolerance, tag and symbol scale, node types, etc. Application settings are
stored in the MUNSYS_AP_SETTINGS table. When a new setting is created, it inherits the
category from the current application and a new record is inserted in the
MUNSYS_AP_SETTINGS table. You will need the MUNSYS_POWER or
MUNSYS_ADMIN roles assigned to be able to create a new application setting.

To create a new application setting, do the following:

1  Select the Settings item below the application that you want to create the setting for in the
Applications tree, and then select the New Setting... option on the Action menu or the context-
sensitive (right-click) menu.

=-{F Applications
- General Settings
CMS5 - Cadastral

& _
X Intearity | Mew Setting...
@ Emg:g::: Collapse All
¢ (3 MBK- Map B Expand All

Figure 2 Selecting Application Settings

The New Application Setting dialog box is displayed.

New Application Setting - Cadastral X

Application Setting - CMS

Descriptive
Name:

Display Group:
Short Description:

Long Description:

Value
Data Type: Initial Value:

W

[] Use Lookup Table for Value
Lookup Table: Initial Value from Lookup:

] Alow Session Edting

Cancel Help

Figure 3 The New Application Setting dialog box
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1  Enter the following Descriptive information:

Name — enter a descriptive alpha-numeric name (containing no spaces) of no longer than
30 characters

Display group — from the list, select the group within the set of application settings that this
setting will belong to. You can select an existing group, or specify a new group for the new
setting.

Short description — enter a short, descriptive setting that give the user an indication of what
the setting will be used for (maximum length 40 characters)

Long description — enter a longer description for the setting (maximum length 250
characters)

2 Enter the following Value information:

Data type — select the data type of the value that will be stored.

Initial value — select one of the following values:
Character : allows for string type values
Integer : whole numbers
Float : decimal numbers
Boolean : only allows the values T (true) or F (false)
Angle : stores a decimal number, but uses AutoCAD formatting to display the angle value

3 Select the Use lookup table for value check box if you want the value to be selected from a lookup
table. The LCODE value from the lookup table will be stored as the Initial Value once it has been
selected.

If the Use Lookup table for Value option has been selected, use this list to select the appropriate
table.

4  Select the appropriate initial value from the list of lookup tables.

5  Select the Allow Session Editing option to allow the user to select this from the same lookup table
specified when the user gets to change a value in the Munsys application. The lookup table has the
fixed structure of LCODE, b — where LCODE is the value that is stored in the value of the setting,
but LVALUE is the description that is displayed in the drop-down entry.

6  Click OK to create the new application setting.
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Modifying an existing application setting

2

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to

change the properties of an application setting. Application settings are changed using the

Modify Application Setting dialog box.

To modify an existing application setting, do the following:

Select the application setting that you want to modify, and then select the Properties... option on the
Action menu or the context-sensitive (right-click) menu.

File  Action Help

=-(3® Applications

{} General Settings

@ CMS - Cadastral
g5 Settings

‘x Integrity

Variable

Building

Density |

43CMs_ =

(&P DMS - Drainage Properties...

(mP EMS - Flectrici

Value

RESIDENTIAL

1P1000

Description

Building Type

Density Type

Figure 4

Selecting Application Setting to modify

The Modify Application Setting dialog box is displayed.

Modify Application Setting - Cadastral

Application Setting - CMS

Descriptive
Name:
"CMS_BUILDING_TYPE" |

Display Group:

|Building v]
Short Description:

|Building Type

Long Description:

This is the default type assigned when capturing a new
building.

Value
Data Type:

Character (strings) v

Initial Value:
RESIDENTIAL

[¥] Use Lookup Table for Value
Lookup Table: Initial Value from Lookup:
LU_CMS_BLDTYPE v

Allow Session Editing

Cancel Help

Residential v

Figure 5

Modify Application Setting dialog box

Change the properties as required, and then click OK.
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Deleting an application setting

You can delete an application setting from a Munsys application. Each Munsys application has
its own default settings that are used when data is captured, for example the snap tolerance, tag

and symbol scale, node types, etc. Application settings are stored in the
MUNSYS_AP_SETTINGS table.

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to
delete an application setting.

To delete an application setting, do the following:

1  Select the application setting that you want to delete, and then select the Delete option on the Action
menu or the context-sensitive (right-click) menu.

The following message is displayed:

Delete Setting

0 Are you sure you want to delete the application setting?

You have selected to delete the "*CMS_BUILDING_TYPE*'
application setting.

ST

Figure 6 Delete application setting

2 Click Yes to delete the application setting from the application.
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Integrity Validations

Note

The Munsys Integrity Validation Tools and checks are extremely powerful and allows
administrators to manage the integrity of their organization’s spatial data to a high degree of
sophistication with relative ease.

The Integrity Validation Tools can be divided into three groups of tools:
Network Check Notifications
Network Node Integrity
Object Attribute Integrity

For more information on Munsys compound validations please refer to the Munsys Administrators
Reference Guide (Munsys15 1 AdminReferenceGuide.pdf) or the Munsys Concepts User Manual
(Munsys15 1 ConceptsUserManual.pdf).

Network Check Notifications

The Network Check Notification Integrity tools are available only for Applications that have
Network-able Feature objects. These include Drainage, Electricity, Roads, Sewer and Water.
Since the networks in each of these have their own characteristics, the Network Check
Notification Integrity tools are application specific. These configurations can be used to
monitor changes in the topological relationships of the network.These serve as notifications to
rerun network integrity validations. These settings must be in line with the Network integrity
test routines for each of the applications.

When any of the items that have been configured for notification are changed, the user will be
notified to rerun the network integrity through which the network relationships are then
validated.

Network Integrity Warning X

Object integrity complete.
Changes have been detected that may influence network integrity.

It is recommended that network integrity is validated before changes
are posted to the database.

Figure 7 Network Integrity Warning

The following Network Check Notifications are automatically created per Munsys Application
data model when a new Schema is created using Munsys Management Console and saved in
the system table MUNSYS_INTEG_OBJECTS:

Working with Munsys Application Settings
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Munsys fs Network

Table Name Network . Network Columns

App Object Object Type

CRS 141 SP_CRTLINK True LINK START NODE,
END_NODE, ROUTE_ID

CRS 142 SP_CRTNODE True NODE NODE_ID

DMS 63 SP_SWNODE True NODE NODE_ID

DMS 65 SP_SWPIPE True LINK START NODE,
END_NODE, PIPE_ID

DMS 66 SP_SWCHANNEL True LINK START _NODE,
END_NODE

DMS 67 SP_SWCULVERT True LINK START NODE,
END_NODE

EMS 101 SP_ELCABLE True LINK START NODE,
END NODE

EMS 102 SP_ELNODE True NODE NODE_ID

RMS 81 SP_RDCL True LINK START _INT, END INT,
STR_CODE, STR_NAME

RMS 82 SP_RDINT True NODE INT _ID

SMS 23 SP_SEWNODE True NODE NODE ID

SMS 25 SP_SEWGPIPE True LINK START_NODE,
END_NODE, PIPE_ID

SMS 27 SP_SEWVPIPE True LINK START NODE,
END_NODE, PIPE_ID

SMS 28 SP_SEWRPIPE True LINK START NODE,
END_NODE, PIPE_ID

WMS 43 SP_. WATNODE True NODE NODE_ID

WMS 45 SP_WATPIPE True LINK START NODE,

END_NODE, PIPE_ID

Table 8 Default Network Check Notifications
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Creating a new Network Check Notification

2

Each Munsys application has its own Network Check Notification settings that are used when

the network is validated.Network Check Notification settings are stored in the
MUNSYS_INTEG_OBJECTS table. When a new notification is created, it inherits the
category from the current application and a new record is inserted in the
MUNSYS_INTEG_OBJECTS table.

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to

create a new network check notification setting.

Select Network Check Notification in the tree under the application that you want to create the

Notification for.

Bl Munsys Management Console (MCITY15INT) = O X
File  Action Help
EIE Applications Mun D Table Name Is Network Obj...  Metwork Object Type  Network Columns
& General Settings X6 SP_SWNODE True NODE NODE_ID
g E:js Ccab"je Ft'bT' es SP_SWPIPE True LINK START_NODE,END_NODE,PIPE_ID
- T -adas 366 SP_SWCHANNEL True LINK START_MODE,END_NODE
[-(38 CRS - Cable Route
Mo SP_SWCULVERT  True LINK START_NODE,END_NODE

E‘ii' DMS - Drainage
- ¥ Settings
le Integrity

X [T

x MNetwork Node Int]

Mew Metwork Check Notification...

. Object Attribute |
H-(30 EMS - Electricity
H-{3 MEK - Map Books

Collapse All

Expand All

B

B

G-(30 ORY - Query

F-{3® RMS - Roads

[-{3P SDM - Spatial Data Manager
F-{P SMS - Sewer

{38 WMS - Water

MNew Metwork Check Notification

Figure 9 Munsys Management Console: Network Check Notification

Select the New Network Check Notification... Option on the Action menu or the context-sensitive

(right-click) menu.

Working with Munsys Application Settings

43



The following dialog is displayed:

New Network Check Notification - Drainage X

Network Check Notification

Spatial Table: ~
Object Type
® Link O Node (O Service Connection
Columns
Available Columns: Notification Columns:

L

Cancel Help

Figure 10 New Network Check Notification

3  Select the Spatial Table for which you want to add a Notification.Note that only those objects are
listed that are a part of the Application under which you have made the selection. Once selected, you
will notice that the columns from the selected table are now listed in the Available Columns list.

4  Next select what role the selected table plays within the network.You have three options:

Link — these must be linear objects that act as topological links (polylines) within the
network.

Node — these must be point type objects that act as topological nodes within the network.

Service Connection — these must be linear type objects that act as topological connections
between the network and the service delivery endpoint, usually a polygon type entity such

as a property.

5  Next, select the columns from the Available Columns list that must be used to notify users to rerun
Network Integrity.

6  Click OK to save your changes to the database.
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Editing an existing Network Check Notification

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit
an existing network check notification setting.

To edit an existing network check notification, do the following:

1  Select Network Check Notification in the tree under the application where you want to edit an
existing notification.

Bl Munsys Management Console (MCITY15INT) = [m] X

File  Action Help

- Applications Mun D Table Name Is Metwork Obj... Metwork Object Type  Network Columns

4 General Settings X6l 5P_SWNODE True NODE NODE ID

! g E;SS Ccab;e:t'bfr es SP_SWPIPE True LINK START_NODE,END_NODE,PIPE_ID
" & crs C;Ll: R:’ute 366 SPSWCHANMEL Tue LINK START_NODE,END_NODE

o ;

; J67  SPSWCULVERT  True LINK START_NODE,END_NODE

E_Hi' DMS - Drainage

3 Network Check Notifi

x Metwork Mode Integril
------ x Object Attribute Integ

(38 EMS - Electricity

o-(38 MEK - Map Books

7-f38 ORY - Query

o-(P RMS - Roads

]--@ SDM - Spatial Data Manager

o-[P SMS - Sewer

(38 WMS - Water

o O o O s OO o OO s OO s O

Figure 11 Select Network Check Notification

2 Select the Existing Notification record in the right hand notifications lists.

Bl Munsys Management Consale (MCITY15INT) = (m] *

File  Action Help

=l icati un able Mame s Metworl etworl ject e etwork Columns
=1 Applications MunID  TableN Is Network Obj.. Network Object Type  Netwark Col
g E;ze”’c' Sbeltt':g‘ 363  SP_SWNODE True NODE NODE_ID
"ﬁl CMS’ ca degt' T’ Xes SP_SWPIPE True LINK START_NODE,END_NODE,PIPE_ID
: - \-adastra CUANC LA KIKIE]D Trve START_MODE,END_NODE

-3 CRS - Cable Rout RT
o able Route X6 p| 2 Delete LINK START_NODE,END_NODE
3P DMS - Drainage -

| Properties...

) Network Check Notifi
x MNetwork Node Integrit
- x Object Attribute Integ

R W T ST

Edit Properties of Integrity Network Check Notification

Figure 12 Selecting Network Check Notification Properties
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3 Select the Properties Option on the Action menu or the context-sensitive (right-click) menu.

The following dialogue is displayed:

Modify Network Check Notification - Drainage

MNetwork Check Notification

Spatial Table: | SP_SWCHANNEL

Object Type

Columns

Available Columns:

CHNL_GRADIENT ~
CHNL_ID

CHNL_MATRL

CHNL_TWIDTH

CHNL_TYPE

COMMENTS

DATA_QUALITY

DATA_SOURCE

END_GL

END_IL

GEOM_LENGTH

GEOMETRY

GID

START_GL

START_IL

TAG_ANGLE

TAG_JUST v

® Link O Node (O Service Connection

=2

<<

Notification Columns:

END_NODE
START_NODE

Figure 13 Modify Network Check Notification

4 Edit the Notification Properties as needed.

5  Click OK to post the changes to the database.
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Deleting an existing Network Check Notification
You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to

4

delete network check notification setting.

To delete an application setting, do the following:

Select Network Check Notification in the tree under the application where you want to edit an

existing notification.

Select an Existing Notification record in the right-hand notifications lists.

Select the Delete Option from the Action menu or the context-sensitive (right-click) menu.

ﬁ Munsys Management Console (MCITY15INT)
File  Action Help

-3 Applications MuniD  Table Name Is Network Obj...
4% General Settings SP_SWNGEC S

! SP_SWPIF

[-{3P CMS - Cadastral - 2
G- CRS - Cable Route Xeo  spswc —
47 DMS - Drainage Xe7 SP_SWCULVERT  True

: & Settings

) Network Check Notifi
x MNetwork Node Integrit
[ x Object Attribute Integ

R W T ST

MNetwork Object Type  Metwork Columns
MNODE MNODE_ID
LINK START_NODEEND_NODE,PIPE_ID
LINK START_NODE,END_NODE
LINK START_NODE,END_NODE

Delete Integrity Metwork Check Motification

The following message is displayed:

Delete Network Check Notification

Are you sure you want to delete the network check
notification?

You have selected to delete the "SP_SWCHANNEL' network
check notification.

] o

Figure 14  Delete Network Check Notification record

Click Yes to delete the Network Check Notification record.
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Network Node Integrity

The Network Node Integrity tools are available only for Applications that have Network-able
Feature objects. These include Drainage, Roads, Sewer and Water.Since the networks in each of
these have their own characteristics, the Network Node Integrity tools are application
specific. These configurations can be used to configure different Network characteristics.

The Network Node Integrity tools can be used to determine how specific node types should
behave in the network.Two rule types are supported:

The INTERMEDIATE rule allows a node to be inserted between the start and end nodes
of a link object.

The LINKLIMITS rule specifies a minimum and a maximum number of links allowable
for the node type.

The following Network Node Integrity settings are automatically created per Munsys
Application data model when a new Schema is created using Munsys Management Console and

saved in the system table MUNSYS_INTEG_NODES:

MUN_ID | Table Name Symbol Name Parameters
DMS 63 SP_SWNODE _SW_CAP LINKLIMITS 1,1
DMS 63 SP_SWNODE _SW_DI LINKLIMITS 1,3
DMS 63 SP_SWNODE _SW_JUNC LINKLIMITS 2,4
DMS 63 SP_SWNODE _SW_MH LINKLIMITS 1,4
DMS 63 SP_SWNODE _SW_PMP_PUB LINKLIMITS 2,2
DMS 63 SP_SWNODE _SWPMP_PVT LINKLIMITS 1,2
DMS 63 SP_SWNODE _SW_WW LINKLIMITS 1,1
DMS 63 SP_SWNODE _SW_KI LINKLIMITS 1,4
RMS 82 SP_RDINT _RINTDEAD LINKLIMITS 1,1
RMS 82 SP_RDINT _RINTNORMAL | LINKLIMITS 2,4
RMS 82 SP_RDINT _RINTFREE LINKLIMITS 2,4
RMS 82 SP_RDINT _RINTTRAFL LINKLIMITS 2,4
RMS 82 SP_RDINT _RINTNODE LINKLIMITS 2,4
SMS 23 SP_SEWNODE | _SCAP LINKLIMITS 1,1
SMS 23 SP_SEWNODE | _SJUNC LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SLH LINKLIMITS 1,3
SMS 23 SP_SEWNODE | _SMH_PUB LINKLIMITS 1,5
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MUN_ID | Table Name Symbol Name Parameters
SMS | 23 SP_SEWNODE | _SOVALVE LINKLIMITS 22
SMS 23 SP_SEWNODE | _SPMP_PUB LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SREDUCER LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SSCVALVE LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SVCHA LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SVENT LINKLIMITS 1,2
SMS 23 SP_SEWNODE | _SVSTA LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SMH_PVT LINKLIMITS 1,5
SMS 23 SP_SEWNODE | _SMPM_PVT LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SAIRVAC LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SMPOINT LINKLIMITS 2,2
SMS 23 SP_SEWNODE | _SRES LINKLIMITS 1,5
SMS 23 SP_SEWNODE | _SREYE LINKLIMITS 1,3
WMS 43 SP_WATNODE | _WHYDSGL INTERMEDIATE YES
WMS 43 SP_WATNODE | _WSPT INTERMEDIATE YES
WMS 43 SP_WATNODE | _WREDUCER LINKLIMITS 2,2
WMS 43 SP_WATNODE | _WEND LINKLIMITS 1,1
WMS 43 SP_WATNODE | _WGTVALVE LINKLIMITS 1,2
WMS 43 SP_WATNODE | _WARVALVE LINKLIMITS 2,2
WMS 43 SP_WATNODE | _WBFVALVE LINKLIMITS 2,2
WMS 43 SP_WATNODE | _WBORE LINKLIMITS 1,1
WMS 43 SP_WATNODE | _WCHVALVE LINKLIMITS 2,2
WMS 43 SP_WATNODE | _WCLVALVE LINKLIMITS 2,2
WMS 43 SP_WATNODE | _WHYDPUB INTERMEDIATE YES
WMS 43 SP_WATNODE | _WJUNC LINKLIMITS 2,4
WMS 43 SP_WATNODE | _WMETR LINKLIMITS 2,2
WMS 43 SP_WATNODE | _WPMP LINKLIMITS 2,2
WMS 43 SP_WATNODE | _WPRVALVE LINKLIMITS 2,2
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MUN_ID | Table Name Symbol Name Rule Type Parameters
WMS | 43 SP_WATNODE | _WPSVALVE LINKLIMITS 2,2
WMS | 43 SP_WATNODE | _WRES LINKLIMITS 1,4
WMS | 43 SP_WATNODE | _WSTANK LINKLIMITS 2,2
WMS | 43 SP_WATNODE | _WTWR LINKLIMITS 1,4
WMS | 43 SP_WATNODE | _WVRVALVE LINKLIMITS 1,2
WMS | 43 SP_WATNODE | _WHYDPVT INTERMEDIATE | YES
WMS | 43 SP_WATNODE | _WSVAL LINKLIMITS 1,2
Table 5 Default Network Node Integrity settings

Creating a new Network Node Integrity Record

Each Munsys application has its own Network Node Integrity settings that are used when the

network is validated.Network Node Integrity settings are stored in the
MUNSYS_INTEG_NODES table.You will need the MUNSYS_POWER or
MUNSYS_ADMIN roles assigned to be able to create a new network node integrity setting.

To create a new network node integrity setting, do the following:

Select Network Node Integrity in the tree under the application that you want to create the Node
Integrity record for.

H Munsys Management Console (MCITY15INT — m]
File  Action Help
EIE Applications Mun ID Table Mame Symbol Name Rule Type Parameters
& General Settings X6 SPSWNODE ~ _SW.PMP_PUB  LINKLIMITS 22
"‘i' CFS - Cable Fiber e SP_SWNODE SW_MH LINKLIMITS 1,4
g E:'SS_' CZ:TZSF:':L'“E X6 SPSWNODE  _SWJUNC LINKLIMITS 24
i@ DMS - Drginage X63 SPSWNODE  _SW.DI LINKLIMITS 13
& Settings 63 SP_SWNODE  _SW_CAP LINKLIMITS 11
0.3 Integrity X63 SPSWNODE  _SW.PMP_RVT  LINKLIMITS 22
X Network Check Notifi 63 SP_SWNODE  _SW_WW LINKLIMITS 1,1
-3¢ Network Node Integrit | | X 63 SP_SWNODE  SW.KI LINKLIMITS 14
oo x Object Attribute Integ

Figure 16  Munsys Management Console: Network Node Integrity

Select the New Network Node Integrity... Option on the Action menu or the context-sensitive
(right-click) menu.
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The following dialog is displayed:

New Network Node Integrity - Drainage X

Network Node Integrity

Spatial Table: v
Symbol Name:
Rule Type
® Link Limit O Intermediate

Minimum Link : 1
Maximum Link: 1

oK Cancel Help

Figure 17 New Network Node Integrity

3 Select the Node table for which you want to add Network Node Integrity.

4  Enter the name of the Node Type (Munsys SYM NAME) for which node integrity needs to be
added.

5  Select the Rule type for the Node Integrity. There are two options:

Link Limit — This option allows you to specify the range of links that are allowed for one
node of the given type. The Minimum Link setting will test for a minimum number of links
while the Maximum Link setting will test for a maximum number of connected links.
Examples:

A reducer in a water network must have an incoming AND an outgoing link but no
more. The minimum and maximum must therefore both be set to “2”.

An Endcap in most networks must always be limited to one link only. The minimum and
maximum must therefore both be set to “1”.

A pre-cast storm water manhole must have at least ONE incoming and one outgoing link,
but it could have multiple incoming links, depending on its design. The minimum should
therefore be set to “2” while the maximum should be in line with its specifications but
would usually be three or more...

Intermediate — This node type does not break a pipe but is merely snapped onto the
pipe.Example:

some organizations require that nodes such as Hydrants do not break pipes but sit inter-
mediately between the start and end nodes.

6  Click OK to update the database and save your new settings.
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Editing an existing Network Node Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit an
existing network node integrity setting.

To edit an existing network node integrity setting, do the following:

1  Select Network Node Integrity in the tree under the application where you want to edit an
existing Node Integrity record.

Ei Munsys Management Console (MCITY15INT) = m] %
File  Action Help
EIE Applications Mun 1D Table Name Symbol Name Rule Type Parameters
g EE;E"’C' i’:lﬁ'::‘ Xe SP_SWNODE  _SW_PMP_PUB  LINKLIMITS 22
& cms_ Ca de tl Tr X3 SP_SWNODE _SW_MH LINKLIMITS 14
aF CRS C;ﬂ:;:ute X 63 SP_SWNODE _SW_JUNC LINKLIMITS 24
(&7 DMS - Drainage X6 SP_SWNODE _SW._DI LINKLIMITS 13
&% Settings J M6l 5P_SWNODE _SW_CAP LINKLIMITS 1,1
5. Integrity X6l SP_SWNODE _SW_PMP_PVT  LINKLIMITS 22
L. Network Check Notifi b 4! SP_SWNODE _SW_ww LINKLIMITS 1,1
3¢ Network Node Integri Xo63 SP_SWNODE _SW.KI LINKLIMITS 1,4

e x Object Attribute Integ

e W T S

Figure 18  Select Network Node Integrity

2 Select the existing network node integrity record in the right-hand panel, and then select the
Properties option on the Action menu or the context-sensitive (right-click) menu.

Bl Munsys Management Console (MCITY1SINT) = a X
File  Action Help
EIE Applications Mun ID Table Name Symbol Name Rule Type Parameters
g EE;E”’C' Sbeltt'F”g‘ Xe SPSWNODE  _SW.PMPPUB  LINKLIMITS 22
et CMS’ ca de t' T’ X3 SPSWNODE  _SW_MH LINKLIMITS 14
@ crs Cablaerat X3 SP_SWNODE _SW_JUNC LINKLIMITS 24
- - Lable houte
Xe SP_SWNODE  _SW_DI LINKLIMITS 13

EHf DM5 - Drainage

) X8 SP_SWNODE _SW_CAP LINKLIMITS 1,1
E‘x Integrity ] SP_SWMNODE LIKIKLIRAITS

3¢ Network Check Notifi | | XK 83 5P_SWNODE sV XK Delete 5 11
x MNetwork Node Integrit )lc53 SP_SWNODE S | Properties... 5 1.4
o x Object Attribute Integ

A S rwac oo

Edit Properties of Integrity Metwork Mode Integrity

Figure 19 Selecting Network Node Integrity Properties
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3

4

The following dialog is displayed:

Modify Network Node Integrity - Drainage
Network Node Integrity

Spatial Table: SP_SWNODE

Symbol Name: | Y010

Rule Type

@) Link Limit O Intermediate

Minimum Link: I:I
Maodmum Link:

oK Cancel Help

Figure 20  Modify Network Node Integrity

Make any changes to the values on the dialog as needed.

Click OK to update the existing Network Node Integrity record.
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Delete an existing network Node Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit
an existing network node integrity setting.

To edit an existing network node integrity setting, do the following;:

1  Select Network Node Integrity in the tree under the application where you want to delete an
existing Node Integrity record from.

2 Select the existing network node integrity record in the right-hand panel, and then select the Delete

option on the Action menu or the context-sensitive (right-click) menu.

ﬁ Munsys Management Console (MCITY15INT)
File  Action Help

23 Applications Mun ID Table Name Symbol Name Rule Type Parameters

# General Settings Xe63 SP.SWNODE  _SW.PMPPUB  LINKLIMITS 22
{37 CFS - Cable Fiber Xes SP_SWNODE _SW_MH LINKLIMITS 14
J g E:;S_' cc;‘::’::;e Xe3 SPSWNODE  _SW_JUNC LINKLIMITS 24
3 SP_SWNODE LINKLIVEES 22
X& SP SWNODE  _SW_CAP LNKLMC Oelete |
X6 SPSWNODE  _SW.PMPPVT  LINKLI Properties...
X Network Check Notifi | | 263 SP_SWNODE  _SW.WW LINKLIMITS i
3 Network Node Integrt | | X 63 SPSWNODE  _SW.KI LINKLIMITS 14
) Object Attribute Integ
A raar Pt

| Delete Integrity Network Node Integrity

Figure 21  Select Delete Network Node Integrity

The following message is displayed:

Delete Network Node Integrity

o Are you sure you want to delete the network node integrity?

You have selected to delete the 'SP_SWNODE - _SW_DI'
network node integrity.

Figure 22 Delete Network Node Integrity Notification

3  Click Yes to delete the existing Network Node Integrity
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Object Attribute Integrity

Note

The Object Attribute Integrity Rules refer to integrity rules allows administrators to set up a
range of integrity rules for any of the attributes of a data object.

NOTE: Multiple rules can be set for specific attributes on any table.

When multiple checks are specified, the Rule order will determine in what order rules will be
run to validate the Object’s Integrity. The following rule types can be set:

Compare Check — This rule will allow users to check the relationship between two attribute
fields of the same table.

Not Null — This forces attributes to have values.

Range — Valid for NUMERICAL attributes only — the attribute must fall within a range
defined as a Minimum and Maximum range: [Not] greater than or equal to x and less than
or equal toy.

Substring — This rule can be applied multiple times for the same attribute and allows
validation of parts or substrings of the attribute value: The substring function returns a
portion of string, beginning at a specified position in the string

Value Check — This rule allows users to check the value of an attribute.

The following Object Attribute Integrity Settings are automatically created per Munsys
Application data model when a new Schema is created using Munsys Management Console and
are saved in the system table MUNSYS_INTEG_ATTR:

Rule

Table Name Column Name Description Type Parameters
1 SP_TOWN TOWN_CODE 1 Town Code NOT-
NULL
3 SP_PARCEL PRCL_KEY 1 Parcel Key NOT-
NULL
3 SP_PARCEL PRCL_KEY 2 Parcel Key Portion SUB- 0,12,NEQ,”00000
STR 0000000”,YES
3 SP_PARCEL TAG_VALUE 1 Parcel Tag NOT-
NULL
5 SP_SUBURB (INT) | SUB_CODE 1 Suburb Code NOT-
NULL
7 SP_WARD (INT) TAG_VALUE 1 Ward Tag NOT-
NULL
8 SP_STRTXT TAG_VALUE 1 Street Text Tag NOT-
NULL
9 SP_STRADDR STR_CODE 1 Street Address Code NOT-
NULL
9 SP_STRADDR STR_NAME 1 Street Address Name NOT-
NULL
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Table Name

Column Name

Description

Rule
Type

Parameters

9 SP_STRADDR STR_NO Street Address Number NOT-
NULL

9 SP_STRADDR SUB_NAME Street Address Suburb NOT-
Name NULL

9 SP_STRADDR MUNI_NAME Street Address Municipal- | NOT-
ity Name NULL

10 SP_EASELINE EASE_TYPE Easement Line Type NOT-
NULL

11 SP_EASELINETXT EASE_TYPE Easement Line Type Text | NOT-
NULL

12 SP_TP_ZONING ZONING Zoning NOT-
NULL

13 SP_TP_DENSITY DENSITY Density NOT-
NULL

14 SP_EASEPOLY EASE_TYPE Easement Polygon Type NOT-
NULL

15 SP_EASEPOLYTXT | EASE_TYPE Easement Polygon Type NOT-
Text NULL

18 SP_MUNICIPAL- MUNI_CODE Municipality Code NOT-
ITY (US) NULL

19 SP_TP_LANDUSE LANDUSE Land Use NOT-
NULL

Table 23

Table Name

Column Name

Description

Default Object Attribute Integrity settings - Munsys Cadastral

Parameters

147 SP_CRTINEST- INF_NAME Infrastructure Name NOT-
RUCT NULL

147 SP_CRTINFST- INF_NUM Infrastructure Number NOT-
RUCT NULL

147 SP_CRTINFST- INF_TYPE Infrastructure Type SUB-
RUCT STR

Table 24  Default Object Attribute Integrity settings - Munsys Cable Route

Rule

Table Name Order

Column Name Description Parameters

Rule Type

65 SP_SWPIPE START_IL 1 Start Invert Level COMPARE- GT, “END_IL”,
CHECK NO
Table 25  Default Object Attribute Integrity settings - Munsys Drainage
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Rule

Table Name Column Name Description Rule Type Parameters

Order

104 SP_ELZONE TAG_VALUE 1 Electricity Zone NOTNULL
Tag

Table 26 Default Object Attribute Integrity settings - Munsys Electricity

Table Name Column Name Description Rule Type | Parameters
25 SP_SEWGPIPE START_INVELEV 1 Start Elevation Greater | COM- GT, “END_IN-
than End Elevation PARE- VELEV”, NO
CHECK
27 SP_SEWVPIPE START_INVELEV 1 Start Elevation Greater | COM- GT, “END_IN-
than End Elevation PARE- VELEV”, NO
CHECK
28 SP_SEWRPIPE START_INVELEV 1 Start Elevation Greater | COM- GT, “END_IN-
than End Elevation PARE- VELEV”, NO
CHECK

Table 27  Default Object Attribute Integrity settings - Munsys Sewer

Rule

Table Name Column Name Order Description Rule Type Parameters
e

42 SP_WATZONE TAG_VALUE 1 Water Zone Tag NOTNULL

Table 28  Default Object Attribute Integrity settings - Munsys Water

Creating an new Object Attribute Integrity

It is possible to set up Object Attribute Integrity rules for each Munsys object class. Object
Attribute Integrity rules are stored in the MUNSYS_INTEG_ATTR table. You will need the
MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to create new object

attribute integrity rules.
To create a new object attribute integrity rule, do the following:

1  Select Object Attribute Integrity in the tree under the application under which the object falls for
which you want to create an object attribute integrity rule.
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ﬁ Munsys Management Console (MCITY15INT) — a x

File  Action Help

- Applications Mun 1D Table Name Column Mame  Rule Order Description 4
""" 4 General Settings X1 SP_TOWN TOWN_CODE 1 Town Code
(0 CFS - Cable Fiber X3 SP_PARCEL PRCL_KEY 1 Parcel Key
e g;ﬁf:::m' X3 SP_PARCEL PRCL_KEY 2 Parcel Key Porticn
5 ntegrity X3 SP_PARCEL TAG_VALUE 1 Parcel Tag
" 5 Object Attribute Integ Xs SP_SUBURE SUB_CODE 1 Suburb Code
(57 CRS - Cable Route X7 SP_WARD TAG_VALUE 1 Ward Tag
i Ga8 DMS - Drainage Xa SP_STRTXT TAG_VALUE 1 Street Text Tag
EJ--@ EMS - Electricity xg SP_STRADDR STR_CODE 1 Street Address Code
{38 MBK - Map Books xg SP_STRADDR STR_NAME 1 Street Address Name
A S Ay e YQ cD CTRANDNDR CTR MM 1 Ctraat Addrace Mimnbhar 3

Figure 29 Munsys Management Console: Object Attribute Integrity

Select the New Object Attribute Integrity... option on the Action menu or the context-sensitive
(right-click) menu.

Bl Munsys Management Console (MCITY15INT) = i X
File  Action Help
E!ﬂ Applications Mun ID Table Name Column Name  Rule Order Description 4
g g:;'”;' S;“'F’f a‘ X1 SP_TOWN TOWN_CODE 1 Town Code
il - CMS' c‘ d’ t' T’ X3 SP_PARCEL PRCL_KEY 1 Parcel Key
2 & mi: :’ = X3 SP_PARCEL PRCL_KEY 2 Parcel Key Portion
bs¢ lmgrigty X3 SP_PARCEL TAG_VALUE 1 Parcel Tag
X e || X5 SPSUBURB  SUB_CODE 1 Suburb Code
[4-{3? CRS - Cable Route | New Object Attribute Integrity... | TAG_VALUE ! Ward Tag
{37 DMS - Drainage Coicae AN TAG_VALUE 1 Street Text Tag
5 (57 EMS - Electricity i STR_CODE 1 Street Address Code
&1 {4 MBK - Map Books Expand All STR_NAME 1 Street Address Name
§L Ay A H Ya €D CTRANNR TR NN 1 Chrmat Arbrlears Klsnihar 1
4 L

| New Object Attribute Integrity

Figure 30 Create new Object Attribute Integrity

The following dialog is displayed:
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Note

A N xR W

New Object Attribute Integrity - Drainage X

Object Attribute Integrity
Spatial Table: v
Column: v

Description: |

Rule Info

Rule Order:

Rule Type: v

Figure 31  New Object Attribute Integrity

Select the Spatial table for which you want to add an object integrity rule.
Select the Column on which you want to add the rule.
Add a Description for the rule.lt is sensible to add concise, but clear descriptions.

The system will automatically provide a Rule order number which is incremental based on existing
rules.This value is not editable when first creating the rule.(To change the rule order, edit the rule
afterwards).

Select a Rule type.Munsys Integrity offers five rule types, each with different parameters. These are:

Compare Check — This rule will allow users to check the relationship between two attribute
fields of the same table.Use this rule to perform Compound Validations. The Rule takes two
parameters: An Operator and a Column name. Example - use this rule to ensure that the
start invert level of a pipe is shallower (has a bigger value) than the end invert level.

Not Null — This forces attributes to have values.

When setting a column to being Mandatory in Munsys Management Console, an Application Object
Attribute Integrity rule with a rule type of NOT NULL is automatically created. When objects are checked
using the Object Integrity checks within the Munsys Application, if a NOT NULL rule type is found, the
Attribute Marker will record the following error:

[Column_name] may not be NULL, New Object - [Table Name]
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Range — Valid for NUMERICAL attributes only — the attribute must fall within a range
defined as a Minimum and Maximum range.Example: use this rule to check that service

connections are longer than 1 meter but shorter than 50 meters.And note that the dialogue
states that these values are inclusive.

Substring — This Rule allows users to validate substrings and can be applied multiple times
for the same attribute. This is similar to “Mask” integrity rules available in other
applications.Example: If you want to ensure that the Plan number for a property is valid,
you may include two rules, the first stating that the first two characters must be alpha

New Object Attribute Integrity - Cadastral X

Object Attribute Integrity

Spatial Table: | SP_PARCEL v
Column: PRCL_KEY >
Description: Plan Number

Rule Info

Rule Order:

Rule Type: | Substring v

Substring Parameters

Start Position: 1
String Length 2
Operator: Not Equal

Value to Search:

Alpha Only Numeric Only
[ Match Case

OK Cancel Help

Figure 32 Substring Alpha Only rule
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and the remainder of the string must be numeric

New Object Attribute Integrity - Cadastral e
Object Attribute Integrity
Spatial Table: | SP_PARCEL v

Column: PRCL_KEY A

Description: Plan Number

Rule Info
Rule Order: 4
Rule Type: Substring v

Substring Parameters

Start Position | JI

String Length: | 20|

Operator: Not Equal
Value to Search:

Alpha Only [ Numeric Only
] Match Case

0K Cancel Help

Figure 33 Substring Numeric Only rule

®  Value Check — This rule allows users to check the value of an attribute against a single pre-

set value using these operators.

New Object Attribute Integrity - Cadastral X
Object Attribute Integrity
Spatial Table: | SP_PARCEL el

Column: PRCL_KEY v

Description: Plan Number
Rule Info
Rule Order: 4

Rule Type: Substring v

Substring Parameters

Start Position | JI

String Length | 20]

o ]

Less Than or Equal to
[ Apha Only |Greater Than
Greater Than or Equal to

Cancel Help

Figure 34 Substring Operator value selection
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Edit an existing Object Attribute Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit
an existing object integrity rule.

To edit an existing object integrity rule, do the following:

1  Select Object Attribute Integrity in the tree under the application under which the object falls, for
which you want to edit an object attribute integrity rule.

ﬁ Munsys Management Conso 15INT, — a X
File  Action Help
Eli? Applications Mun 1D Table Name Column Mame  Rule Order Description 4
; g EE;E"’C' 5:'“'::‘ X1 5P TOWN TOWN CODE 1 Town Code
i CMS’ Cadegt' T’ X3 SP_PARCEL PRCL_KEY 1 Parcel Key
= & Seﬁi: : . X3 SP_PARCEL PRCL_KEY 2 Parcel Key Portion
: X inte rigty X3 SP_PARCEL TAG_VALUE 1 Parcel Tag
: T Cg}bjectAttributeInteg X5 5P_SUBURE SUB_CODE 1 Suburb Code
&7 CRS - Cable Route X7 SP_WARD TAG_VALUE 1 Ward Tag
27 DMS - Drainage X3 SP_STRTXT TAG_VALUE 1 Street Text Tag
& EMS - Electricity Xo SP_STRADDR  STR_CODE 1 Street Address Code
: {3 MBK - Map Books xg 5P_STRADDR STR_MAME 1 Street Address Name
LR Ry R YCI cD CTRANDNDR CTR MM 1 Ctraat Addrace Mimnbhar 3

Figure 35 Select Object Attribute Integrity

2 Select the existing Object Attribute Integrity Rule in right-hand panel.

3  Select the Properties option on the Action menu or the context-sensitive (right-click) menu.

Bl Munsys Management Console (MCITY15INT) = a X
File  Action Help
E‘"E Applications Mun 1D Table Name Column Mame  Rule Order Description 4
: P
g g:;e”’c' Sbeltt'F”g‘ X1 SP_TOWN TOWN_CODE 1 Town Code
- -amlember X3 SP_PARCEL PRCL_KEY 1 Parcel Key
{38 CMS - Cadastral 4 p——— . :
: . 3 SP_PARCEL Parcel Key Portion
A% Settings .
0. Integrity X3 SP_PARCEL TAG_VALL X Delete Parcel Tag
" 3¢ Object Attibute Integ Xs SP_SUBURE suB_COD[  Properties... Suburb Code
&7 CRS - Cable Route M7 SP_WARD TAG_VALUE T Ward Tag
&7 DMS - Drainage Xs SP_STRTXT TAG_VALUE 1 Street Text Tag
&7 EMS - Electricity Xo SP_STRADDR  STR_CODE 1 Street Address Code
@ MBK - Map Bocks X‘J SP_STRADDR STR_NAME 1 Street Address Name
R R w'a <D STRANNR STR M 1 Strast Addrare Mimahar A
4 »

Edit Properties of Integrity Object Attribute Integrity

Figure 36 Selecting Object Attribute Integrity Properties

4 The following dialog will be displayed:
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Note

Modify Object Attribute Integrity - Cadastral
Object Attribute Integrity

Spatial Table: 5P PARCEL

Column: PRCL_KEY

Description: |Pa'rcel Key Portion
Rule Info
Rule Order:
Rule Type: Substring ~

Substring Parameters

Start Position: | 1‘
String Length: | 12|
Operator: Not Equal v

Value to Search: [000000000000

(] Alpha Only (] Numeric Only
[] Match Case
0K Cancel Help
Figure 37  Modify Object Attribute Integrity

Edit the values on the dialogue to match the desired rule parameters.

Note if you want to reorder Rules, it is best to first change the rule order using a different number set as

the system will not allow rules with the same order.

Once satisfied with the parameter settings, click OK to save your edits.
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Delete an Existing Object Attribute Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to

delete an existing object integrity rule.

To delete an existing object integrity rule, do the following:

1  Select Object Attribute Integrity in the tree under the application under which the object falls, for
which you want to edit an object attribute integrity rule.

2 Select the existing Object Attribute Integrity Rule in right-hand panel.

3  Select the Delete option on the Action menu or the context-sensitive (right-click) menu.

ﬁ Munsys Management Console (MCITY15INT)
File  Action Help

EIE gplications Mun 1D Table Mame Column Name
v General Settings x
i X 1 SP_TOWN TOWMN_CODE
g E::S Cca b;e:t'bfr X3 SP_PARCEL PRCL_KEV
=0 " -adasiE SP_PARCEL PRCL KEY
I {}5 Settings
- x3 SP_PARCEL TAG_VALUE
Bx Integrity x
. Object Attribute Integ 3 sP_SUBURB 5UB_CODE
51 CRS - Cable Route X7 SP_WARD TAG_VALUE
37 DMS - Drainage Xa SP_STRTXT TAG_VALUE
@ EMS - Electricity xg SP_STRADDR STR_CODE
(5637 MEK - Map Books X9 SP_STRADDR  STR_NAME
R ¥ao <D CTRAPNNE TR NN
4 »

Delete Integrity Object Attribute Integrity

Rule Order Description

Town Code
Parcel Key

D
3 Delete Yortion

Properties...
e

Ward Tag

Street Text Tag

Street Address Code
Street Address Name
Sract Addrace Mimher

Figure 38  Select Delete Object Attribute Integrity

The following dialog will be displayed:

Delete Object Attribute Integrity

object attribute integrity.

0 Are you sure you want to delete the object attribute integrity?

You have selected to delete the 'SP_PARCEL - PRCL_KEY - 2'

Figure 39 Delete Object Attribute Integrity Notification

4 Click Yes to delete the Object Attribute Integrity.
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Chapter 6
Record locking

Introduction

Munsys record locking is activated by default, ensuring data integrity within the working
environment and restricting the editing of a spatial object to one user at a time. In the Munsys
Management Console, the following record locking issues are managed from the Locks tree:

Locking behavior — enabling or disabling the record locking mechanism, and setting lock
reminders for users then they log on or off.

Lock reporting and overriding — displays the current status with regard to users and
respective locked objects, and allows the database administrator to unlock objects
currently locked by users.

Record locking in the Munsys schema can be disabled permanently or temporarily.

Disable permanently — the option to clear all existing locks in the database is
recommended before record locking is disabled permanently to ensure that no locking
information is retained in the database.

Disable temporarily — this can be done to allow users with locked objects to post changes
to database, although these objects are not locked in the database. In this case, the
administrator should verify existing locks before clearing all the locks from the database.
The administrator should also ensure that users do not query any objects from the
database while the lock administration is disabled. Clearing all the existing locks may
cause problems when users try to post the changes to the database after the lock
administration is enabled again. It is therefore recommended that the administrator notify
all the users to post changes to the database before disabling the lock administration
temporarily. If any objects are still locked and the administrator ensures that these locks
can be cleared, the option to clear all the locks can be used.
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The Locks tree: overview
The Locks tree contains the Records branch, which displays a summary of the total number of
records currently locked by all users in all tables.

Clicking on Records in the Locks tree displays each user name that has locked objects, the
spatial table where the objects reside and the number of objects locked for that table. You
can drag the column headers to display in any order that you want.

ﬁ Munsys Management Console (MCITY15INT — ]
File  Action Help

E Applications User Name Table Mame Locked Objects
8 L_“:S . S MCITYASINT SP_BUILDING 5
1;‘? E‘Cmt‘ _ S MCITsINT SP_CRTINFSTRUCT 6
P & mcimyisinT SP_CRILINK 2%
ﬁ Pri\.rile;)re S MCITYASINT 5P_CRTNODE 18

B ToblesViews S MCITYSINT SP_PARCEL 9
) Lineage S MaImvsINT 5P_WATNODE 4
=3 Scheduled Tasks

Figure 1 Locks tree: Records
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Enabling or disabling record locking

1

Record locking is activated by default in any Munsys schema. From the Locks tree in the
Munsys Management Console, you can change record locking properties by disabling or
enabling record locking in a schema, or by changing the record locking status reminders for
users.

To be able to work with record locking properties, you need to have the following
roles/privileges assigned:

®  Munsys role: MUNSYS_ADMIN

®  Database privileges: SELECT, INSERT, UPDATE and DELETE on
MUNSYS_DB_SETTINGS

To specify record lock settings
Right-click on Locks, and then select the Properties option on the context-sensitive menu, as
seen below:

¥

¥ Appl

lications

= -

Eﬁ w Clear Locks
*jfg G | Properties...
-2 Sec
4 i Collapse All
+' Expand All
)

4@ Scheduled Tasks

Figure 2 Record Locking: Properties

The Record Locking dialog box is displayed.

Record Locking X

Settings

Enabling record locking on a Munsys schema will require
users to exclusively lock an object before any editing
can take place.

Enable Record Locking
Record Locking Status Reminders

[] Remind users at logon
[] Remind users at logoff

I R

Figure 3 The Record Locking dialog box

Select or clear the Enable Record Locking check box to enable or disable record locking in the
schema.

Recordlocking
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2 Set the record locking status reminders as required (this group is unavailable when record locking
has been disabled):

Remind users at logon reminds users that they still have objects locked when they log on to
the schema.

Remind users at logoff reminds users that they still have objects locked when they log off
from the schema

3  Click OK to apply the settings that you have specified.

Clearing all the locks in the database

Using the Clear Locks menu item, the database administrator can clear all the locks in the
database. Please note that unlocking all locked records could result in the loss of data.

To be able to clear all the locks in the database, you need to have the following roles/privileges
assigned:

Munsys role: MUNSYS_ADMIN
Database privileges: SELECT, INSERT, UPDATE and DELETE on
MUNSYS_LOCKED_OBJECT

To clear all the locks in the database

1  Right-click on Locks, and then select the Clear Locks option on the context-sensitive menu, as seen

below:
+ ﬂ? Applications
Clear Locks
Properties...
Collapse All
Expand All

4 Scheduled Tasks

Figure 4 Record Locking: Clear Locks

The following confirmation message is displayed:

Clear Locks

0 Are you sure you want to remove all record locks?

Removing record locks from the schema can result in loss of
unsaved user data.

Yes _ No

Figure 5 Clear Locks

2 Click Yes to clear all the locks in the database.

The locks are cleared, and the content pane refreshed and updated accordingly.
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Working with locked records in the database

To be able to work with locked records in the database, you need to have the following

roles/privileges assigned:

Munsys role: MUNSYS_ADMIN

Database privileges: SELECT, INSERT, UPDATE and DELETE on

MUNSYS_LOCKED_OBJECT

The Records item in the Locks tree displays the number of objects that are currently locked for

all users in all the spatial tables in the database. Selecting this item displays the following
summary list in the content pane:

t-i Munsys Management Console (M

File  Action Help

CITY15IN

ﬂ Applications
58 Locks

43 Records

= Query Categories
[y SECUrity

% Privilege

o By Tables/Views

% Lineage

o Scheduled Tasks

Figure 6

User Name

&4 MCITY15INT
£ MaITY15INT
4 MCITY1SINT
&4 MCITY15INT
&4 MCITY1SINT
&4 MCITY15INT

Record locking summary

Table Name Locked Objects
SP_BUILDING 5
SP_CRTINFSTRUCT 6
SP_CRTLINK 26
SP_CRTNCODE 18
SP_PARCEL 9
SP_WATNODE 4

Recordlocking
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Viewing locked objects

You can view details of the objects that have been locked by a user on the Record Locking Detail

dialog box.

To access the Record Locking Detail dialog box, do the following;:

Right-click on an item in the summary list, and then select the Details item on the context-sensitive

menu:

Bl Munsys Management Console (MCITY1SINT) = a X
File  Action Help
E Applications User Mame Table Name Locked Objects
HI Locks &
3"3 Becordy S MCITYASINT SP_CRTINFSTRUCT Belabm
73 Query Categories £ MCITVISINT SP_CRTLINK Clear Locks
iy Security -
% Privilege & MCITY13INT SP_CRTNODE 18
I
% Tables/Views ‘: MCITY15INT SP_PARCEL 9
% Lineage s MCITY15INT SP_WATNODE 4
1) Scheduled Tasks
Details tooltip
Figure 7 Selecting Locked Record Details
The Record Locking Detail dialog box is displayed:
Record L b
Detail
Usen  MCITY13INT ~
Date/Time Locked Duration Lock...  Table Name GID
02/09/2024 11:20:26 14d 04:56:12 SP_PARCEL 50350
02/09/2024 11:20:26 14d 04:56:12  SP_BUILDING 220119
02/09/2024 11:20:26 14d 04:56:12 SP_BUILDING 220118
02/09/2024 11:20:26 14d 04:56:12  SP_BUILDING 220453
02/09/2024 11:20:26 14d 04:56:12  SP_BUILDING 221296
02/09/2024 11:20:26 14d 04:56:12  SP_BUILDING 220091
10/09/2024 09:15:26 6d 07:01:12 SP_WATNODE 141968
Unlock Refresh
Close Help
Figure 8 The Record Locking Detail dialog box
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Unlocking locked objects

You can clear the objects that have been locked by a user by right-clicking on an item in the
summary list, and then selecting the Clear Locks item on the context-sensitive menu, as seen

below:

Ei Munsys Management Console (MCITY15INT)

File  Action Help

{3 Applications

User Mame

Table Name

Locked O bjects

L T
C‘t‘}%:r:c;a?:gmies &. MCITY15INT SP_CRTINFSTRUCT Dm"‘
| Secuity & MCITY1SINT SP_CRILINK
ﬁ Prvilege & MCITYI5INT SP_CRTNODE 18
B, Tables/Views ;: MCITY15INT SP_PARCEL 9
B Linesge & MCITYISINT SP_WATNODE 4
i1} Scheduled Tasks

Clear locks tooltip

Figure 9 Selecting Clear Locks Option

A Clear Locks confirmation message will be displayed requiring the user to confirm of cancel
the Clear Lock operation.

Are you sure you want to remove all record locks?

Removing the record locks on the "SP_PARCEL table for user
'MCITY15INT can result in loss of unsaved user data.

Yes No

Figure 10 Clear Locks confirmation message

You can also unlock locked objects from the Record Locking Detail dialog box:

1  Select the object(s) that you want to unlock, and then right-click on one or more selected records to
display a context-sensitive menu that you can use to clear selected records for unlocking.
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2
3

Record Locking Detail X

Detail
Userr  MCITY15INT w
Date/Time Locked Duration Lock... Table Name GID

02/09/2024 11:20:26 T4d 05:01:29 | SP_PARCEL | 50346

02/05/2024 11:20:26 14d 05:01:29 SP_PARCEL 30339

e T s

9 | SP_PARCEL

02/09/2024 11:20:26

50347
14d 05:01:29 SP_PARCEL 50348

Close Help

Figure 11 The Record Locking Detail dialog box: unlocking locked objects

Records can also be unlocked by using the Unlock button on the Record Locking Detail dialog box.

Click Refresh to refresh the dialog box once you have unlocked the locked records.
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Chapter 7
Query Categories

Introduction

Munsys Query categories are maintained from the Query Categories tree in the Munsys
Management Console (MMC). You need to have the MUNSYS_POWER or
MUNSYS_ADMIN roles assigned to be able to manipulate query categories.

Munsys recognizes the following types of query categories:

Uncategorized — by default any new query (not a user query) is seen as being
uncategorized until it has been allocated to a category. Queries may be moved to or from
the uncategorized group, but the category itself is a special case whereby the name may
not be changed — only the content. The uncategorized group may also not be granted
other roles — all queries in this group are seen to be granted the MUNSYS_ALL_QUERY
role. As soon as a query is moved to a category or as a user query, it cannot also belong to
the uncategorized group — the query no longer has this status.

User — whenever a user creates a new query, it is automatically seen as a personal query,
hence called a User query. Other users cannot see any other user’s queries until they are
shared in the pool of Uncategorized or Categorized queries.

Custom Categories — each category is provided with a unique name. When a new category
is created, it is automatically granted the MUNSYS_ALL_QUERY role. A category may
be granted multiple roles.

Munsys provides default custom categories as part of a new Munsys schema. The power user
can customize these and/or add personal categories. The following categories are created in a
new schema, synonymous with the Munsys applications and the default roles will be granted
to these categories:

Fiber - MUNSYS_CFS_QUERY

Cable Routes — MUNSYS_CRS_QUERY
Cadastral - MUNSYS_CMS_QUERY
Drainage —- MUNSYS_DMS_QUERY
Electricity - MUNSYS_EMS_QUERY
Roads — MUNSYS_RMS_QUERY

Sewer — MUNSYS_SMS_QUERY

Water —- MUNSYS_WMS_QUERY
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The Query Categories tree: overview

Note

The Query Categories main tree consists of three branches (nodes):

When an existing Munsys schema is upgraded to a Munsys 15 schema, all system queries are classified
as uncategorized, and the power user/administrator will be required to move these into categories.

Categories — allows the user to create and/or delete categories and provides a mechanism for
the user to allocate roles to categories.

Queries — the properties of the queries are not edited here, but the user may arrange queries
into various categories. The visibility of queries within a category will be restricted by the
roles granted to a user. However, in the MMC the power user has the right to see all queries
and categories regardless of roles granted, having the responsibility to arrange the queries
and query categories.

Roles — contains the roles that exist in the database and have been granted to the various
query categories.

File  Action Help

15' Applications

: 8 Locks

=5 Query Categories
-85 Categories

-85 «<Llineage Queries>>

1 =< Uncategorized Queries>»
-85 Cable Fibers
-5 Cable Routes

Queries #-35 Cadastral

‘3&5 Drainage

-5 Electricity

‘3&5 Info Counter
‘36§ Roads

‘3&5 Sewer

‘36§ Water

i‘»:ﬁ Water (Abandoned)
35 Water (Potable)
i‘»:ﬁ Water (Raw)
‘Ehﬁ Water (Reclaimed)

B Tables/Views

% Lineage

) Scheduled Tasks

Figure 1 Munsys Management Console: Query Categories tree

The sub-trees within the Query Categories tree are displayed when a user has the
MUNSYS_POWER or MUNSYS_ADMIN role assigned. For more information about the
various Munsys roles, see Chapter 8: Security in the Munsys Management Console.
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Creating a new query category

2

To be able to create a new query category, you need to have the following roles/privileges
assigned:

= Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
®  Database privileges: UPDATE on query-related tables

To create a new query category

Right-click on the Categories node of the Query Categories tree, and then select the New
Category... option on the context-sensitive menu.

=-235 Query Categories

. El i
: Bci New Category...

= Roles Collapse Al
Expand All

Figure 2 Creating a new Query

The New Query Category dialog box is displayed:

New Query Category X

Category Info

Name :

[y New Guery Categony

Privileges

Grant access to the following roles :

] MUNSYS_ADMIN Py
[C] MUNSYS_ALL_EDIT
] MUNSYS_ALL_QUERY
] MUNSYS_CFS_EDIT
[] MUNSYS_CFS_QUERY
[C] MUNSYS_CMS_EDIT
] MUNSYS_CMS_QUERY
] MUNSYS_CRS_EDIT
[] MUNSYS_CRS_QUERY
] MUNSYS_DMS_EDIT

Figure 3 The New Query Category dialog box

On the New Query Category dialog box, do the following:

= Specify a name for the new query category, with a maximum of 40 characters. Query

categories are uniquely named in a schema; a new query category name must therefore not

Query Categories
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already exist in the MUNSYS_QUERY_CAT table. The name may also not begin or end

with the characters << or >>, as this sequences denotes system reserved names.

Grant access to the query category by selecting the appropriate Munsys role(s) from the list
that is provided. The MUNSYS_ALL_QUERY role is granted access to a new query
category by default.

3  Click OK to create the new query category.
The new query category is saved in the MUNSYS_QUERY_CAT table.
Renaming a query category
To be able to rename a query category, you need to have the following roles/privileges assigned:
Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
Database privileges: UPDATE on MUNSYS_QUERY_CAT

To rename query category

1  Inthe Query Categories content pane, right-click on the category that you want to rename, and then
select the Rename option on the context-sensitive menu, as seen below:

Bl Munsys Management Console (MCITY1SINT) = a X
File  Action Help
15' Applications

f-85 <<Llineage Queries> >

H-1:d < <Uncategorized Queries= »
+- 35 Cable Fibers

S5 Categories H-55 Cable Routes

5 CQueries JE“ETW—
4=/ Roles H-55 Drainage Rename
& Security b-35 Electricity 3¢ Delete
% Privilege H-55 Info Cou
% Tables/Views t-Z5 Roads Collapse Al
{55 Sewer Expand All
) Scheduled Tasks H-35 Water Privileges
i85 Water (A

H- 35 Water (Potable)
+-35 Water (Raw)
H-F5 Water (Reclaimed)

P OO OO OO O O O e O B O IO e O e O o O e O

Renames a query category

Figure 4 Rename Query Categories

2 Specify a new name for the query category, with a maximum of 40 characters. Query categories are
uniquely named in a schema; a new query category name must therefore not already exist in the
MUNSYS QUERY_CAT table. The name may also not begin or end with the characters << or >>,
as this sequences denotes system reserved names. If the new name that you want to give to the query
already exists, an error message to this effect is displayed.
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Changing access to a query category

With this function, you can view or modify the access to a selected query category. You will need
to have the following roles/privileges assigned:

=  Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
®  Database privileges: UPDATE on MUNSYS_QUERY_CAT, MUNSYS_PRIV

To change access to a query category

1  Inthe Query Categories content pane, right-click on the category that you want to modify, and then
select the Privileges option on the context-sensitive menu.

The Query Category Privileges dialog box is displayed.

Query Category Privileges X

Category Info
Name :
Water (Reclaimed)

Privileges

Grant access to the following roles :

MUNSYS_ADMIN A~
MUNSYS_ALL_EDIT

[ MUNSYS_ALL_QUERY

] MUNSYS_CFS_EDIT

[] MUNSYS_CFS_QUERY

] MUNSYS_CMS_EDIT

[C] MUNSYS_CMS_QUERY

] MUNSYS_CRS_EDIT

] MUNSYS_CRS_QUERY

[J MUNSYS_DMS_EDIT

[] MUNSYS_DMS_QUERY

[C] MUNSYS_EMS_EDIT

[] MUNSYS_EMS_QUERY

(] MUNSYS_LICENSE v

Figure 5 The Query Category Privileges dialog box

2 Onthe Query Category Privileges dialog box, change the access to the query category by selecting
or clearing the check boxes adjacent to the roles displayed in the list.

3  Click OK to save the changes to the database.
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Deleting a query category

When a query category is deleted, all the references to the queries in that category are removed
and the queries are marked as Uncategorized. To be able to delete a query category, you need to
have the following roles/privileges assigned:

Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
Database privileges: UPDATE on MUNSYS_QUERY_CAT, MUNSYS_PRIV

To delete a query category

1  Inthe Query Categories content pane, right-click on the category that you want to delete, and then
select the Delete option on the context-sensitive menu.

The Delete Query Category confirmation dialog box is displayed:

Delete Query Category

Are you sure you want to delete the "Water (Reclaimed) query
category?

This operation will remove all references to the queries in this

category and mark them as < <Uncategorized> >,
This operation cannot be undone.

Yes | No

Figure 6 The Delete Query Category dialog box

2 Click Yes on the Delete Query Category confirmation dialog box to delete the query category.

The query category is removed from the MUNSYS_QUERY_CAT table. Any reference
between the queries and the category are removed from the MUNSYS_PRIV table, and any
queries that belonged to the category are moved to the <<Uncategorized>> category.
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Working with queries in a query category

The Queries item in the Query Categories tree of the Munsys Management Console is used to

maintain queries within a query category. The queries can be viewed as either a tree or a list.

The view is set by right-clicking on Queries, and then selecting the View as Tree or View as List

option.

®  The View as Tree option displays the queries in a tree control, with the top level of the tree
containing the query category and the sub-level containing queries that belong to the
various categories.

Bl Munsys Management Console (MCITY15INT) - O x

File  Action Help

(3 Applications
- 8 Locks

View queries as a tree

Figure 7

- <<Lineage Queries>>
=] -!, Cable Fibers

(125 Query Categories Fac Cable Fil Rename
25 Categories ** CableFit ¥ Delete
- f )
! Chaerins e Catke Flh Collapse All
S Roles "'\,, Cable Fig
&) :H Security +++ Cable Fit Expand All
i M Privilege *,, Fiber C/ ViewasTee |
o By Tables/Views *y, Fiber Pat =
B Lineage *, Qry: Fibe
) Scheduled Tasks *. Qy: Fibe Privileges

*y, Quy: Fiber SEFaRd COURE IR Uz

-8 Cable Routes
.! Cadastral
-8 Drainage
- Flectricity

View queries as tree

®  The View as List option displays a sortable multi-column list.

Bl Munsys Management Console (MCITY15INT) — O X
File  Action Help
L‘EE Applications CQuery Name Category Priority
r+ ) Locks ) [B)Block Boundaries Cadastral 1.21
223 Quecrthategorles [@Buildings Cadastral 1.33
!r!::,‘ Q::r?::gs e Cable Fiber Dimension Notes Cable Fibers 56,60
el Roles W Cable Fiber Dimensions N
&% Sty Fac Cable Fiber Notes Copy to Caagory.. 56.30
& I Privilege *,, Cable Fiber Service Connections Move to Category... 56.70
e B Tobles/Views *)" Cable Fiber Symbols Bename 5650
% Lineage EH:Cable Route Dimension Notes % Delete 5541
443 Scheduled Tasks + Cable Route Dimensions : 55.31
[O) Cable Route Infrastructure View as Tree 55.25
Kac Cable Route Labels [V Viewas List 55.51
*,, Cable Route Links . 55.21
*¥ Cable Route Nodes s e ki s 55.24
T—nl’=h|n Raida Mater Tahla Raidar LUV )
| View queries as a list
Figure 8 View queries as list
Using the context-sensitive (right-click) menu, queries can be:
= Copied to other categories
®  Moved to another category
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® Renamed
®  Deleted
®  Assigned a query priority

Bl Munsys Management Console (MCITY15INT) = O x

File  Action Help
{3 Applications | B <<lineage Queries>>
B Locks -4 Cable Fibers
33 Query Categories s Cable Fiber Dimension Notes
: 35 Categories tf Cable Fiber Dimensions
ac Cable Fiber Notes
"\, Cable Fiber Service Connections
_** Cable Fiber Symbols

o EB- Privilege .g\} Fiber Cables
-y Tables/Views *, Fiber Paths Copy to Category...
B Lineage *y, Qry: Fiber ¢ Move to Category...
19 Scheduled Tasks : "\,, Qry: F!herP Pt
'9\,. Qry: Fiber 5
-8 Cable Routes Delete
8 g Caiclastral Collapse Al
[ Drainage
Expand All
o M Flectricity P
_ W View as Tree -
View as List [
Set Query Priority...

Figure 9 View query options

Copying a query to one or more categories

1  Right-click on the query that you want to copy, and then select Copy to Category... from the
context-sensitive menu.

Tip Ifyou are copying a query to the same category it is currently associated with, you will have the option to
replace the query, which retains the QRY _ID of the original query, but replaces the content of the query
in the MUNSYS QUERY table.

The Copy Query dialog box is displayed, showing the name of the query that you have selected.
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Tip

Copy Query X

Destination

Query :
[Cable Fiber Dimensions|

Query Categories

[[] «<Lineage Queries>> A
[ «<Uncategorized Queries...

[] Cable Routes

[ Cadastral

[] Drainage

[] Bectricity

[C] Roads

[1 Sewer

[] Water

[[] water (Abandoned)

] Water (Potable)

[] water (Raw)

[ Water (Reclaimed) i

Cancel Help

Figure 10 The Copy Query dialog box

Change the query name if required.

From the Query Categories list, select the category(ies) that you want the query copied to by
checking the boxes, and then click OK.

A copy of the query is created for each of the categories that you selected. The query name remains
the same, but a new QRY_ID is assigned for each copy.

Moving a query to another category

When a query is moved to another category, the QRY_ID and the query record in the
MUNSYS_QUERY table stay the same, but the MUNSYS_QUERY_CAT table is updated to
change the category reference to the query.

To move a query to another category, do the following:

Right-click on the query that you want to move, and then select Move to Category... from the
context-sensitive menu.

The Move Query dialog box is displayed, with the current category of the query excluded.
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Move Query - Cable Fiber Dimensions

Category

Query Category:
<<Lineage Queries>> v

oK Cancel Help

Figure 11~ The Move Query dialog box

On the Move Query dialog box, select the category that you want to move the query to from the

Query Category list.

The query is moved to the selected category. If a query with the same name already exists within the
new category, an error message will be displayed, and you will not be able to move the query.

Move Errors

Unable to move query ‘Cable Fiber Notes',

Routes’.

X

Query 'Cable Fiber Notes’ already exists in category 'Cable

Figure 12 Move Query Warning Message
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Renaming a query

1  Right-click on the query that you want to rename, and then select Rename from the context-sensitive
menu.

2 Enter a new name for the query.

The query is renamed and the record in the MUNSYS_QUERY table is changed accordingly.
If a query with the same name already exists within the category, an error message will be
displayed, and you will not be able to rename the query.

Deleting a query

Right-click on the query that you want to delete, and then select Delete from the context-
sensitive menu.

The following message is displayed:

Delete Query

e Are you sure you want to delete the ‘Cable Fiber Symbols’
query?

This operation cannot be undone.

Yes No

Figure 13 Delete Query warning message

3  Click Yes to delete the query.
The query is deleted from the MUNSYS_QUERY table, and the association with the query
category is deleted from the MUNSYS_QUERY_CAT table.

Tip If you want to remove a query from a query category, but do not want not delete the query from the
database, use the Move to Category... item on the context-sensitive menu.

Setting a query priority

The query priority of any query determines which objects will be queried on top of others. You
have to have the MUNSYS_POWER role assigned to be able to set a query priority.

1  Right-click on the query for which you want to set/change the priority, and then select Set Query
Priority... from the context-sensitive menu.

The Query Priority dialog box is displayed.
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Priortty (56.5)

Query Priorty (Dto 100):

Query Priority - Cable Fiber Symbols

x

Figure 14  The Query Priority dialog box

2 Enter a value between 0 and 100. Clicking on the arrows will increment the priority by a whole
number; decimal numbers have to be entered manually. A low number means that the query will be
executed before queries with higher numbers. This means that queries with a higher number will be
executed towards the end of the query process, causing the objects with a higher priority to be placed
on top of the objects queried from queries with a low query priority.

3  Click OK to assign the query priority to the selected query.

Working with query category roles

The Roles tree item in the Query Categories tree of the Munsys Management Console is used

to maintain access privileges to query categories. When the Roles tree item is activated, all

Munsys roles (MUNSYS_) are displayed in a tree view control in the content pane. The tree
contains all the available MUNSYS_roles as the top level nodes, and the query categories as the

sub-level nodes.

Ei Y
File  Action Help
(3P Applications
¥ B Locks
=33 Query Categories
%5 Categories
B Queries
43| Roles
H-apy Security
-} Privilege
1. Y Tables/Views
% Lineage

=) Scheduled Tasks

When you right-click on a role in the content pane, the context-sensitive menu can be used to

185 MUNSYS_ADMIN

25 <<Lineage Queries>>

25 <<Uncategorized Queries> >

35 Cable Fibers

235 Cable Routes

=4 Cadastral

=4 Drainage

=5 Electricity

23 Info Counter

23 Roads

2 Sewer

S Water

35 Water (Abandoned)

2 Water (Potable)

25 Water (Raw)

35 Water (Reclaimed)
+-G=| MUNSYS_ALL_EDIT
48] MUNSYS_ALL_QUERY

change the privileges for accessing categories by:

Removing access to query categories from a role — revokes access from a role so that it no

longer has access to any query categories.

Granting or revoking access of a role to multiple query categories — changes the access that
a particular role has with regard to various query categories.
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Bl Munsys Management Console (MCITY15INT) ot | X
File  Action Help
@@ Applications

45| MUNSYS_ADMIN

£3]

8 Lo B, oy .
=33 Query Categories 33 <<lineage 0“':] Remove ANl Query Categories ]
| .3 Categories 53 <<Uncategoriz Query Category Privileges..
& Queries 34 Cable Routes
55| Roles B35 Cadastral Collapse All
[-ap Security 23 Drainage Expand All
w0 Privilege =3 Electricity
- fERg Tables/Views =3 Info Counter
I Lineage =3 Roads
i) Scheduled Tasks =5 Sewer
25 Water
335 Water (Abandoned)
.35 Water (Potable)
S Water (Raw)

L=g Water (Reclaimed)
&= MUNSYS_ALL_QUERY
85| MUNSYS_CFS_EDIT

]

B

| Revoke all query categories

= When you right-click on a query category assigned to a role in the content pane, you can
remove the access from the role to which it has been assigned using the Remove Privilege
from Role context-sensitive menu item. You will be prompted for confirmation before
access is removed for the role.

Bl Munsys Management Console (MCITY1SINT) = O X

File  Action Help

1? Applications 4= MUNSYS_ADMIN
& Locks MUNSYS_ALL_EDIT
25 Query Categories -85 «<<Llineage Queries>>
835 Categories -85 «<Uncategorized Queries» »
) Cadastr,x_ Remove Category from Role
.35 Drainag
-85 Electric
.85 Info Co Expand All
-85 Roads
JQ Scheduled Tasks B Sewer
-85 Water
-85 Water (Abandoned)
-85 Water (Potable)
B Water (Raw)
-85 Water (Reclaimed)
-G MUNSYS_ALL_QUERY

i=[ MUNSYS_CFS_EDIT

Collapse All

Revoke access from role
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Removing all query categories from a role

With this function, you can revoke access to query categories from a selected Munsys role.
When this is done, all the entries associated with the role are removed from the

MUNSYS_PRIV table.

1  Right-click on the appropriate role in the content pane, and then select Remove All Query

Categories from the context-sensitive menu.

Bl Munsys Management Console (MCITY15INT) ot | X
File  Action Help
L:'J{f Applications -85 MUNSYS_ADMIN
o Locs B s 1ot ,
=-23 Query Categories =5 <<Lineage Quui Remove All Query Categories
| 97 Categories 25 <<Uncategeriz Query Category Privileges...
B Queries 35 Cable Routes
35 Roles =34 Cadastral Collapse All
-4y Security =3 Drainage Expand All
& ﬁ Privilege 25 Electricity
- Tables/Views =3 Info Counter
% Lineage 33 Roads
i) Scheduled Tasks =3 Sewer
25 Water
5 Water (Abandoned)
=5 Water (Potable)
.85 Water (Raw)
35 Water (Reclaimed)
-85 MUNSYS_ALL_QUERY
-85 MUMSYS_CFS_EDIT
| Revoke all query categories
The following message is displayed:
Remove Privileges
Are you sure you want to remove all query categories
from the "MUNSYS_ADMIN' role?
to
Figure 15  The Remove Privileges dialog box
2 Click Yes to remove access to all the query categories from the role.
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Granting or revoking access of a role to multiple query categories

1  Right-click on the appropriate role in the content pane, and then select
Query Category Privileges... from the context-sensitive menu.

ﬁ Munsys Management Console (MCITY15INT)

File  Action Help

{3 Applications
i@ Locks

=3 Query Categories
-85 Categories
B Queries

%= Roles

' g.i.’l Security

L+3 a Privilege

% Tables/Views

: % Lineage

29 Scheduled Tasks

The Query Category Privileges dialog box is displayed, showing the query categories to which access
has already been granted for the role, as well as the query categories that are available to the role.

-85 MUNSYS_ADMIN
SRS MUNSYS ALL_EDIT,

-

L& <<Lineage Que > Remove All Query Categories

g < <Uncategorizt] Query Category Privileges...

-85 Cable Routes
—35 Cadastral Collapse All
23 Drainage Expand All

25 Electricity
83 Info Counter
25 Roads

-8 Sewer
85 Water
-85 Water (Abandoned)
35 Water (Potable)
-85 Water (Raw)

Query Category Privileges *
Role
Name: |MUNSYS_ALL_EDIT
Query Categories
Available Query Categories: Query Categories Granted:
Cable Fibers ¢<lineage Queries>> ~
<<Uncategorized Queries>>
Cable Routes
Add > Cadastral
P — Drainage
Blectricity
Roads
Sewer
Water
Wtar (Ahandnnad) v
< >
Cancel Help
Figure 16  The Query Category Privileges

2 Add or remove the query categories to the role as required.

3  Click OK to apply any changes that you have made.
The MUNSYS_PRIV table is updated accordingly.
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Note

Chapter 8

Security

Introduction

In the Munsys Management Console, security management consists of the creation and
maintenance of database users and roles. Database users and roles are managed on the Security
tree. Roles place users in a “category” where certain responsibilities are associated with these
roles. Depending on the role of a user, varying components and/or menu items in the console
will be available for manipulation. The Munsys Management Console recognizes the
following roles:

*MUNSYS_ADMIN - this role is reserved for users who have the authority to change
structure such as creating, dropping or validating schemas, tables or views, re-indexing
tables, overriding object locking status, or manipulating database users and the roles or
privileges that may be assigned to them.

MUNSYS_POWER - this role is reserved for users who have the authority to change the
content of items such as rules, lookup tables and application settings.

MUNSYS_APP_EDIT — users with this role assigned can create and modify objects in a
specified Munsys application only (where APP is the relevant application, for example
MUNSYS_CDS_EDIT or MUNSYS_DRN_EDIT)

MUNSYS_ALL_EDIT - users with this role assigned can create and modify objects in all
of the Munsys applications

MUNSYS_APP_QUERY — users with this role assigned can query objects from a specific
Munsys application only (where APP is the relevant application, for example
MUNSYS_CDS_QUERY or MUNSYS_DRN_QUERY)

MUNSYS_ALL_QUERY - users with this role assigned can query objects from all the
Munsys applications

Having the MUNSYS_ADMIN role assigned is not enough to create and manipulate objects; Oracle
expects other privileges to also be assigned to a user as well before objects such as tables, etc. can be
created or manipulated. The database administrator has the ability to still restrict other privileges in respect
of a user with the MUNSYS_ADMIN role assigned.
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The Security tree: overview
The Security tree consists of two branches (nodes):
1  Users —used for the creation and maintenance of users in the database. When you click on Users in

the Security tree, the content pane displays the relevant user name, with all the assigned Munsys
roles as sub-items. Right-clicking on an item displays a context-sensitive menu, from which user

maintenance can be done.

Ei Munsys Management Cons Y15INT O x
File  Action Help
|_:_|_‘.:33I Query Categories
S5 Categories
B Queries o
5= Roles -4k GISPROD
Security -4 GSC_TEST
Users < 5 GSMADMIN_INTERNAL
=| Roles o
=B Privilege
. Table/Views
&= Roles o iy
- Tables/Views g MCITY12US
% Spatial Tables []---:,;a MCITYT1HNT
% Attribute Tables []---:,3 MCITY14U5
% Lookup Tables []---:,;a MCITY15INT
ER Indexes - & MDDATA
LER Trgges || e L MDsYs
Figure 1 Security tree: Users
Note You have the option of displaying all the database users, or only the Munsys users. This is set by selecting

a user, and then selecting the Display all Users or Display Munsys Users option on the Action menu or

the context-sensitive (right-click) menu.

Ei Munsys Management Console (MCITY15INT)

File  Action Help

,31:3 Cuery Categories
35 Categories
5 Queries

=| Roles

& Users

&=| Roles

[—j% Privilege

BB, Table/Views
5= Roles

- Tables/Views

: % Spatial Tables
% Attribute Tables
% Lookup Tables

% Indexes

Display only Munsys users

(-4t GISPROD

§9 GSC_TEST,
MCITY12

Assign Roles...
Drop User

Display All Users

Display Munsys Users

Collapse All
Expand All

Properties...

Figure 2

Displaying Munsys Users
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Roles —used for maintenance of the database roles and the creation of Munsys roles. When you click

on Roles in the Security tree, the content pane displays all the database roles, with their assigned
users as sub items. Right-clicking on an item displays a context-sensitive menu, from which role

maintenance can be done.

B Munsys Management Consol O X
File  Action Help
[-{3 CMS - Cadastral 85| MUNSYS_ABC
[#-{@F CRS - Cable Route =| MUNSYS_ADMIN
G-£38 DMS - Drainage 4= MUNSYS_ALL_EDIT
F-{@P EMS - Electricity 5| MUNSYS_ALL_QUERY
[-{38 MBK - Map Books MUNSYS_CFS_EDIT
&-£2P QRY - Query MUNSYS_CFS_QUERY
({38 RMS - Roads 45| MUNSYS_CMS_EDIT
[]--fi! SDM - Spatial Data Manager = MUNSYS_CMS_QUERY
[-(P SMS - Sewer = MUNSYS_CRS_EDIT
(g WMS - Water MUNSYS_CRS_QUERY
MUNSYS_DMS_EDIT
= MUNSYS_DMS_QUERY
=8 Query Categories &=| MUNSYS_EMS_EDIT
35 Categories MUNSYS_EMS_QUERY
=| MUNSYS_LICENSE
= MUNSYS_MBK_EDIT
MUNSYS_MBK_QUERY
MUNSYS_POWER
MUNSYS_QRY
[—]% Privilege MUNSYS_RMS_EDIT
: a Table/Views =| MUNSYS_RMS_QUERY
E = MUNSYS_SDM_EDIT
[—Ja Tables/Views 4= MUNSYS_SDM_QUERY
5 Spatial Tables = MUNSYS_SMS_EDIT
% Attribute Tables &= MUNSYS_SMS_QUERY
=| MUNSYS_TMS_EDIT
MUNSYS_TMS_QUERY
MUNSYS_WMS_EDIT
% Lineage B85 MUNSYS_WMS_QUERY
-3y Scheduled Tasks
Figure 3 Security tree: roles
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Working with Munsys users

Using the context-sensitive (right-click) or Action menu, you can create a new user, assign roles
to a user, drop a user, change the role assignment of a user or revoke a role from a user.

MNew User...

Display All Users

-G=| Rol

E% Tables.

Spa Collapse all
% Lo Expand Al

Display Munsys Users

Indexes T

Assign Roles...
Drop User

Display All Users

Display Munsys Users

Collapse Al
Expand Al

Properties...

Creating a new Munsys user

When a new Munsys user is created, the MUNSYS_ALL_QUERY and CONNECT roles are

assigned by default.

1  To create a new Munsys user, do one of the following:

m  Click on Users in the Security tree, and then select New User... from the Action menu

m  Right-click on Users in the Security tree, and then select New User... from the context-sensitive

menu.

The User Details dialog box is displayed, showing the User Details tab.

User Details
User Info  Assign User Roles

User Details

Enter the user details below.

User Name : |

Password : |

Confirm Password : I

Account Security

Specify the user security settings below.

Status O Locked

@®) Unlocked

] Expire Password

Figure 4 The User Details dialog box: User Details tab
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Under User Details, enter the following information for the new user:
® the user name
m  password

m  password confirmation
Under Account Security, you can lock a user, or expire a user’s password.

m  Expiring the password will prompt the user to change their password when they next login.

By Default the Status of the account is set to Unlocked allowing the user to connect to the
database.

m  The Locked status option will lock their account preventing them from connecting to the
database when opening a Munsys session.

Click the Assign User Roles tab to assign Munsys roles to the new user. The
MUNSYS_ALL_QUERY role is assigned by default.

User Details X

User Info

Use the lists below to manage roles for the user.

Available Roles : Assigned Roles :
MUNSYS_ADMIN A MUNSYS_ALL_QUERY
MUNSYS_ALL_EDIT
MUNSYS_CFS_EDIT
MUNSYS_CFS_QUERY
MUNSYS_CMS_EDIT
MUNSYS_CMS_QUERY
MUNSYS_CRS_EDIT -
MUNSYS_CRS_QUERY < Remove
MUNSYS_DMS_EDIT

MUNSYS_DMS_QUERY

MUNSYS_EMS_EDIT

MUNSYS_EMS_QUERY

MUNSYS_LICENSE

MUNSYS_MBK_EDIT

AL IBICWE BANK MIEOW

Cancel Help

Figure 5 The User Details dialog box.: Assign User Roles tab

Select the check box adjacent to the role that you want to add or remove, and then use the Add or
Remove buttons as required.

When you have specified all the details for the new user, click Commit to save the new user to the
database.
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Changing user properties

Using the Properties option on the context-sensitive menu or the Action menu when a user
name is selected, the password, security settings and role allocation for a user can be changed.

To change user properties, do the following:

1  Select a user name in the content pane, and then choose either
Action > Properties, or the Properties option on the context-sensitive menu.

2 The User Details dialog box is displayed, showing the User Details tab.

UserInfo  Assign User Roles

User Details

Enter the user details below.

User Mame : JOESMITH
Password : et
Confirm Password : R

Account Security

Specify the user security settings below.

Status : (D) Locked © Unlocked

[ Expire Password

Cancel Help

Figure 6 The User Details dialog box.: Properties

3 Change the user details or account security as required.
4 On the Assign User Roles tab, add or remove roles from the user.

5 Click Commit to save the changes to the database.

Tip Selecting the Assign Roles option from the context-sensitive or the Action menu when a user is selected
directly displays the Assign User Roles tab.
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Dropping a user

To drop a user do the following:

1  Right-click on the user name, and then select the Drop User option from the context-sensitive menu,
or select the Drop User menu item from the Action menu.

2 The following confirmation message is displayed:

o Are you sure you want to drop user JOESMITH'?

User "JOESMITH' still owns objects. Dropping the user will
also remove the objects owned by the user.

Yes Mo

Figure 7 Drop user confirmation message

Working with Munsys roles
In the Munsys Management Console, Munsys roles are created and maintained from the Roles
item in the Security tree. You have the option of displaying all the database users in the content
pane, or only the Munsys users. This is set by selecting a user, and then selecting the Display all
Users or Display Munsys Users option on the Action menu or the context-sensitive (right-click)
menu.

Creating a new Munsys role

To create a new Munsys role, do the following:

1  Select Roles in the Security tree, and then select the New Munsys Role option on the Action menu,
or right-click on Roles in the Security tree, and then select the New Munsys Role option from the
context-sensitive menu.

The New Munsys Role dialog box is displayed.

New Munsys Role X

Role Info

Role Details

Role Name :  MUNSYS |

Cancel Help

Figure 8 The New Munsys Role dialog box

2 On the New Munsys Role dialog box, enter a name for the role, and then click Commit to save the
new Munsys role to the database.
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Dropping a role from the database

3

To drop a role from the database, do the following:

Right-click on the role that you want to drop in the content pane, and then select the Drop Role
option from the context-sensitive menu, or select the Drop Role menu item from the Action menu.

The following confirmation message is displayed:

o Are you sure you want to drop the "MUNSYS_HELPDESK' role?

Dropping the "MUMNSYS_HELPDESK' role will remove it
permanently from the database.

Yfes MNa

Figure 9 Drop Role confirmation message

Click Yes to drop the role from the database.

Revoking a role from a user

3

To revoke a role from a user, do the following:

Right-click on a user name in the content pane, and then select the Remove option from the context-

sensitive menu, or select the Remove option from the Action menu.

The following confirmation message is displayed:

Are you sure you want to revoke the "MUNSYS_POWER' role
from the "JOESMITH' user?

Revoking the "MUNSYS_POWER' role from the user
JOESMITH' will prevent the user from accessing objects that
require this role,

Yes Mo

Figure 10 Revoke Role confirmation message

Click Yes to remove the role from the user.
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Chapter 9

Privilege

Introduction

In the Munsys Management Console, privilege management consists of granting or revoking
privileges on database objects to the users. The administrator can grant or revoke privileges
assigned to the Munsys roles on a table or view and visa-versa.

The Munsys roles are a collection of privileges or access rights to the various tables and views
in the Munsys schema. The administrator assigns a user to Munsys role and then assigns the
role to a spatial table or spatial view. They then grant the role a combination of SELECT,
INSERT, DELETE and/or UPDATE privileges for that spatial table or spatial view.

SELECT - roles with this privilege can select data from a database object. This is used
when users run any of the queries to which they have access in the Munsys applications.

INSERT - roles with this privilege can insert rows into a spatial, attribute or lookup table.
This is used when users post new objects to the database or when a user with the

MUNSYS_POWER role edits the lookup table values in the Munsys Management

Console application.
DELETE - roles with this privilege can delete objects from the table or view.

UPDATE - roles with this privilege assigned can modify existing data in the Munsys
tables. This is used when using any of the change commands in the Munsys applications.



The privilege tree: overview
The Privilege tree consists of two branches (nodes):
1  Tables/Views — used for assigning roles to the tables and views. When you click on Tables/Views
in the Privilege tree, the content pane displays all the table and views in the schema. Right-clicking

on an item displays a context-sensitive menu, where the administrator can assign a role to a table or
view.

File  Action Help

-3 Applications -y SP_BLOCK
2 Locks By SP_BUILDING
Gy Records -y SP_CMSNOTE
5133 Query Categories [j--% SP_COMT3M
84 Categories - By SP_CRTDIM
-y SP_CRTINFSTRUCT
-y SP_CRTLABEL
- SP_CRTLINK
By SP_CRTNODE
-y SP_CRTNOTE
-y SP_CRTSYM
.y Table/Views B SP_CTATSM
\..gz| Roles - B SP_DAM
- Tables/Views - By SP_EASELINE
B Spatial Tables -y SP_EASELINETXT
ER Attribute Tables - SP_EASEPOLY
B Lookup Tables [j--% SP_EASEPOLYTHT
B Indexes -5y SP_ELCABLE
.ER Triggers -y SP_ELDIM
[ Lineage -y SP_ELDUCT
\-‘fk' Scheduled Tasks [j--% SP_ELNODE
- SP_ELNOTE

Figure 1 Privilege tree: Tables/Views

2 Roles —used for maintenance of tables and views assigned to Munsys roles. When you click on
Roles in the Privilege tree, the content pane displays all the Munsys database roles. Right-clicking
on an item displays a context-sensitive menu, where the administrator can assign a table or view to
arole.
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File  Action Help

E Applications
BB Locks

iy SECUTitY

& Users
5= Roles

=B Privilege

B Table/Views

- Tables/Views

% Spatial Tables
EG, Attribute Tables
) Lookup Tables

: % Indexes

052 MUNSYS_ALL_QUERY
MUNSYS_CFS_EDIT
MUNSYS_CFS_QUERY
MUNSYS_CMS_EDIT
MUNSYS_CMS_QUERY
MUNSYS_CRS_EDIT
MUNSYS_CRS_QUERY
MUNSYS_DMS_EDIT
MUNSYS_DMS_QUERY
MUNSYS_EMS_EDIT
MUNSYS_EMS_QUERY
MUNSYS_HELPDESK
MUNSYS_LICENSE
MUNSYS_MBK_EDIT
MUNSYS_MBK_QUERY
MUNSYS_POWER
MUNSYS_QRY
MUNSYS_RMS_EDIT

MUNSYS_RMS5_CUERY
MUMNSYS_SDM_EDIT
MUNSYS_SDM_QUERY
MUNSYS_SMS_EDIT

% Lineage

-4l Scheduled Tasks

Figure 2 Privilege tree: roles

Assigning a role to a table or view

When a new Munsys table is created using the Munsys Management Tables/Views > Create
New Table option, the following roles are automatically assigned to the new table:

MUNSYS_ADMIN
MUNSYS_ALL_EDIT
MUNSYS_ALL_QUERY
MUNSYS_POWER
MUNSYS_SDM_EDIT

MUNSYS_SDM_QUERY
Should the administrator wish to make the table available to specific Munsys applications for
querying or editing, they will need to assign the Munsys roles for the various applications to the
table or view.

1  To assign a role to a table do the following:

Click on Tables/Views in the Privilege tree and the content pane is populated with a list of all
tables and views in the schema.

In the content pane select the table or view to which you want to assign the role to.
Right-click on table name in the content pane and select the Assign Role option from the

context-sensitive menu.

Note The administrator has an option of using the right click context-sensitive menu Assign Role to assign
the role or they can select the table or view in the content pane and select Action > Assign Role from
the main menu.

Privilege
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Note

The Assign Role dialog box is displayed showing the Assign Role tab with the table or view name
in the dialog box header.

Assign Role to Table SP_BUILDING X

Assign Role

Select Role:
MUNSYS_ALL_QUERY v
Privileges Assigned

SELECT [] INSERT
[[] DELETE [] UPDATE

Figure 3 The Assign Role dialog box: Assign Role tab

From the Select Role drop down list select the role to be assigned to the table or view.

Check the tick boxes next to the privileges you want to assign to the role on the table or view.

Assign Role to Table SP_BUILDING X

Assign Role

Select Role:
MUNSYS_ALL_QUERY

Privileges Assigned

SELECT [ INSERT
[ DELETE [AIUEDATE:

Commit Cancel

Figure 4 The Assign Role dialog box: Privileges Assigned
Select the Commit button to save the changes to the database.

This selection process must be repeated for all roles added to the table or view.

At least one privilege must be assigned to the role to activate the Commit button.

The administrator user must select the Action > Refresh optin to view the changes in the content
pane.
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Removing a role from a table or view

Should the administrator wish to remove the table from the Munsys applications for querying
or editing, they will need to remove the Munsys roles for the various applications to the table
or view. A manual refresh is required to view the changes in the content pane.

1  Toremove a role assigned to a table do the following:

m  Click on Tables/Views in the Privilege tree and the content pane is populated with a list of all
tables and views in the schema.

= In the content pane select the expand node next to the table or view whose roles you want to
remove.

m  Right-click on role and select the Remove option from the context-sensitive menu.

Bl Munsys Management Console (MCITY15INT) = O X
File  Action Help

-3 Applications [ By sp_ELsERV

-3 Locks +- Py SP_ELZONE

| gk Records + B SP_FIBCABLE
=) ~3f_'|j Query Categories G % SP_FIBDIM

-85 Categories a % SP_FIBNOTE

B Queries 1 By SP_FIBPATH

Roles + B2, SP_FIBSERV

i Security +- By SP_FIBSYM

> + B SP_FLOODLINE

i : + 5y SP_GEOSCAN_BNDRY
- B Privilege = B sp_PARCEL

B Table/Views +- By SP_RAILWAYLINES

. 1.8z Roles = BBy SP_RAIL_RESERVE
=By Tables/Views &2 MUNSYS_ADMIN
-Bg Spatial Tables E MUNSYS ALL EDI Tt
ER Attribute Tables 42| MUNSYS_ALL_Qui#%_ Remove J
ﬁ}: Lookup Tables &= MUNSYS_POWER Collapse All
L) Indexes &2 MUNSYS_SDM_ED Expand Al
-] Triggers 2] MUNSYS_SDM_QL
M Lineage - B SP_RDAREA
\JS' Scheduled Tasks +) % SP_RDCL
| @B SP_RDEDGE
Remove the assigned role from table/view
Figure 5 The Remove command in the context-sensitive menu
Note The administrator has an option of using the right click context-sensitive menu Remove to remove the

role or they can select the role in the expanded list of roles in the content pane and select Action >
Remove from the main menu.

2 The Remove Role warning message is displayed. Click Yes to remove or No to cancel.

Remove Role

Are you sure you want to remove the "MURNSYS_ALL_EDIT role
from the 'SP_RAIL_RESERVE' tablefview?

Yfes MNa

Figure 6 Warning message displayed when removing a Role from a table.
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Assigning a table/view to a role

1  To assign a table or view to a Munsys role do the following:

Click on Roles in the Privilege tree and the content pane is populated with a list of all Munsys
roles in the schema.

In the content pane select the role you want to assign the table or view to.

Right-click on the role in the content pane and select the Assign Table/View option from the
context-sensitive menu.

The Assign Table dialog box is displayed showing the Assign Table tab with the Munsys role name
in the dialog box header.

Assign Table to Role MUNSYS_ALL_QUERY X
Assign Table

Select Table:
SP_BUILDING "
Privileges Assigned

SELECT [] INSERT
[] DELETE [J] UPDATE

Close

Figure 7 The Assign Table to Role dialog box: Assign Table tab

2 From the Select Table drop down list select the table or view to be assigned to the role.

3 Check the tick boxes next to the privileges you want to assign to the role on the table or view.

Assign Table to Role MUNSYS_ALL_QUERY X
Assign Table

Select Table:
SP_BUILDING

Privileges Assigned

SELECT [ INSERT
[7] DELETE UPDATE

Commit Cancel

Figure 8 The Assign Table dialog box. Privileges Assigned
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4  Select the Commit button to save the changes to the database and then click the Close button to close
the dialog box

This selection process must be repeated for all table or views added to the Munsys roles.

Note At least one privilege must be assigned to the role to activate the Commit button.

5  The administrator user must select the Action > Refresh optin to view the changes in the content
pane.
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Removing a table/view from a role

1  To remove a table or view from a Munsys role do the following:

Click on Roles in the Privilege tree and the content pane is populated with a list of all Munsys
roles in the schema

In the content pane select the expand node next to the Munsys role whose table or view you want
to remove.

Right-click on the table name and select the Remove option from the context-sensitive menu.

H Munsys Management Console (MCITY13INT)

File  Action Help
(38 Applications £)-2] MUNSYS_SMS_EDIT
BBy GEN_DWGCAT

- H Locks

55 Categories
B Queries

[—j% Privilege
BB Table/Views

Roles

-y Tables/Views

: % Spatial Tables
% Attribute Tables
5} Lookup Tables

43 Scheduled Tasks

% LU_GEN_DATAQUALITY
% LU_GEN_JUSTIFICATION

- EB LU_MD_MAINTENANCE
-EB LU_MD_PROGRESS
BB LU_SMS_GPIPEDIA
BB LU_SMS_GPIPEMATRL
BB LU_SMS_GPIPETYPE
BB LU_SMS_NODEFUNC
. EB LU_SMS_RPIPEDIA
BB LU_SMS_RPIPEMATRL
BB LU_SMS_RPIPETYPE
.EBy LU_SMS_SERVTYPE
BB LU_SMS_SEWSYM

% LU_MD_CURRENTNESSREF

=¥ LU_SMS_VPIPEDLA

B Indexes - LU_SMS_VPIPEMﬁ’W‘
B Triggers BBy LU_SMS_VPIPETVE Collapse All
[ Lineage - E MUNSYS_APPLIC Expand Al
. EBq MUNSYS_AP_SE

BBy MUNSYS_AT COLUMNS

Remove the assigned table/view from role

Figure 9 The Remove command in the context-sensitive menu

2 The Remove Table/View warning message is displayed.

i
3
m
o
=)
e
m

Are you sure you want to remove the 'LU_SMS_VPIPEDIA
table/fview
from the "MUNSYS_SMS_EDIT' role?

Yes Mo

Figure 10 Remove Table/View warning message

3 Click Yes to remove the table or view.

4  The administrator user must select the Action > Refresh optin to view the changes in the content
pane.
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Chapter 10

I:Fflbles, Views and Indexes

Introduction

The Tables/Views tree of the Munsys Management Console is used to manage spatial tables,

lookup tables and indexes in the database.

With this tree, you can:

Create, maintain and validate spatial tables
Create and mainatin attribute tables
Create and maintain lookup tables

Create and maintain indexes on spatial tables, attributes and lookup tables
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The Tables/Views tree: overview
The Tables/View main tree consists of three branches (nodes):

w  Spatial Tables

®  Actribute Tables
= Lookup Tables
® Indexes

w  Triggers

Using the Action menu or context-sensitive (right-click) menu that is activated when an item
is selected, tables and indexes as created and maintained.

Bl Munsys Management Console (MCITY15INT) = O X
File  Action Help
E Applications

: % Spatial Tables

{8 Locks B Attribute Tables
=5 Query Categories % Lookup Tables
iy SECUrity % Indexes

% Privilege % Triggers

% Tables/Views
% Spatial Tables
% Attribute Tables
% Lookup Tables
% Indexes

% Triggers

% Lineage

=y Scheduled Tasks

Figure 1 Munsys Management Console: Tables/Views tree
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Working with spatial tables in the Munsys Management Console

Using the Spatial Tables item in the Tables/Views tree, you can do the following:

Create custom spatial tables

Drop a spatial table
Validate a spatial table

Add, modify or delete a column in a spatial table

Edit Table Description

Creating custom spatial tables

Custom spatial tables are created by selecting the Create New Table or Create from Existing
Table option on the Action menu, or from the context-sensitive (right-click) menu that is
displayed when you right-click on Spatial Tables in the Tables/View tree.

[E
[
£
[
[

Bl Munsys Management Console (MCITY15INT) O X
File Action  Help

]E Applications 1D Description Table Mame Table Type Geometry Type
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J.k{ﬂcn Easement Line Text SP_EASELINETXT TABLE Label
J'\.,‘ID Easement Lines SP_EASELINE TABLE Line

Create new spatial table tooltip

Figure 2

Select Create New Spatial Table

Spatial table names and descriptions have to be unique; when a new table is created in the
database, the system checks whether the name or description is not yet present. If this is the

case, the table will not be created. A custom spatial table is always assigned a MUNID of >1000.

Tables, Views and Indexes
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When a new spatial table is created, the following happens:
The default columns are added to the table based on the Geometry Type selected.
The table is inserted into MUNSYS_SP_TABLES
The columns are inserted into MUNSYS_SP_COLUMNS
The Geometry Metadata (USER_SDO_GEOM_METADATA) is updated
A new entry is added to the system table MUNSYS_QUERY.
A new Query with the same table description is added to the <<Uncategorized Queries>>.

Indexes are created on the GID and Geometry columns of the new table

Roles are assigned to the table (MUNSYS_SDM_QUERY, MUNSYS_ALL_QUERY,
MUNSYS_SDM_EDIT, MUNSYS_ALL_EDIT, MUNSYS_POWER,
MUNSYS_ADMIN)

When a new spatial table is created from an existing table, the following happens:
The default columns are added to the table based on the Geometry Type selected.
Columns are created in new table that exist in the old table but not in the new one

Columns with the prefix _OLD in are created in the new table for all columns that exist in

both the old and new tables.

All the data from the original table is copied into new table into the corresponding OLD_
columns, however the GEOMETRY does not get assigned an OLD_ column name.

The table is inserted into MUNSYS_SP_TABLES

The columns are inserted into MUNSYS_SP_ COLUMNS

The Geometry Metadata (USER_SDO_GEOM_METADATA) is updated
A default query is created (MUNSYS_QUERY)

Roles are assigned to the table (MUNSYS_SDM_QUERY, MUNSYS_ALL_QUERY,
MUNSYS_SDM_EDIT, MUNSYS_ALL_EDIT, MUNSYS_POWER,
MUNSYS_ADMIN)

Indexes are created on the GID and Geometry columns of the new table

When a custom spatial table is created, the Munsys system table MUNSYS_SP_COLUMNS
is populated with the default columns for the new table and its corresponding geometry type.
Default Munsys system queries are also created at this time.

Warning A maximum of 1000 columns may be added to a single spatial table, inclusive of the default
columns per spatial object type. This is a restriction implemented by Oracle ®.
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To create a custom spatial table

1  Right-click on the Spatial Tables node of the Tables/View tree, and then select the Create New
Table... option on the context-sensitive menu or the Action menu.

The New Spatial Table dialog box is displayed.

New Spatial Table X

Create New Table

Spatial Table Name: SF'_||

Description: |

Geometry Type: W

Figure 3 The New Spatial Table dialog box

2 Enter a unique name used for the spatial table. This name is also used as the primary spatial layer in
Munsys Spatial Data Manager. The name specified is prefixed with SP_ when creating the table
in the database.

3  Enter a descriptive string that will identify which object the new spatial table represents. The
description should be unique in describing the contents of the table.

4  From the Geometry Type list, select the type of geometry data that will be stored in the table. The
available geometry types are Point, Label, Polygon and Line.

New Spatial Table X
Create New Table

Spatial Table Name:  SP_|RAILWAYS

Description: | Railway Lines
Geometry Type: Line »
Create Cancel Help

Figure 4 Creating a new spatial table

5  Click Create.

The spatial table is created in the database.
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To create a custom spatial table from an existing table

1  Right-click on the Spatial Tables node of the Tables/View tree or on an existing spatial table, and
then select the Create From Existing Table... option on the context-sensitive menu or the Action
menu.

The New Spatial Table dialog box is displayed.

MNew Spatial Table *

Create from Existing Table

Existing Table Name: SP_BUILDING v

Spatial Table Name:  SP_| |

Description: | |

Geometry Type: +

Figure 5 The New Spatial Table dialog box: create from existing

2 From the Existing Table Name list, select the spatial table on which you want to base the new table.

3  Enter a unique name used for the spatial table. This name is also used as the primary spatial layer in
Munsys Spatial Data Manager. The name specified is prefixed with SP_ when creating the table in
the database.

4  Enter a descriptive string that will identify which object the new spatial table represents. The
description should be unique in describing the contents of the table.

5 From the Geometry Type list, select the type of geometry data that will be stored in the table. The
available geometry types are Point, Label, Polygon and Line.

ew Spatial Table
Create from Existing Table

Existing Table Name: SP_BUILDING ~

Spatial Table Name: SP_  BLD_FOOTPRINT

Description: Building Footprint
Geometry Type: Polygon ™
Create Cancel Help

Figure 6 Creating a new spatial table

6  Click Create.

The spatial table is created in the database.
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Dropping a spatial table

Custom spatial tables (tables with MunID > 1000) can be dropped from the database. Munsys-
defined spatial tables cannot be dropped from the Munsys Management Console.

When a table is dropped from the database, all references to the table is deleted from:
The system query table (MUNSYS_ QUERY)
MUNSYS_SP_TABLES
USER_SDO_GEOM_METADATA
MUNSYS_SP_COLUMNS
To drop a spatial table, do the following:

1  Select the table that you want to drop, and then select the Drop Table... option on the Action menu
or the context-sensitive (right-click) menu.

The following confirmation message is displayed:

Drop Table

0 Are you sure you want to drop the "SP_BUILDINGS' table?

The table will be permanently deleted.

Figure 7 Drop Table confirmation message

2 Click Yes to drop the table from the database.
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Validating a spatial table

The Spatial Table Validation function validates the geometry of spatial tables. You need to have
the MUNSYS_ADMIN role assigned and be logged in as the schema owner to be able to
validate a spatial table.

To validate a spatial table, do the following:

1  Select the table that you want to validate, and then select the Validate Table... option on the Action
menu or the context-sensitive (right-click) menu.

The Validation Results dialog box is displayed. This dialog box consists of three tabs:

Summary — this tab lists the main category of the tests that were performed, and whether
the entire category failed or passed the validation test.

Validation Results X

Emors  Validation Log
Summary of validation:

Validation Test Result
v SP_BUILDING Oracle Spatial Validation Passed

Close Help

Figure 8 Validation Results: Summary tab
Errors — this tab contains a list of all the errors that were encountered during the validation.
The results are grouped under the validation category that was performed.

Validation Log — this tab contains a list of the tests that were performed, as well as a detailed
account of the outcome. The validation log can be saved as a text file by clicking the Save
Log button.
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Validation Results X

Summary Emors |
Validation log:
Validation log for table *SP_BUILDING' in schema ‘MCITY12INT

Rows Processed <1591>
No Emors

Save Log...

Figure 9 Validation Results: Log Tab
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Editing columns in a spatial table

Creating a spatial table requires a predefined set of columns to be included in the table. When
using the Munsys Management Console to create a spatial table, these columns are inserted into
the table automatically.

One of the columns that needs to be present in the table is the GID column. This column is
used as the geometry identifier for an object inserted into the table. It is a unique identifier
throughout the Munsys schema, and is used as primary index for the spatial table.

Other required columns are used to hold label or text attributes for the object, such as angle,
size and position of a town name.

The predefined columns cannot be deleted from a table. The database administrator can add
new columns to any spatial table and also delete such columns.

Adding a column to a spatial table

1  Select the spatial table to which you want to add a column, and then select the Edit Columns...
option on the Action menu or the context-sensitive (right-click) menu.

The Edit Spatial Table Columns dialog box is displayed.

Edit Spatial Table Columns - SP_BUILDING X
Table Columns

Column Name Data Type Width Precision Description Edtable Mandatory System

GID NUMBER 10 0 GID N N Y

BLD_TYPE VARCHARZ2 20 Building Type Y N Y

BLD_FLOORS NUMBER 4 0 Number of Floors Y N Y

GEOM_AREA NUMBER 22 0 Geometry Area N N Y

COMMENTS VARCHAR2 150 Comments Y N Y

TAG_X NUMBER 22 0 Tag X Coordinate N N Y

TAG_Y NUMBER 22 0 Tag Y Coordinate N N Y

TAG_VALUE VARCHAR2 40 Tag Value Y N Y

TAG_SIZE NUMBER 22 0 Tag Height N N Y

TAG_ANGLE NUMBER 22 0 Tag Angle N N Y

TAG_JUST CHAR 2 Tag Justification N N Y

GEOMETRY GEOMET... 0 Geometry Object N N Y

BLD_NAME VARCHAR2 250 Building Name Y N Y

BLD_NUM VARCHAR2 10 Building Number Y N Y Ad...
DATA_SOURCE  VARCHAR2 20 Data Source Y N Y Modiy..
DATA_QUALITY VARCHAR2 20 Data Quality Y N Y

< > Delete

Cancel Help

Figure 10 Edit Spatial Table Columns

2 Click the Add button.
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The Add Column dialog box is displayed.

Add Column X

Column Info

Table Name
SP_BUILDING

Column Irformation

Name: “

Data Type: V]

Data Width: 0
Data Precision: (

Display Information
Description:

Data Format: UseDefault v
Is Editable [ ] Is Mandatory

[ Is System Column

Cancel Help

Figure 11 The Add Column dialog box

3  Enter the following column information:

Name — the name of the column. This value cannot be changed.

Data Type — the data type of the column (CHAR, NUMBER, VARCHAR2, DATE or
GEOMETRY).

Data Width — the maximum width of the column.

Data Precision — the number of decimal digits that the column will display. This only
applies to Number data types.

4  Enter the following display information:

Description — enter a description for the new column, or change the description of an
existing column.

Data Format — select a data format from the list (Use Default, Angle, Date/Time,
Hyperlink, or Lookup Table).

Is Editable — specify whether the value may be edited in Munsys Applications.

Is Mandatory - specify whether an integrity check rule must be added to the
MUNSYS_INTEG_ATTR table. If checked, an entry is added and the default
RULE_TYPE is set to NOTNULL. By default this remains unchecked.

5  Click OK to add the column to the spatial table.
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Modifying a column in a spatial table

Note

1

Select the spatial table of which you want to edit a column, and then select the Edit Columns...

option on the Action menu or the context-sensitive (right-click) menu.

Only columns in custom (user-defined) spatial tables can be edited.
The Edit Spatial Table Columns dialog box is displayed.

Select the column that you want to edit, and then click the Modify button.

Edit Spatial Table Columns - SP_BUILDING
Table Columns
Column Mame Data Type Width  Precision Description Editable Ptﬂandator‘_.iI System
G ID N UMBER 10
--
BLD FLOORS NUMBER 0 Number of Floors Y N Y
GEOM_AREA NUMBER 22 0 Geometry Area N N Y
COMMENTS VARCHAR2 150 Comments Y N Y
TAG_X NUMBER 22 0 Tag X Coordinate N N Y
TAG_Y NUMBER 22 0 Tag Y Coordinate N N Y
TAG_VALUE VARCHAR2 40 Tag Value Y N Y
TAG_SIZE NUMBER 22 0 Tag Height N N Y
TAG_ANGLE NUMBER 22 0 Tag Angle N N Y
TAG_JUST CHAR 2 Tag Justification N N Y
GEOMETRY GEOMET... 0 Geometry Object N N Y
BLD_NAME VARCHAR2 250 Building Name Y N Y
BLD_NUM VARCHAR2 10 Building Number Y N Y Ad...
DATA_SOURCE  VARCHAR2 20 Data Source Y N Y Modfy..
DATA_QUALITY  VARCHAR2 20 Data Quality Y N Y
< > Delete
Commit Cancel Help

Figure 12 Edit Spatial Table Columns: Modify
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3
4

The Modify Column dialog box is displayed.

Maodify Column X

Column Info
Table Name
SP_BUILDING

Column Information
Name: [BLD_TYPE

Data Type: VARCHAR2

Data Wicth: [ 20|
Data Precision: DJ
Display Information
Description:
Data Format: UseDefault o
[+] Is Editable [ ] Is Mandatory

[ Is System Column

Figure 13 Modify Column

Edit the column as required, and then click OK.

Click the Commit button to commit the transaction to the database.
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Deleting a column from a spatial table

The administrator can only delete custom columns from the spatial tables. When selecting a
column to delete, the delete process checks to see if there are any integrity rules defined for the
deleted column in the MUNSYS_INTEG_ATTR table, and if so, removes the reference when
the deletion is committed.

Select the column to be deleted so that it is highlighted
1  Click the Delete button

The user is presented with the following Delete Column message

Delete Column

0 Are you sure you want to delete the 'BLD_TYPES' column?

The column will be permanently deleted.

Yes No

Figure 14  Delete Column message

2 Click the Yes button to continue with the deletion process, or click the No button to cancel the
command.

3 Click the Commit button to commit the transaction to the database.
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Working with attribute tables in the Munsys Management Console
Using the Attribute tables item in the Tables/Views tree, you can do the following:

Create or add custom attribute tables
Drop an attribute tables
Add, modify or delete columns in an attribute table

Modify table description

Create attribute tables

Attribute tables are created by selecting the Create New Table option on the Action menu, or
from the context-sensitive (right-click) menu that is displayed when you right-click on
Attribute tables in the Tables/View tree.

Bl Munsys Management Console (MCITY15INT) = O X
File  Action Help

tj--if_' Applications ID Description Table Name

D"'I@Ij Locks c . 1 Building Floor Info AT_BLDG_FLOOR_INFO
w28 Sue'*_' ategories 2 Building Room Info AT_BLDG_ROOM_INFO
&y decurity 141 CableRoute Ducts AT_CRTDUCT

[j--% Privilege R

: 161 Fiber Cable Info AT_FIBERCABLE

- BR Tables/Views
% Spatial Tables

% Lineage

- Scheduled Tasks

Figure 15  Munsys Management Console: Attribute Tables

When creating a new table, the system will automatically add the prefix [AT_] to the name
supplied. Both the table name AND the descriptions must be unique; when a new table is
created in the database, the system checks whether either the name or description already exists.
If this is the case, the table will not be created. A custom attribute table is always assigned a
MUN_ATID of >1000. When a new attribute table is created, the system

automatically adds an ID column
Populates MUNSYS_AT_TABLES Munsys system table
Populates MUNSYS_AT_COLUMNS Munsys system table

Create new KEY index on ID column.

Assigned roles MUNSYS_ADMIN, MUNSYS_ALL_EDIT, MUNSYS_ALL_QUERY,
MUNSYS_POWER, MUNSYS_SDM_EDIT, MUNSYS_SDM_QUERY

Note Oracle imposes a limit of a 1000 columns per table.
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To create a custom attribute table

1  Right-click on the Attribute tables node of the Tables/View tree, and then select the Create New
Table... option on the context-sensitive menu or the Action menu.

Bl Munsys Management Console (MCITY15INT) = a X

File Action  Help

-3 Applications D Description Table Name
U"'HA Locks _ 1 Building Floor Info AT_BLDG_FLOOR_INFO
-3 Query Categories 2 Building Room Info AT_BLDG_ROOM_INFO
E"""U security 141 Cable Route Ducts AT_CRIDUCT

]--% Privilege )
5 % Tables/Views 161 Fiber Cable Info AT_FIBERCABLE

T S

% Lookup Tables Create Mew Table...
R Indexes Add Existing Table...

LR T
R Triggers Collapse Al
% Lineage

-4 Scheduled Tasks

Expand All

Create new attribute table tooltip

Figure 16  Create Attribute Table

The New Acttribute Table dialog box is displayed.

New Attribute Table X
Create New Table

Adtribute Table Name: AT_ [ASSET |

Description: Asset Registry| |

Figure 17  New Attribute dialog box

2 Enter a unique name used for the attribute table. The name specified is prefixed with AT _when
creating the table in the database.

3  Enter a descriptive string that will identify which object the new attribute table represents. The
description should be unique in describing the contents of the table.

4  Click Create.

The attribute table is created in the database.
Note When creating a new attribute table in Munsys, the system will automatically add one column. This is the
ID column which is used as a primary index for the attribute table. It is also possible to make this column

unique throughout the Munsys schema by assigning the sequence MUNSEQ _ID to the ID field. (This is
not done automatically.)
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To add an attribute table from an existing table

Note

1

Right-click on the Attribute tables node of the Tables/View tree, and then select the Add Existing
Table... option on the context-sensitive menu or the Action menu.

A dialog box is displayed that lists all available non-system or spatial tables.

Add Existing Attribute Table

Add Existing Tables

Attribute Tables:

FIN_ACCT_NO
FIN_EREADINGS
FIN_WREADINGS
GEN_DWGCAT
TP_PARCEL_DATA
TP_PARCEL_OWNER

Cancel

Figure 18  Add Existing Attribute Table

Select the attribute table that you want to add to the Table Name List and Click Add.

The attribute table is added in the database.

When adding an Attribute Table it enables you to now administer the table i.e. add/modify/delete columns.
It also lists only the tables that you added so even if you have 100 attribute tables in the schema but only

10 are relevant then you can simply add those 10 tables.
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Dropping an attribute table

Tables that are listed under Attribute tables and have a MUN_ATID > 1000 are custom
attribute tables and they can be dropped from the database.

When a table is dropped, references to the table are also removed from the attribute table list,
all references to the table is deleted from:

MUNSYS_AT_TABLES
MUNSYS_AT_COLUMNS

To drop an attribute table, do the following:

1  Select the table that you want to drop, and then select the Drop Table... option on the Action menu
or the context-sensitive (right-click) menu.

The following confirmation message is displayed:

Drop Table

o Are you sure you want to drop the 'AT_ASSET table?

The table will be permanently deleted.

e ] 0w

Figure 19  Drop Attribute Table notification

2 Click Yes to drop the table from the database.
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Removing an attribute table

Tables that are listed under Attribute tables and have a MUN_ATID > 1000 are custom
attribute tables and they can be dropped from the database.

When a table is removed from the attribute table list, all references to the table is deleted from:
MUNSYS_AT TABLES
MUNSYS_AT COLUMNS

To remove an attribute table, do the following:

1  Select the table that you want to drop, and then select the Remove Table... option on the Action
menu or the context-sensitive (right-click) menu.

The following confirmation message is displayed:

Remove Table

0 Are you sure you want to remove the "AT_ASSET table?

The table will be removed from the list of attribute tables
only.

ST

Figure 20  Remove Attribute Table notification

2 Click Yes to remove the table from the attribute list.
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Editing columns in an attribute table

When creating a new attribute table in Munsys, the system will automatically add one
column.Any other columns that are needed will have to be added after the table is created.

When you have a configured Attributed table, you can also use the edit function to add or edit
columns to that table.

Adding a column to an attribute table

1  Select the attribute table to which you want to add a column, and then select the Edit Columns...
option on the Action menu or the context-sensitive (right-click) menu.

The Edit Attribute Table Columns dialog box is displayed:

Edit Attribute Table Columns - AT_ASSET X
Table Columns
Column Name Data Type Width  Precision Description Editable Mandatory System
ID NUMBER 10 0 ID N N Y
Add...
Modfy...
Delete
Cancel Help

Figure 21  Add a column to an Attribute table

2 Click the Add button.
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3

4

5

The Add Column dialog box is displayed:

Add Column X

Column Info

Table Name
AT_ASSET

Column Information

Name: l
Data Type: v

Data Width: 0

Data Precision:

Display Information
Description:

Data Format: UseDefault ~
Is Editable

[] Is System Column

Figure 22 Add Column Dialog box

Enter the following column information:

Name — the name of the column. This value cannot be changed.

Data type — the data type of the column (CHAR, NUMBER, VARCHAR?2, DATE or
GEOMETRY).

Data Width — the maximum width of the column.

Data Precision — the number of decimal digits that the column will display. This only applies
to Number data types.

Enter the following display information:

Description — enter a description for the new column, or change the description of an
existing column.

Data Format — select a data format from the list (Use Default, Angle, Date/Time,
Hyperlink, or Lookup Table).

Is Editable (This specifies whether the value may be edited in Munsys Applications and is
turned on by default.)

Is System Column — flagging a column as a System column prevents it from been

deleted/dropped.

Click OK to add the column to the attribute table
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Modifying a column in an attribute table

1

Select the attribute table within which you want to edit a column, and then select the Edit Columns...

option on the Action menu or the context-sensitive (right-click) menu.

The Edit Attribute Table Columns dialog box is displayed. Note that only user-defined attributes

within registered attribute tables can be edited.

Select the column that you want to edit, and then click the Modify button.

Edit Attribute Table Columns - AT_ASSET

Table Columns

Column Name Data Type Width  Precision Description Editable Mandatory System
NUMBER 10 0 ID N

ID N Y
[ASSET_NUMBER | NUMBER _| 20| 1] Asset Barcode Number [ Y | N ___[N ]

Figure 23 Modify Attribute Table Columns

The Modify Column dialog box is displayed:
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4
5

Modify Column

Column Info

Table Name
AT_ASSET

Column Information

Name: |ASSET_NUMBER

Data Type: NUMBER

DataWidth: | 20|
Data Precision: E

Display Information
Description:

Ass-et Barcode Number]

Data Format: UseDefault
[+ Is Editable

[] Is System Column

Figure 24  Modify Column

Edit the column as required, and then click OK.

Click the Commit button to commit the transaction to the database.
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Deleting a column from an attribute table

The administrator can only delete custom columns from the attribute tables. When selecting a
column to delete, the delete process checks to see if there are any integrity rules defined for the
deleted column in the MUNSYS_INTEG_ATTR table, and if so, removes the reference when
the deletion is committed.

1  Select the column to be deleted so that it is highlighted.
2 Click the Delete button

The user is presented with the following Delete Column message:

Delete Column

Are you sure you want to delete the "ASSET_NUMBER'
column?

The column will be permanently deleted.

e 770 mo

Figure 25  Delete column notification

3 Click the Yes button to continue with the deletion process or click the No button to cancel the
command.

4 Click the Commit button to commit the transaction to the database.
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Working with lookup tables in the Munsys Management Console

Note

Alookup table is designed in the same way as an attribute table, with the difference that lookup
tables are not used to capture data, but rather to look up data values. All possible values for a
single field, for example all the possible values for zonings, are grouped into one lookup table.
The user is presented with a list of values to choose from. This method of data capture enhances
data accuracy. The database administrator can add lookup values to lookup tables, or modify or
delete existing values.

The lookup tables have a unique primary key index assigned to the lookup code column enforcing the
LCODE value to be unique.
Using the Lookup Tables item in the Tables/Views tree, you can do the following:

Create new lookup tables

Create and edit links between lookup tables and spatial tables

Delete lookup links

Drop lookup tables

Create and edit lookup values in a lookup table

Creating a new lookup table

To create a new lookup table, do the following:

Select the New Lookup Table... option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select Lookup Tables on the Tables/Views tree.

Bl Munsys Management Console (MCITY15INT) = O X
File Action  Help

(30 Applications B} LU_CF5_CBLDIAMETER

-3 Locks By LU_CFS_CBLGROUP

(-3 Query Categories B LU_CFS_CBLTYPE

By Security 5B LU_CFS_FIBOWNER

- Privilege - LU_CFS_FIBSYM

- B Tables/Views B} LU_CFS_FIBTENANCY

Eg Spatial Tables B} LU_CFS_MUXTYPE
B2, Attribute Tables B} LU_CF5_SERVSUBCAT
) B} LU_CFS_SERVTYPE
B Indexes -} LU_CMS_BLDTYPE
% Triggers []--Eu'. LU_CMS_DEMNSITY
I Lineage -} LU_CMS_EASETYPE
B
B

£33 Scheduled Tasks 0B} LU_CMS_LANDUSE
0By LU_CMS_LSTATUS

Figure 26 Munsys Management Console: Lookup Tables

The Create Lookup Table dialog box is displayed:
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3

Table Info
Table Name
Table Mame:  LU_

Lookup Code
Data Type: VARCHARZ ~

Data Width: 10 =

-
-

Lookup Value
Data Type: VARCHAR2

Data Width: 20 =

Cancel Help

Figure 27 The Create Lookup Table dialog box

Enter the following information:

Table Name — enter a descriptive name for the lookup table. The table is automatically
prefixed with LU_.

Lookup Code: Data Type — enter the appropriate data type for the lookup table: CHAR,
VARCHAR?2 or NUMBER. If you select NUMBER, the data precision field becomes
available. The default data type is VARCHAR?2.

Lookup Code: Data Width — enter the width for the column. The default data width is 10
and the maximum data width is 20.

Lookup Code: Data Precision — enter the number of decimal digits that the column will
display. This field is only available when you selected NUMBER as the data type.

Lookup Value: Data Type — the data type for the lookup value is set to VARCHAR?2 by
default. This value cannot be changed.

Lookup Value: Data Width — enter the maximum width for the column. The default data
width is 20 and the maximum data width is 200

Click the Create button to create the new lookup table.
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Creating links between lookup tables and spatial tables
To create a link between a lookup table and a spatial table, do the following;

1  Select the Lookup Links... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Links dialog box is displayed:

Lookup Links X

LU_CMS_BLDTYPE

Table Link Column Lookup Link Column
SP_BUILDING  BLD_TYPE LCODE

Modify...
| <€ > Delete
Close Help
Figure 28  The Lookup Links dialog box
2 Click the Add... button.
The Lookup Link dialog box is displayed.
Lookup Link X

Table: v
Link Column: v
Lookup Link Column: |LCODE v

Cancel Help

Figure 29 The Lookup Link dialog box

Select the required spatial table from the list.
Select the required spatial link column from the list.

Select the required lookup link column as required.

A N R W

If the Data Type for the link column in the spatial table does not match the data type of the lookup
link column, a DataType Mismatch warning message is displayed.
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Note

10

Table link column and lookup link column datatypes do not
- match!

oK

Figure 30 Data Type Mismatch warning message

It is recommended that the Lookup table’s LCODE data type and data width match the spatial table’s link
column data type and data width.

Click OK to acknowledge the warning and return to the Lookup Link dialog box.

Click OK to create the lookup link or Cancel to end the command so that the administrator can
correct the mismatched data type.

Select the Commit button to commit the Lookup Links definition to the database.

Select Close to return to the Munsys Management Console dialog.
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Editing links between lookup tables and spatial tables
To edit a link between a lookup table and a spatial table, do the following:

1  Select the Lookup Links... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Links dialog box is displayed:

Lookup Links X

LU_CMS_BLDTYPE

Table Link Column Lookup Link Column

SP_BUILDING | BLD_TYPE LCODE

Close Help

Figure 31  The Lookup Links dialog box

2 Select the lookup link that you want to edit, and then click the Modify... button.
The Lookup Link dialog box is displayed.

Lookup Link X

Table: SP_BUILDING v
Link Column: BLD_TYPE v
Lookup Link Column: | LCODE v

Figure 32 The Lookup Link dialog box

3  Change the spatial table if required.
4 Change the spatial link column and the lookup link column as required.
5 Click OK to apply the changes to the lookup link.
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Deleting a link between a lookup table and a spatial table

Tip

To delete a link between a lookup table and a spatial table, do the following:

Select the Lookup Links... option on the Action menu or the context-sensitive (right-click) menu

that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.
The Lookup Links dialog box is displayed:

Lookup Links

LU_CMS_BLDTYPE

Table

Link Column

Lookup Link Column

SP_BUILDING | BLD_TYPE LCODE

Close

Modfy...

Delete

Figure 33 The Lookup Links dialog box

Select the lookup link that you want to delete, and then click the Delete... button.

The lookup link is deleted.

Click Commit to save the changes to the database.

You can also remove a link by selecting the appropriate link in the content pane, and then selecting the
Remove Link option on the Context-sensitive menu.

The following dialog is displayed:

Remove Link

Yes

Are you sure you want to remove lookup link 'SP_BUILDING'
on column ‘BLD_TYPE' from table 'LU_CMS_BLDTYPE'?

Figure 34 Remove Link notification
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Dropping a lookup table from the database
To drop a lookup table from the database, do the following:

1  Select the Drop Lookup Table... option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

A confirmation message is displayed:

Drop Lookup Table

o Are you sure you want to drop the table "LU_CMS_BLDTYPE'?

The lookup table will be permanently deleted.

Yes . No

Figure 35  Drop Lookup Table notification

2 Click Yes to drop the lookup table from the database.
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Creating a lookup value in a lookup table

To create a new lookup value for a lookup table, do the following:

1  Select the Lookup Values... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Values dialog box is displayed.

Lookup Values X

LU_CMS_BLDTYPE

Table Values:

Lookup Code Lookup Value

RESIDENTIAL Residential

OFFICE Office

MEDICAL Medical

FACTORY Factory

HOTEL Hotel

GENERAL  Geners

Modify...

Delete

Close

Figure 36 The Lookup Values dialog box

2 Click the Add... button.
The New Lookup Value dialog box is displayed.

New Lookup Value X

LCODE:

LVALUE:

T R

Figure 37 The New Lookup Value dialog box

Enter a new lookup code (LCODE).
Enter a new lookup value (LVALUE).
Click OK to add the lookup value to the table.

A N xR W

Click Commit on the Lookup Values dialog box to save the changes to the database.
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Modifying a lookup value in a lookup table

1

2

3
4

Select the Lookup Values... option on the Action menu or the context-sensitive (right-click) menu

that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Values dialog box is displayed:

Select the value that you want to change, and then click the Modify... button.

Lookup Values

LU_CMS_BLDTYPE

Table Values:

Lookup Code  Lookup Value

OFFICE Office
MEDICAL Medical
FACTORY Factory
HOTEL Hotel
GENERAL General

RESIDENTIAL

Add...

Modify...
Delete

Figure 38  The Lookup Values dialog box

The Modify Lookup Value dialog box is displayed.

Modify Lookup Value X

LCODE:

|RESIDENTIAL

LVALUE:
| Residential

T R

Figure 39 The Modify Lookup Value dialog box

Change the lookup value as required, and then click OK.

Click Commit on the Lookup Values dialog box to save the changes to the database.
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Deleting a lookup value from a lookup table

1  Select the Values... option on the Action menu or the context-sensitive (right-click) menu that is
displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Values dialog box is displayed:
2 Select the value that you want to delete, and then click the Delete... button.

Lookup Values X

LU_CMS_BLDTYPE

Table Values:

Lookup Code  Lookup Value

RESIDENTIAL

OFFICE Office

MEDICAL Medical

FACTORY Factory

HOTEL Hotel

GENERAL General _—

Delete

Figure 40  The Lookup Values dialog box

The lookup value is deleted from the lookup table.

3  Click Commit on the Lookup Values dialog box to save the changes to the database.
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Editing lookup columns

1

Select the Edit Columns... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

ﬁ Munsys Management Console (MCITY13INT)

File Action  Help
@-{3 Applications By LU_CFS_MUXTYPE
73 Locks B} LU_CFS_SERVSUBCAT
35 Query Categories % LU_CFS_SERVTYPE
a}) Security ]--%
B2 Privilege 0B LU_CMS_DENSI Lookup Links...
B Tables/Views B4 LU_CMS_EASET| 3¢ Drop Lookup Table

B Spatial Tables
% Attribute Tables
% Lookup Tables
% Indexes

% Triggers

% Lineage

Scheduled Tasks

Edit Columns tooltip

Figure 41

o-Bfl LU_CMS_LAND
o LU_CMS_LSTAT|

Lookup Values...

Edit Columns...

0Bl LU_CMS_STRNA
0B LU_CMS_SUBN
o-E LU_CMS_TOWI

Collapse All
Expand All

0B LU_CMS_WSTATUS

B
B
B
B
B
- LU_CMS_pRCLT|
B
B
B
B
-y LU_CMS_ZONING

Edit Lookup Columns

The Edit Lookup dialog box is displayed:

Edit Lookup Table X
Table Info

Table Name
Table Name: LU_ CMS_BLDTYPE

Lookup Code
Data Type: VARCHAR2 v
Data Width: 20 =

Lookup Value
Data Type: VARCHAR2
Data Width: 40 =

Commit Cancel Help
Figure 42 Edit Lookup Table

2 Set the Lookup Code column to either CHAR, VARCHAR or NUMBER. Each option displays
parameters associated with that data type. Set each of the parameters as required.

Only the width of the Lookup Value can be changed. Set this value as required
4 Ifyoutried to change the data type of any lookup table that contains values, and error will occur to

prevent data loss.
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e Unable to alter Lookup Table 'LU_CMS_BLDTYPE".

ORA-01441: cannot decrease column length because some
value is too big

Database Error X

Figure 43 Data loss notification

Click Commit to update the changes in the database
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Working with indexes on spatial tables and lookup tables

In the Munsys Management Console, you can create custom indexes, as well as recreate and

drop indexes on Munsys spatial, attribute and lookup tables using Indexes on the Tables/Views
tree.

Bl Munsys Management Console (MCITY15INT) = O X
File  Action Help

-3 Applications % Spatial Tables
I@I Locks % Lookup Tables
=3 Query Categories % Attribute Tables
E_:TJ Security

% Privilege

B% Tables/Views

% Spatial Tables
% Attribute Tables

B} Lookup Tables

o) Scheduled Tasks

Figure 44  Munsys Management Console: Indexes

Indexing is separated into two different sections:
Spatial Tables — All tables starting with the prefix SP_.
Lookup Tables — All tables starting with prefix LU_.

Attribute Tables — All tables that are being managed by the Munsys Attribute Management
tools.

A custom index for a spatial, attribute or lookup table is created using the Create Custom Index
dialog box. This dialog box is accesses by selecting the appropriate spatial, attribute or lookup
table, and then selecting the Create Custom Index option on the Action menu or context-
sensitive (right-click) menu.

Each spatial or lookup table lists the columns on which indexes have been created. A spatial or
attribute table can have multiple indexes.
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Creating a custom index for a spatial or lookup table

The Create Custom Index dialog box is used to create custom indexes for columns in a selected
spatial table. The GID and GEOMETRY columns have preset index names and custom indexes

cannot be created on these two columns.
To create a custom index for a spatial or lookup table, do the following:

1  Select the Create Custom Index... option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select the appropriate table on the Tables/Views tree.

Bl Munsys Management Console (MCITY15INT) = a X
File  Action Help
E Applications 9--% Spatial Tables
08 Locks -5 SP_BLD_FOOTPRINT
=3 Query Categories - w
ETJ Security EJ"% SP_BUILD | Create Custom Index...
% Privilege - SP_CMSN Create Geometry Index
B% Tables/Views EJ--% SP_CONT] Create GID Index
& Spatial Tables - SP_CRTDI -
B Attribute Tables -5 SP_CRTIN Rebuild All Indexes
B} Lookup Tables - SP_CRTLA Collapse Al
) In.daces -5 SP_CRITLI Expand Al
% Triggers []--% SP_CRTM
A Lineage -5 SP_CRTNOTE
13 Scheduled Tasks []--% SP_CRTSYM
- SP_CTXTSM

Create Custom Index tooltip

The Create Custom Index dialog box is displayed:

Create Custom Index X

SP_BLOCK

Index Name: ||

Column: v

Cancel Help

Figure 45  The Create Custom Index dialog box

2 Enter a descriptive name for the custom index that you are creating.

3  From the Column list, select the column that you want to create the index for (the list only displays
currently non-indexed columns).

4  Click Create to create the new custom index.
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Rebuilding all indexes on a spatial or lookup table

To rebuild an index on a table, do the following:

1  Select the Rebuild All Indexes option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select the appropriate table on the Tables/Views tree.

The following message is displayed:

Rebuild Indexes

Are you sure you want to rebuild all the indexes for table
'SP_BLOCK'?

All the indexes on table "SP_BLOCK' will be rebuilt one by one.
This operation may take several minutes,

Yes | No

Figure 46 Rebuild indexes notification

2 Click Yes to rebuild the indexes.

The indexes are rebuilt.
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Chapter 11

Munsys Lineage

Introduction

Munsys Lineage is primarily used as a data management tool to track and archive changes
made to records in spatial tables. This is achieved through the implementation of database
triggers which populate Munsys system tables based on the preferences selected when
Lineage is added to a spatial table. Reports can also be generated to query the database for
MONItor or usage purposes.

This chapter is divided into the following sections for easy reference:
The Lineage Tree: overview
Working with Munsys Lineage
Enabling or disabling Lineage
Adding Lineage
Disabling triggers
Enabling triggers
Editing Lineage
Removing Lineage
Recompiling triggers
Rebuilding triggers
Deleting monitor logs
Running reports
Adding reports
Editing reports

Deleting reports
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Working with Lineage
Lineage must be enabled before you can start adding Monitor and Archive triggers to selected
tables. If you select Lineage on the Tree and get the Lineage Not Enabled message, you will be
required to enable before you can contine.

Munsys Lineage is currently disabled. Please enable this
setting in "Schema Properties'.

oK

Figure 1 Lineage is Disabled message
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Enabling or disabling Lineage

Lineage can be enabled or disabled from within the Schema Properties dialog box. The Lineage
tree branch only becomes active and functional once it has been enabled for a schema.
Alternatively, when Lineage is not enabled, all Lineage functionality is disabled and cannot be
modified in the Lineage tree branch of the Munsys Management Console.

To enable / disable Lineage and for more information, please refer to the chapter on Schema
management: The Lineage Tab.

1  Choose File > Schema Properties...

Bl Munsys Management Console (MCITY1SINT) = O X

File | Action Help

Mew Schema...

Drop Schema..
Export Schema...

Validate Schema...
Schema Data Models...

Schema Properties...

Import Demo Data...

A Edit/View the properties of the Munsys schema |
Disconnece

Change Password...

Exit

Edit/View the properties of the Munsys schema

Figure 2 Open Schema Properties

2 The Schema Properties dialog box is displayed. This dialog box consists of four tabs: General,
Schema, Lineage and Scheduled Tasks.

Select the Lineage tab and tick the check-box to Enable Lineage.

4 Select the Editing Behavior of Lineage.

Munsys Lineage
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The Lineage tree: overview
The Lineage tree consists of the Spatial Tables and Reports branch.

ﬁ Munsys Management Console (MCITY15INT, — [m]
File Action  Help
u_EI Roles % Spatial Tables
=-EEL Privilege [ Reports
BB Table/Views
...5=| Roles

-y Tables/Views

% Spatial Tables
% Attribute Tables
B} Lockup Tables

% Indexes

[_]% Lineage

% Spatial Tables
Reports
-y Scheduled Tasks

Figure 3 Munsys Management Console: Lineage Tree

Clicking on Spatial Tables in the Lineage tree displays existing spatial tables (if any) to
which triggers have being implemented to track Lineage. Refer to the specific sections in
this chapter for more details on the available functions on the Spatial Tables branch.

ﬁ Munsys Management Console (MCITY15INT, — ]

File Action  Help

]--E Applications
i@ Locks

{35 Query Categories
]---EU Security

]% Privilege

- BB Tables/Views
—]--% Lineage

: % Spatial Tables
Reports

-9 Scheduled Tasks

ooy A O O O oy O

m

=-Bg SP_WATLABEL
- B SP_WATNODE
-Bgp SP_WATNOTE
5.6 SP_WATPIPE
' MARC_SP_WATPIPE )
9] MMA_SP_WATPIPE} Triggers
' MMS_SP_WATPIPE
- SP_WATSYM

Spatial Tables towhich
Triggers have been added

Figure 4 Lineage Tree: Spatial Tables branch

Clicking on Reports in the Lineage tree displays the reports that can be run. Reports are
created and maintained in this window. Refer to the specific sections in this chapter for
more details on the available functions on the Reports branch.
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File Action  Help

]--E Applications
7@ Locks

{33 Query Categories
]---EU Security

]% Privilege

- Tables/Views
[—]% Lineage

% Spatial Tables
Reports

49 Scheduled Tasks

[
[
[
[
[
[

Figure 5

L R O

Fu — — 4 a4 gy
=T R R T R T N

Type
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Monitor
Usage
Usage
Usage
Usage
Usage

Description

Total Mumber of Records
Records for the past 24 Ho...
Records for the past Week
Records for the past Month
Grouped by Operation
Grouped by User Name
Grouped by Month
Grouped by Table Name
Grouped by Month and Q...
Grouped by Month and Us...
Grouped by Month and Ta...
Grouped by Month, Table ...
Grouped by Month, Table ...
Grouped by Table Name, ...
Grouped by Table Name, ...
Murnber of unique users p...
MNumber of applications us...
Applications used per user...

Shared users (users with sa...

Logged on users for the pa..

Munsys Management Console: Reports

SaL

select round(count(*),0) "Records" from munsys_mo..,
select gid "GID", table_name "Table Name", decodef...
select gid "GID", table_name "Table Name", decodef...
select gid "GID", table_name "Table Name", decode(...
select round(count(*),0) "Records", decode(operatio...
select round{count(*),0) "Records", user_name "User ..
select round(count(*),0) "Records”, fmt_date "Date 5t..
select round({count(*),0) "Records", table_name "Tabl...
select round({count(*),0) "Records", fmt_date "Date St..
select round{count(*),0) "Records", fmt_date "Date 5t..
select round(count(*),0) "Records”, fmt_date "Date 5t..
select round({count(*),0) "Records", fmt_date "Date St..
select round({count(*),0) "Records", fmt_date "Date St..
select round{count(*),0) "Records", table_name "Tabl...
select round(count(*),0) "Records”, table_name "Tabl..,
select count({c.users) "Unique Users”, to_char(to_date..
select count(c.app) "Unique Applications", to_char(t..,
select distinct(b.module_name) "Application Name",..
select b.user_name "User Name", substr{b.machine_...

select user_name "User Name", substr(machine_nam..

Munsys Lineage
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Working with Munsys Lineage

Note

Munsys Lineage can be used to:
Monitor changes to records made in a specified table.
Archive deleted or updated records into an archive table.

Report according to specific monitor and usage requirements.

Monitor
Munsys Lineage can be used to log and monitor the following information about operations
done on a table:

the type of operation

the date and time of the operation

the table on which the operation was done
the user who executed the operation

Logging is done during insert, update, and delete operations on a specified table in the Oracle
schema. Updates are classified based on the columns updated, and as Spatial or Attribute, for
example if the geometry of an object has been changed, it can be classified as a spatial update.

Logging information is stored in the MUNSYS_MONITOR_LOG and is maintained by the
administrator to prevent logs from growing too big.

Lineage date is important, especially if you want to be able to supply incremental updates to
other customers, for example if the county wants to supply changes to the municipality based
on a specific date.

The Show Info function in Munsys Applications shows the history of the object on the Linked Tables
tab. This is done by inserting a record into the MUNSYS_LNK TABLES table.

Archive

Munsys Lineage can be used to archive deleted or updated records into an archive table
associated with a specified spatial table. This requires the creation of an archive table
(SP_AD_tablename) and an associated archive trigger for a selected spatial table in the database.
The archive trigger is implemented in such a way that all the columns in a specified spatial table
are archived. When Lineage is added to a spatial table, the structure of that spatial table is
duplicated to create an archive table. The archive table is populated with records that meet
archive requirements as specified when Lineage is added or edited. Three extra columns are
added to the archive table to keep track of the following information:

the type of operation performed which resulted in the record being archived: An operation
type column (ARCHIVE_OPERATION) is added to the archive table, which can be
populated with the operation types DEL (delete) and UPD (update).

the date and time of the archive: A date stamp column (ARCHIVE_DATE) is added to the
archive table, which is populated with the date and time that the archive operation
occurred.

the archived ID: A unique ID column (ARCHIVE_ID) of the archived record is added.

Munsys Lineage
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The archive table is also inserted into the Munsys system tables, enabling users to query deleted
records from an archive table using Munsys Applications.

The database administrator maintains the records in the archive tables to prevent the tables
from growing too big. Records are deleted from the archive table based on the time stamp of
the deleted record.

Reports

Reports can also be generated from spatial tables to which Lineage is applied. Administrator can
generate monitor and usage reports to provide basic or detailed reporting based on predefined
or customised requirements.

Munsys Lineage also reports on user logon/logoff and license usage, based on the entries in the

MUNSYS_USAGE_LOG table.

Munsys Lineage
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Adding Lineage
Adding Lineage to a spatial table will create the necessary tables and triggers in the database to

monitor and archive operations for the selected spatial table. The administrator will also be able
to customise how and when Lineage should monitor and archive records.

Three types of triggers are created when Lineage is added to a spatial table, two for logging
purposes and one for archiving. These triggers populate Munsys system tables based on the
preference selected when Lineage is added or edited.

MMA_tablename (for example MMA_SP_PARCEL) — this trigger name contains the
prefix MMA_(Munsys Monitor Attribute columns) to indicate that the primary function
is to log attribute updates. This trigger populates the MUNSYS_MONITOR_LOG table
with the following operations:

INS — Insert operations
UPD — Update operations, based on the columns selected during the implementation
DEL — Delete operations

MMS_tablename (for example MMS_SP_PARCEL)- this trigger name contains the prefix
MMS_(Munsys Monitor Spatial update) to indicate that the primary function is to log
spatial updates that occurred in the GEOMETRY column. This trigger populates the
MUNSYS_MONITOR_LOG table with spatial updates only. This trigger is only created
if the user selects the option to log spatial updates explicitly when the Lineage is added or
edited. In this case, the SPA (spatial update) operation will be used in the case of a spatial
update.

MARC_tablename (for example MARC_tablename) — this trigger name contains the prefix
MARC_(Munsys Archive columns) to indicate that the primary function is to archive
records. The MARC trigger populates the archive table associated with a spatial table (for
example SP_AD_WATERPIPE) with the archived records. The MARC_tablename trigger
populates the SP_AD_tablename with the operations update or delete (as preferenced when
Lineage is added or edited).

Munsys Lineage
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To add Lineage to a spatial table

5  Select the Spatial Tables branch in the Lineage tree to view spatial tables with triggers already
implemented.

ﬁ Munsys Management Console (MCITY13INT) — a *

File  Action Help

@-{3P Applications - EEp SP_WATLABEL
-3 Locks B sp_waTNODE Spatial Tables to which
-3 Query Categories B SP_WATNOTE Triggers have been added
-y Security B sP_WATPIPE
B Privilege - B SP_WATSYM
- Tables/Views
[—j% Lineage
! % Spatial Tables
- Reports
e} Scheduled Tasks

Figure 6 Lineage tree: Spatial Tables

6  To add lineage to a spatial table, select the Add Lineage... option that is displayed when you right
click the Spatial Tables branch of the Lineage tree.

Bl Munsys Management Console (MCITY15INT) = O X

File  Action Help

-8 Applications -5 SP_WATLABEL
Locks - B SP_WATNODE
-3 Query Categories —- B SP_WATNOTE

0 MARC_SP_WATNOTE
S0 MMA_SP_WATNOTE
Q) MMS_SP_WATNOTE

] :.i.i Security
] ﬂ Privilege

% Tables/Views

% Lineage

 Spatial Table
Reports m..—l

- B SP_WATPIPE
SP_WATSYM

Ll Scheduled Tasks

Delete Logs...

Collapse All
Expand All

I

Creates a new lineage on spatial table.

Figure 7 Add Lineage selection

The Add Lineage dialog will appear:
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Add Lineage e

Lineage Details

Table Name: | SP_WATNODE o
Monitor
Log Insert, Update and Delete Operations
Log Spatial Updates Explicitly

Archive
Archive on Update Operations Log Attribute Changes
Archive on Delete Operations

Columns
@ All Columns

O Specfic Columns

o ||t

Figure 8 The Add Lineage dialog box

7  Inthe Table Name drop down of the Add Lineage dialog box, select a table for which Lineage will
be applied. The table selection does not include tables to which Lineage is already applied.

8 Inthe Monitor area, select one or more of the following check boxes (all operations are selected by
default):

Log Insert, Delete and Update Operations — This option logs insert, update and delete
operations. Selecting this option creates the MMA_tablename trigger in the database.

Log Spatial Updates Explicitly — Log Spatial Updates this option logs updates on the
GEOMETRY column as an additional operation. The MMS_ tablename trigger is created,
firing only on the GEOMETRY column when an update occurs. The trigger logs an
operation of SPA (spatial update) in the monitor log.

9 In the Archive area, select one or more of the following check boxes (all operations are selected by
default):

Archive on Update Operations — this option archives records that have been updated. The
MARC_tablename trigger will populate the SP_AD_tablename for update operations. The
trigger logs an operation of UPD in the monitor log.

Archive on Delete Operations — this option archives records that have been deleted. The
MARC_tablename trigger will populate the SP_AD_ tablename for delete operations. The

trigger logs an operation of DEL in the monitor log.
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Note

10 Specify the Columns that will be monitored and archived in the Lineage.

All Columns — when this option is selected, all columns will be used, which means that the
trigger is not dependent on the structure of the table. The trigger will also fire on the
GEOMETRY column (for spatial updates). The All Columns option is the default option.

Specific Columns — when this option is selected, the Available Columns and Monitored
Columns lists, as well as their associated options, become available. The arrow options are

used to add or remove columns from the two lists. The columns on which the trigger should

fire are moved from the Available Columns list to the Monitored Columns list, as seen in

the example below. Note that, the GEOMETRY column is not listed as an available column

but the MARC_tablename trigger will automatically fire on this column when a spatial
update is made.

If a new column is added to a spatial table that has Lineage applied, that column will not automatically be
added to the Monitored Columns list. It will have to be manually shifted to from Available Columns list to
the Monitored Columns in the Edit Lineage dialog box. The new column will then be added to the specified

database trigger(s). The column will also automatically be added to the associated archive table.

11 Click OK.

The spatial table will be added to the Spatial Tables branch of the Lineage tree. The necessary
triggers will also be created in the database to log and archive operations for the selected spatial
table. Triggers will be customised to track Lineage only for selected operations and columns as

defined in the Add Lineage dialog box upon implementation.

b

File  Action Help

(3 Applications
+I'E‘I Locks

+I§ Query Categories
+:|JJ Security

+% Privilege

- B Tables/Views
_% Lineage

% Spatial Tables
-[§ Reports

oy Scheduled Tasks

- B SP_WATLABEL
=B SP_WATNODE
4B SP_WATNOTE
=B SP_WATPIPE

() MARC_SP_WATPIPE ]
) MMA_SP_WATPIPE Triggersonthe

Q) MM SP WATPPE SP_WATPIPE table
- B SP_WATSYM

Figure 9 Spatial tables and triggers
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Disabling triggers

The current operation status of a trigger is identified by the following prefix symbols:

=B SP_tablename

) —— Light bulb on (yellow): Enabled trigger

) —— Light bulb off (blue): Disabled trigger

¥ — Light bulb off with redline strike: Invalid trigger

Figure 10 Trigger status symbols

Disabling all triggers on a spatial table

To disable all triggers on a spatial table, select the Disable All Triggers option on the context-

sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

ﬁ Munsys Management Console (MCITY15INT)

File  Action Help

& E Applications

@ B Locks

o =5 Query Categories
i Ey Security
£ % Privilege
- Tables/Views
E Lineage
B Spatial Tables
| Reports
) Scheduled Tasks

Disable all triggers active on spatial table

|[ =B sp_wamLABEL

B SP_WATNODE
- B SP_WATNOTE

- 7 AT

Q MARC

Disable All Triggers

Q MMa]
Q MmMs)
- B SP_WATS]

Enable All Triggers
Edit Lineage...

Remove Lineage...

Collapse All
Expand All

Figure 11 Disable All Triggers

All triggers for the selected spatial table will be disabled.
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Disabling a selected trigger

1

Figure 12

The selected trigger will be disabled.

H Munsys Management Console (MCITY15INT)

File  Action Help

To disable only a selected trigger on a spatial table, right click the trigger and select Disable Trigger
on the context-sensitive (right-click) menu.

-(F Applications
-8 Locks

[#-25 Query Categories
[j---ED Security

w-FE} Privilege

-y Tables/Views
[—j% Lineage

% Spatial Tables
Reports

,d"?, Scheduled Tasks

Disable selected trigger

- Eg SP_WATLABEL
B, SP_WATNODE

=B SP_WATPIPE

. MARC_SP_WATPIPE

SOR MMA_SP_WATPIP

D MMS_SP_WATPIPE

Disable Trigger

g, SP_WATSYM

Rebuild Trigger
Recompile Trigger

Collapse All
Expand All

Disable selected trigger

Munsys Lineage
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Enabling triggers

The current operation status of a trigger is identified by the following prefix symbols:

=B SP_tablename

) —— Light bulb on (yellow): Enabled trigger

) —— Light bulb off (blue): Disabled trigger

¥ — Light bulb off with redline strike: Invalid trigger

Figure 13 Trigger status symbols

Enabling all triggers on a spatial table

To enable ALL triggers on a spatial table, select the Enable All Triggers option on the context-

sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

ﬁ Munsys Management Console (MCITY15INT)

File Action  Help

{30 Applications
-8 Locks

[]...xg Query Categories
Fil-40 Security

[].-% Privilege

[].-% Tables/Views
-1 Lineage

% Spatial Tables
i Reports

49 Scheduled Tasks

Enable all triggers active on spatial table

=B SP_WATLABEL
- SP_WATNODE
- SP_WATNOTE

- % BN

- MARC_SP

Disable All Triggers

. MMa_SP |

Enable All Triggers

- SP_WATSYM

Edit Lineage...
Remove Lineage...

Collapse All
Expand All

Figure 14  Enable All Triggers

All triggers for the selected spatial table will be enabled.
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Enabling a selected trigger

1

To enable only a selected trigger on a spatial table, select the Enable Trigger option on the context-

sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

The selected trigger will be enabled:

ﬁ Munsys Management Console (MCITY13INT)

File Action  Help

[]--E Applications
(-3 Locks

[#-35 Query Categories
U"'ETJ Security

[]--% Privilege

[

- Tables/Views

Enable selected trigger

=B SP_WATLABEL

- B SP_WATNODE

B SP_WATNOTE

5.5 SP_WATPIPE

. MARC_SP_WATPIPE

MY R MMA_SP WATPIPE

- MIMS_SP_WATPIPE]

Enable Trigger

- SP_WATSYM

Rebuild Trigger
Recompile Trigger

Collapse All
Expand All

Figure 15  Enable selected trigger
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Editing Lineage

1  Toedit the Lineage of a spatial table, select the Edit Lineage... option on the context-sensitive (right-
click) menu that is displayed when you right click on a spatial table in the Spatial Tables branch of
the Lineage tree.

Bl Munsys Management Consale (MCITY15INT) = [m] *

File  Action Help

@-{0 Applications B SP_WATLABEL
-3 Locks ERy SP_WATNODE
[#-%5 Query Categories % SP_WATNOTE
-4 Security [ER:sY P WATPIPE, 5 5
E]--% Privilege f ) MARC_S Disable All Triggers
E]--% Tables/Views o MMA_SH Enable All Triggers
- Lineage 0 Mms_sh Edit Lineage...

- Spatial Tables By SP_WATSYM Remove Lineage...

Reports
i) Scheduled Tasks Collapse All
Expand All
Edit lineage table settings and triggers
Figure 16  Edit Lineage selection
The Edit Lineage dialog box will appear:
Lineage Details
Teble Name:  SP_WATPIPE

Meonitor

@ Log Insert, Update and Delete Operations

@ Log Spatial Updates Explicitly

Archive

@ Archive on Update Operations B Log Attribute Changes

P 9 9

B Archive on Delete Operations

Columns

© Al Columns

() Specific Columns

MENTS
QUALITY

RCE

GEOMETRY
o GID
PIPE_DIA
PIPE_
PIPE_MATRL
2 PIPE_TYPE

Figure 17  Edit Lineage dialog box
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2  Lineage preferences can be edited for the selected spatial table by selecting the Monitor and
Archive check boxes and specifying the Columns to which Lineage will apply.

3  Click OK to apply any changes.
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Removing Lineage

1

To remove the Lineage of a spatial table, select the Remove Lineage... option on the context-

sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

ﬁ Munsys Management Console (MCITY15INT)

File Action

Help

-8 Locks

Wy Security

IE3] E Privilege

o] % Lineage
) Spatial

43 Scheduled

{38 Applications

-33 Query Categories

Y Tables/Views

Tables

Reports

Tasks

- B SP_WATLABEL
- B SP_WATNODE
- SP_WATNOTE

Y

- SP_WATS

Disable All Triggers
Enable All Triggers
Edit Lineage...

Remove Lineage...

Collapse All
Expand All

Remove lineage functionality from spatial table

Figure 18

The Remove Lineage Confirmation dialog box will appear.

Remove Lineage

Remoave Lineage Confirmation

Removal Details

["] Remove Monitor Logs
[C] Drop Archive Table

Remove Cancel Help

Figure 19  Remove Lineage Confirmation dialog box

Select the check boxes to also remove the monitor logs and associated archive table for the selected

spatial table.

Click Remove.
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Recompiling triggers

1

To recompile a trigger, select the Recompile Trigger option on the context-sensitive (right-click)
menu that is displayed when you right click on a trigger that belongs to spatial table in the Spatial

Tables branch of the Lineage tree.

This option will recompile the currently selected trigger. This is useful if the structure of the related

table has changed and the trigger needs to be recompiled.

H Munsys Management Console (MCITY15INT)

File  Action Help

7-(30 Applications
{3 Locks

1-25 Query Categories
-4 Security

o B Privilege

- B Tables/Views
- Lineage

% Spatial Tables
B Reports

il Scheduled Tasks

£
£
£
£
£
£

Recompile selected trigger

Figure 20

- B SP_WATLABEL
B SP_WATNODE
B SP_WATNOTE
B SP_WATPIPE

SR MARC SP_WATPIPE

(3 MMA_SP_WATPIPE
[ MMS_SP_WATPIPE

Disable Trigger
Rebuild Trigger

Recompile Trigger

Collapse All
Expand All

Recompile selected trigger
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Rebuilding triggers

1

To rebuild a trigger, select the Rebuild Trigger option on the context-sensitive (right-click) menu
that is displayed when you right click on a trigger that belongs to spatial table in the Spatial Tables
branch of the Lineage tree.

Rebuild Trigger will rebuild and compile the trigger and associated views. The trigger will be rebuilt

using the same process as when creating a new trigger.

H Munsys Management Console (MCITY15INT)

File  Action Help

% Privilege
-y Tables/Views

- Lineage

% Spatial Tables
Reports

) Scheduled Tasks

Rebuild selected trigger

Figure 21

=B
=B
o5
=B

%

SP_WATLABEL
SP_WATNODE
SP_WATNOTE
SP_WATPIPE

3 MARC_SP_WATPIPE

98 1IMA_SP_WATPIPE

3 MMS_SP_WATP

Disable Trigger

SP_WATSYM |

Rebuild Trigger

Recompile Trigger

Collapse All
Expand All

Rebuild selected trigger
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Deleting monitor logs
The delete logs function can be used to maintain the amount of records in the
MUNSYS_MONITOR_LOG.

1  To delete monitor logs, select the Delete Logs... option on the context-sensitive (right-click) menu
that is displayed when you right click the Spatial Tables branch of the Lineage tree.

ﬁ Munsys Management Console (MCITY15INT)

File Action  Help
- Applications B SP_WATLABEL
-3 Locks g SP_WATNODE
135 Query Categories % SP_WATNOTE

i Security
% Privilege

B, SP_WATPIPE
- B SP_WATSYM

- Tables/Views
@, Lineage
% Spatial Tableg

Reports Add Lineage...
) Scheduled Tasks|  Delete Logs... |
Collapse All
Expand All

Delete existing lineage logs

Figure 22 Spatial Tables: Delete Logs

2 The Delete Logs dialog box will appear:

Delete Logs

Table
© All Tables

(O Specific Table

Operation

B Insert B Update

@ Delete B Spatial Update
Date

© All Dates

() Specific Date

Older than 6 Months

Older than 12 Months

Custom

18 September 2024

From:

To: 18 September 2024

User
© All Users

() Specific User

Cancel Help

Figure 23 The Delete Logs dialog box

Note  Different options are available to filter the records in this table before they are deleted. Records can be deleted

from specific tables, by specific operations, according to specific dates and by specific user.
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In the Table area, do one of the following:
Select the All Tables option to delete all the records for all the tables

Select a spatial table name from the Specific Table drop down list to delete records for
a specific spatial table.

In the Operation area, select one or more of the following check boxes (all operations are selected
by default):

Insert — deletes all operations of the type INS (Insert)

Delete — deletes all operations of the type DEL (Delete)

Update — deletes all operations of the type UPD (Update)

Spatial Update — deletes all operations of the type SPA (spatial update)

In the Date area, do one of the following:
Select the All Dates option to delete records from all dates
Select the Specific Date option to apply one of the following date filters:
Older than 6 months — will select logs older than 6 months from the current date.
Older than 12 months — will select logs older than 12 months from the current date.

Custom — specify your own dates by clicking on the calendar drop down and navi-
gating to a desired From and To date. The default From and To dates are set to the current
system date.

Delete Logs *
Delete Logs
Table
© All Tables
() Specific Table
Operation
Insert Update
Delete Spatial Update
Date
(O All Dates
© Specific Date
(O Older than 6 Months
() Older than 12 Months
© Custom

From: |01 September 2023 [B-]

To: 1 September 2023 3
Mon Tue Wed Thu Fri  Sat Sun

2 2 3 AN 23

User 4 5 & 7 8 9 10

1112 13 14 15 16 17

© Al Users 18 19 20 21 2 23 4

. ) 5 26 27 228 28 30 1

(O Specific User 5 3 4 5 5 - 3
[ Today: 18/09/2024

Figure 24 Delete Logs: Date Custom

Munsys Lineage

158



6  Inthe User area, do one of the following:
Select the All Users option to delete records of all users

To delete records for a specific user, select the Specific User option, and then select a
user from the list.

7  When you have selected all the appropriate filters, click Delete.

8  The Log delete confirmation dialog box is displayed, prompting for confirmation to delete the
records as specified.

Log delete confirmation

o Are you sure you want to delete the selected logs?

Figure 25  The Log Delete Confirmation dialog box

9  Click Yes.
The Logs Deleted dialog box will appear when the selected logs have been successfully deleted.

Logs Deleted X

o Selected logs have been successfully deleted.

Figure 26 The Logs Deleted dialog box

Running reports
Reports can be run to query the database for monitor or usage purposes:

Reports of type Monitor can be used to provide basic or detailed reporting, based on
operation type, user, table name and date of the operation.

Reports of type Usage can be used to show the license usage of the complete range of
Munsys applications, providing the administrator with the necessary records to evaluate the
license usage and detail of users logging on to the Oracle database and using any of the
Munsys applications.

All report queries are stored in the MUNSYS_MONITOR_REPORT table in the database.
Once a report has been run, the results can be saved to a CSV or text file.
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Note

The number of records output to the Munsys Management Console display for any of the monitor or usage
reports is limited to 10,000. If any of the reports return more than 10,000 records, a message is produced
indicating that the report process has stopped. The Administrator can continue to execute the report directly
from the database from the SQL command prompt and spool it to a file.

To run a report
1  Select the Reports branch of the Lineage tree to view the available reports.

A list of Monitor and Usage reports are displayed. The Description field is generally descriptive of
the specific query operation.

B Munsys ole (MCITY15INT = O
File  Action Help
E:Hi Applications D Type Description saL

EJ"'|@|§ Locks . 1 Monitor  Total Mumber of Records select reund{count(*),0) "Records" frem munsys_mo...
D?‘:j Quer}TCategones 2 Menitor Records for the past 24 Ho.,  select gid "GID", table_name "Table Name", decode(..
H-an ;e.u..llrlt)r 3 Monitor Records for the past Week select gid "GID", table_name "Table Name", decode(...
g% T:l:rll:s?'\feiews 4 Monitor Records for the past Month  select gid "GID", table_name "Table Name", decode(...
EI% Lineage 5 Monitor Grouped by Operation select round({count(*),0) "Records”, decode(operatio...
% Spatial Tables b Monitor Grouped by User Name select round(count(*),0) "Records", user_name "User ...

. Reports 7 Monitor Grouped by Month select round(count(*),0) "Records”, fmt_date "Date 5t...

03 Scheduled Tasks 8 Monitor Grouped by Table Name select round(count(*),0) "Records", table_name "Tabl...
g Monitor Grouped by Month and Q... select round({count(*),0) "Records”, fmt_date "Date St...

10 Monitor Grouped by Month and Us...  select round({count(*),0) "Records”, fmt_date "Date St...

i Maonitor Grouped by Month and Ta...  select round({count(*),0) "Records”, fmt_date "Date St...

12 Monitor Grouped by Month, Table ..  select round({count(*),0) "Records”, fmt_date "Date St...

13 Monitor Grouped by Month, Table ... select round{count(*),0) "Records”, fmt_date "Date St...

14 Monitor Grouped by Table Name, ... select round(count(*),0) "Records”, table_name "Tabl...

15 Monitor Grouped by Table Name, ... select reund{count(*),0) "Records", table_name "Tabl...

16 Usage Mumber of unique users p...  select count{c.users) "Unique Users”, to_char(to_date...

17 Usage MNurmber of applications us...  select count{c.app) "Unique Applications" , to_charft...

18 Usage Applications used per user...  select distinct(b.module_name) "Application Name",...

19 Usage Shared users (users with sa.. select b.user_name "User Name", substrib.machine_...

20 Usage Logged on users for the pa...  select user_name "User Name", substr{machine_nam...

Figure 27  Lineage Tree: Reports by Type

2 Torun areport, right click on an available report and select the Run Report option that appears on
the context-sensitive (right-click) menu.
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E Munsys Management Console (MCITY15INT)
File  Action Help
(P Applications D Type
{8 Locks i 1 Menitor
=5 Query Categories 2 Monitor
3 Menitor
4 Menitor
5 Menitor
% Spatial Tables b Manitor
Reports 7 Maonitor
8 Menitor
9 Monitor
10 Menitor
" Manitar
12 Menitor
13 Menitor
14 Monitor
15 Menitor
16 Usage
7 Usage
12 Usage
19 Usage
20 Usage
Execute and display report results.

Description

Total Mumbe

Records for the past 24 Ho...
Records for the past Week
Records for the past Month
Grouped by Operation
Grouped by User Name
Grouped by Month
Grouped by Table Name
Grouped by Month and O...

Grouped by Month and Us...

Grouped by Month and Ta...
Grouped by Month, Table ...
Grouped by Month, Table ...
Grouped by Table MName, ...
Grouped by Table MName, ...
Murnber of unique users p...

MNumber of applications us...

Applications used per user...

Shared users (users with sa...

Logged on users for the pa...

select gid "GID", table s

select gid "GID", table Edit Report... ...
select gid "GID", table x Delete Report ...
select round({count(*),0) "Records’, decode(operatio...

select round(count(*),0) "Records", user_name "User ...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round{count(*),0) "Records", table_name "Tabl...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round(count(¥),0) "Records”, fmt_date "Date St...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round{count(*),0) "Records", fmt_date "Date St...
select round(count(*),0) "Records”, table_name "Tabl...
select round{count(*),0) "Records", table_name "Tabl...
select count(c.users) "Unique Users”, to_char(to_date...
select count(c.app) "Unique Applications”, to_char(t..
select distinct{b.module_name) "Application Mame",...
select b.user_name "User Name", substr(b.machine_...

select user_name "User Name", substr(machine_nam...

Figure 28  Run Report selection

A dialog box will appear for the selected report displaying the results of the query.

For example, the report dialog box below displays Report Details for the total number of
Records recorded in the MUNSYS_MONITOR_LOG grouped by each OPEPRATION.

Grouped by Operation

Report Details

Operation

Insert

Spatial

Update

Figure 29 The run report dialog box

Once the report has been run, the results can be saved.
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3 Click Save... to save the results to a folder of your choice. Results can be saved as a CSV or text
file.

Save As

&« P » ThisPC » Local Disk (C:) » Munsys14.0 v O O Search Munsys14.0

A
Organize v New folder Bz - 0

[&] Pictures +n Mame Date Type Size Tags

@ OneDrive - Open ! @ Munsys 16/11/2020 10:59 AM Microsoft Excel C... 1KB
& ThisPC

¥ 3D Objects

‘> A360 Drive (dgo
[ Desktop

E Documents

; Downloads

J! Music

[&=] Pictures

B Vvideos

‘i Local Disk (C:)

= ftp (\\197.85.185
v

File names

Save as type: | £S5V files (*.e5v)

~ Hide Folders | Cancel

Figure 30  Saving a report
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Editing reports

1

H Munsys Management Console (MCITY13INT)

File  Action Help

Reports can be edited to specific user requirements so that only the desired information is
queried from the database.

To edit a report, right click on an available report and select the Edit Report option that appears on
the context-sensitive (right-click) menu.

Description

Total Mumber of Records

Records for the past 24 Ho..

Records for the past Week
Records for the past Month
Grouped by Operation
Grouped by User Name
Grouped by Month
Grouped by Table Name

Grouped by Month and O...
Grouped by Month and Us...
Grouped by Month and Ta...
Grouped by Month, Table ...
Grouped by Month, Table ...

Grouped by Table Mame, ...
Grouped by Table MName, ...

Murnber of unique users p...
MNurmnber of applications us...
Applications used per user...
Shared users (users with sa...
Logged on users for the pa...

50L

select round{count(™),0) "Records" frorpem e

select gid "GID", table_name "Table Na Run Report
select gid "GID", table_name "Table Na Edit Report...
select gid "GID", table_name "Table Ma| 3¢ Delete Report

select round({count(*),0) "Records”, decode(operatio...

select round(count(*),0) "Records”, user_name "User ...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round{count(*),0) "Records", table_name "Tabl...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round(count(¥),0) "Records”, fmt_date "Date St...
select round(count(*),0) "Records”, fmt_date "Date 5t...
select round{count(*),0) "Records", fmt_date "Date St...
select round(count(*),0) "Records”, table_name "Tabl...
select round(count(*),0) "Recerds”, table_name "Tabl...
select count(c.users) "Unique Users”, to_char(to_date...
select count(c.app) "Unique Applications”, to_char(t...
select distinct{b.module_name) "Application Name",...
select b.user_name "User Name", substr(b.machine_...

select user_name "User Name", substr(imachine_nam...

=38 Applications ID Type
D'"H_l, Locks . 1 Menitor
[+-35 Query Categories 2 Monitor
[y Security 3 Menitor
[j-.% Privilege 2
] 4 Monitor
[]..% Tables/Views
’ 5 Menitor
- Lineage .
% Spatial Tables 6 Mon?tor
Reports 7 Menitor
-2 Scheduled Tasks 8 Manitor
g Monitor
10 Menitor
11 Monitor
12 Meonitor
13 Meanitor
14 Monitor
15 Menitor
16 Usage
17 Usage
12 Usage
19 Usage
20 Usage
Edit existing report
Figure 31  Edit Report selection

The Edit Report dialog box will appear displaying the Report Type, Report Description and
Report SQL (statement) for the current report.
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Edit Report X

Report Details

Report Type: Monitor ~

Report Description:
Grouped by Operation

Report SQL:

select round(count(”).0) "Records”, decode

(operation,'DEL’, Delete” INS', Insert”, UPD",'Update’,'SPA’ "Spatial) "Operation” from
munsys_monitor_log group by operation order by operation

Figure 32 The Edit Report dialog box

2 Inthe Edit Report dialog box, the Report Type, Report Description and Report SQL are editable.
= Report Type: Click on the drop down menu to change the report type.
= Report Description: Click inside the text box to edit or change the report description.

= Report SQL: Click inside the text box to edit or change the report SQL statement.

Note  If the Report SQL is modified the statement will need to pass the Validate test before the changes can be
applied in the Edit Report dialog.
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Report SQL:

select round(count(*),0) "Records”, decode

(operation, ' DEL" Delete’, INS"‘Insert’,'UPD’", Update’ 'SPA’'Spatial’) "Operation” from
munsys_monitor_log group by operation order by operation

Figure 33 The Report SQL text box

= Click Validate to test the changes.

If the SQL is valid, the Report Validate Success dialog box will appear.

Report Validate Success

o Report SOL statement is valid.

Figure 34  The Report Validate Success dialog box

= Click OK to return to the Edit Report dialog box.

The Click OK button in the Edit Report dialog box is now active again.

= Click OK in the Edit Report dialog box to apply any SQL statement changes, or continue
making edits in the Edit Report dialog box.
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Adding reports

Reports can be created to query the database according to customised requirements.

1  To add a new report, select the Add Report... option that is displayed when you right click the
Reports branch of the Lineage tree.

Ei Munsys Management Console (MCITY15INT)

File Action  Help
[j--ﬁ Applications D Type
Dmﬂé Locks 1 Menitor
@35 Query Categories
,\.3 ry 9 2 Maonitor
-y Securty 3 Meonitor
[j--% Privilege X
. 4 Monitor
[j--% Tables/Views X
. 5 Meonitor
[—j% Lineage .
% Spatial Tables & Monitar
7 Monitor
|— Add Report... Monitor
Collapse Al Menitor
Meonitor
Expand All Monitar
12 Monitor
13 Monitor
14 Monitor
15 Meonitor
16 Usage
17 Usage
18 Usage
19 Usage
20 Usage
Creates a new report record
Figure 35  Add Report selection

Description

Total Number of Records
Records for the past 24 Ho...
Records for the past Week
Records for the past Month
Grouped by Operation
Grouped by User Name
Grouped by Month
Grouped by Table Name
Grouped by Month and Q...
Grouped by Month and Us...
Grouped by Month and Ta...
Grouped by Month, Table ...
Grouped by Month, Table ...
Grouped by Table Mame, ..
Grouped by Table Mame, ...
Mumber of unique users p...
Mumber of applications us...
Applications used per user..,
Shared users (users with sa...
Legged on users for the pa..

saL

select round(count(*),0) "Records” from munsys_mo...

select gid "GID", table_narne "Table Name", decode(...
select gid "GID", table_name "Table Name", decode(...
select gid "GID", table_name "Table Name", decode(...

select round(count(¥),0) "Records"”, decode(operatio...

select round({count(*),0) "Records", user_name "User ...
select roundicount(*),0) "Records”, fmt_date "Date St...
select round(count(*),0) "Records", table_name "Tabl...
select round{count(*),0) "Records”, fmt_date "Date 5t...
select round({count(*),0) "Records", fmt_date "Date St...
select round{count(*),0) "Records", fmt_date "Date St...
select round{count(*),0) "Records", fmt_date "Date St...
select round({count(*),0) "Records", fmt_date "Date St...
select round{count(*),0) "Records"”, table_name "Tabl...

select round(count(*),0) "Records", table_name "Tabl...

select count(c.users) "Unigue Users”, to_charite_date...

select count{c.app) "Unique Applications", to_char(t...

select distinct{b.module_name) "Application Name",...

select b.user_name "User Mame", substr{b.machine_...

select user_name "User Name", substr{imachine_nam...

The Add Report dialog box will appear:

Add Report

Report Details

Report Type

Report Description:

Report SQL:

Validate

Help

Figure 36

The Add Report dialog box
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In the Report Type drop down of the Add Report dialog box, select a report type or create a new
report type/category by typing in the drop down area.

In the Report Description area, briefly describe the report. For example, “Grouped by Month and
Operation”.

In the Report SQL area, include the SQL statement that will be used to generate the report.

The OK button in the Add Report dialog box will only become available once the Report SQL
statement has passed the Validate text.

Click on the Validate button to test the validity of the SQL statement in the Report SQL field.
If the SQL statement is valid, the Report Validate Success dialog box will appear.

Report Validate Success X

o Report SOL statement is valid.

Figure 37 The Report Validate Success dialog box

Click OK in the Report Validate Success dialog box.
Click OK in the Add Report dialog box to create the report.

The report will appear in the right hand side window when the Reports branch of the Lineage tree
is selected.
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Deleting reports

Reports can be deleted if they are unused or no longer required.

1  To Delete a report, right click on a report and select the Delete Report option that appears on the
context-sensitive (right-click) menu.

ﬁ Munsys Management Console (MCITY13INT)

File Action  Help

@-(F Applications
-3 Locks

[#-35 Query Categories
[j...gy Security

[j--% Privilege

By Tables/Views
[-j% Lineage

: % Spatial Tables
Reports
Scheduled Tasks

Delete existing report

(=T == - B A —

[ —
T R ]

13

Type

Monitor

Meonitor
Monitor
Monitor

Meonitor
Meonitor
Meonitor
Monitor
Monitor
Meonitor
Meonitor
Meonitor
Meonitor
Monitor
Maonitor
Usage
Usage
Usage
Usage
Usage

Descripticn

Total Mumber of Records select round(count(*),0) "Records” from munsys_mo...
Records for the g Run Report 0", table_name "Table Name", decode(...
Records for the g Edit Report... J", table_name "Table Name", decodef...

saL

Records for the [:|x Delete

Grouped by Operamon
Grouped by User Name
Grouped by Month
Grouped by Table Mame
Grouped by Month and O...

Grouped by Month and Us...
Grouped by Month and Ta...

Grouped by Month, Table ...
Grouped by Month, Table ...
Grouped by Table Mame, ...
Grouped by Table Mame, ...

Mumber of unique users p...
Mumber of applications us...
Applications used per user...
Shared users (users with sa...
Logged on users for the pa..

select round({count(*),0) "Records", user_name "User ...
select round({count(*),0) "Records", frmt_date "Date St...
select round{count(*),0) "Records”, table_name "Tabl...
select round{count(*),0) "Records”, fmt_date "Date 5t...
select round{count(*),0) "Records”, fmt_date "Date 5t...
select round({count(*),0) "Records", frmt_date "Date St...
select round({count(*),0) "Records", frmt_date "Date St...
select round({count(*),0) "Records", frmt_date "Date St...
select round{count(*),0) "Records”, table_name "Tabl...
select round{count(*),0) "Records”, table_name "Tabl...
select count(c.users) "Unique Users", to_char(to_date...
select count(c.app) "Unique Applications" , to_char(t...
select distinct(b.module_name) "Application Name",...
select b.user_name "User Name", substr{b.machine_...

select user_name "User Mame", substrimachine_nam...

Figure 38

Delete Report selection

The Report delete confirmation dialog box will appear:

Records'?

Report delete confirmation

o Are you sure you want to delete report ‘Total Number of

2 Click Yes in the Report delete confirmation dialog box to delete the selected report.

The selected report will be deleted.
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Chapter 12
Munsys Scheduled Tasks

Introduction

Munsys allows users to set up and manage regular scheduled database tasks. The scheduled
task will run a Procedure and can pass a range of Parameters with their values (Key / Value
Pairs) to the procedure. Tasks can be scheduled to run on a Daily, Weekly or Monthly basis.

This chapter is divided into the following sections for easy reference:

Adding Scheduled Task
Editing Scheduled Tasks
Deleting Scheduled Tasks
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Enabling Scheduled Tasks

In the event Scheduled Tasks are not enabled, the administrator user will see the below message
when selecting the Scheduled Tasks option in the Tree pane.

[ von

File  Action Help

= § Applications

B ﬂ Locks
33 Query Categories
& ;!‘ Security
£ q-h Privilege Munsys Scheduled Tasks is currently disabled. Please enable
- % Tables/Views this setting in "Schema Properties’.

] % Lineage
"l Scheduled Tasks
oK

Figure 1 Scheduled Tasks Disabled message

Scheduled Tasks can be enabled and disabled from within the Schema Properties dialog box.
The Scheduled Tasks tree branch only becomes active and functional once it has been enabled
for a schema. Alternatively, when Scheduled Tasks is not enabled, all functionality is disabled
and cannot be modified in the Scheduled Tasks tree branch of the Munsys Management
Console.

When Enabling Scheduled Tasks the administrator must also set the time the scheduled task is
to run. To enable / disable Lineage and for more information, please refer to the chapter on
Schema management.

Properties X

General Schema Lineage Scheduled Tasks

Munsys Scheduled Tasks
@ Enable Scheduled Tasks

Set Process Time: ‘01:00 v|

00:00 I

i} 0200
equies Create Job'F 3,00
04:00
05:00
06:00
07:00
08:00
09:00
10:00
11:00
12:00
13:00
150 Help
1 16:00
17:00
18&:00
19:00
20:00
21:00
22:00
23:00

Figure 2 Enabling Scheduled Tasks on Schema Properties

Munsys Scheduled Tasks
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Adding Scheduled Tasks

Scheduled Tasks can be created to automate the running of regularly scheduled tasks.

Clicking on Scheduled tasks in the Munsys Management Console tree displays existing
scheduled tasks (if any).

B3 Muns ent Console (MCITY15INT = (]
File  Action Help
@ Applicaticns D Description Enabled Schedule Name Values Priority
93 Locks c 1000 Log Attribute Changes for SPWATPIPE ¥ Daily MP_ADLOG_POPULATE  SP_WATPIPE 1
& 1,? ?”e':” ategories 1001 Log Attribute Changes for SP_WATNODE ¥ Daily MP_ADLOG_POPULATE  SP_WATNODE 1
EE': PZ:I:“’E 1002 Log Attribute Changes for SP_WATSYM Y Daily MP_ADLOG_POPULATE  SP_WATSYM 1
1 Tablajwiews 1003 Log Attribute Changes for SP_WATLABEL ¥ Daily MP_ADLOG_POPULATE  SP_WATLABEL 1
B Lineage 1004 Log Attribute Changes for SPWATNOTE ¥ Daily MP_ADLOG_POPULATE  SP_WATNOTE 1
1005 Log Attribute Changes for SPWATNOTE ¥ Daily MP_ADLOG_POPULATE  SP_WATNOTE 1

Iy Scheduled Tasks

Figure 3 Munsys Management Console: Scheduled Tasks

1  To add a new Scheduled Task right-click on the Scheduled Tasks node in the tree or using the
Action menu or context-sensitive (right-click) menu that is activated when an item is selected and
select the Add Scheduled Task...option.

Bl Munsys Management Console (MCITY15INT) = o *
File Action  Help
E Applications 1o} Description Enabled Schedule MName Values Priority
95 Locks ) 1000 Log Attribute Changes for SP WATRIPE Y Daily MP_ADLOG_POPULATE  SP_WATPIPE 1
?”e'?f Categories 1001 Log Attribute Changes for SP_WATNODE ¥ Daily MP_ADLOG_POPULATE  SP_WATNODE 1
EE': nf.(vL.Telwe 1002 Log Attribute Changes for SE_WATSYM ¥ Daily MP_ADLOG_POPULATE  SP_WATSYM 1
= Tablejvws 1003 Log Attribute Changes for SP_WATLABEL ¥ Daily MP_ADLOG_POPULATE  SP_WATLABEL 1
B Lineage 1004 Log Attribute Changes for SP_WATNOTE ¥ Daily MP_ADLOG_POPULATE  SP_WATNOTE 1
1005 Log Attribute Changes for SPWATNOTE ¥ Daily MP_ADLOG_POPULATE  SP_WATNOTE 1

| AddScheduled Task..

Collapse All
Expand All

Creates a new scheduled task.

Figure 4 Add Scheduled Task

The Add Scheduled Task dialog is displayed:
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0 N & W

MNew Munsys Scheduled Task *

Scheduled Task

Task Description: |

Scheduled Task Procedures:

Procedure Parameters:

Parameter Name Parameter Value

Modify

Priority: 1 Task Enabled
Schedule
(® Daily () Weekly O Monthly

(o ][

Figure 5 Add Scheduled Task dialog box

In the Scheduled Task Description area, briefly describe the Scheduled Task. For example, ‘Run
Asset Management Update’.

In the Scheduled Task Procedures drop down of the Add Scheduled Task dialog box, select a
Scheduled Task Procedure. These are procedures that are part of the
MUN_SCHEDULED TASKS PACKAGE. To add new Scheduled Tasks Procedures this package
must be edited. Please contact Open Spatial before editing the package.

In the Scheduled Task Parameters area, a list of Parameters will be loaded depending on the
selected Procedure. Modify the Parameters to obtain the desired outcome.

Set the Priority Value — 1 is the default value.

If all the values are correct, select the Task Enabled option.

Set the Task interval: Daily, Weekly or Monthly.

Click OK in the Add Scheduled Task dialog box to create the Scheduled Task.
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Editing Scheduled Tasks
Scheduled Tasks can be run to facilitate easy and regular maintenance and management jobs
in Oracle.

1  To edit a Scheduled Task, right click on an available Scheduled Task and select the Edit
Scheduled Task option that appears on the context-sensitive (right-click) menu.

Bl Munsys Management Console (MCITY15INT) — (m} *
File Action  Help

- Applications D Description Enabled Schedule Mame Values Priority

‘fnﬂ Locks

1000 Log Attribute Changes for SP_WATPIPE Y Daily MP_ADLOG_POPULATE SP_WATPIPE
-33 Query Categories

i
o 1001 Log Attribute Changes for SP_WATNODE Y Daily MP_ADLOG POPULATE  SP_WATNODE 1
*”ﬁ F:“I":“; 1002 Log Attribute Changes for SP_WATSYM Y Daily MP_ADLOG_POPULATE  SP_WATSYM 1
@

< E Tabfesf'\l’rews 1003 Log Attribute Changes for SP_WATLABEL Y Daily MP_ADLOG_POPULATE  SP_WATLABEL 1
;‘ m Lineage Log Attribute Changes for SP_WATNOTE i ity MP ADLOG_POPULATE  SP_WATNOTE 1
@ Scheduled Tasks 1005 Log Attribute Changes for SP_WATN| Add Scheduled Task... | ADLOG_POPULATE  SP_WATNOTE 1

Edit Scheduled Task...

3¢ Delete Scheduled Tack...

Deletes an existing scheduled task.

Figure 6 Edit Scheduled Task

The Edit Munsys Scheduled Task dialog is displayed:

Edit Munsys Scheduled Task X

Scheduled Task

Task Description: |Log Attribute Changes for SP_WATNOTE |

Scheduled Task Procedures:
MP_ADLOG_POPULATE v |

Procedure Parameters:

Parameter Name Parameter Value
P_TAB_NAME SP_WATNOTE

Modify

Pioty: [ 1] Task Enabled

Schedule
@ Daly O Weeky O Monthly

T

Figure 7 Edit Munsys Scheduled Task
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2 In the Edit Scheduled Task dialog box, the Scheduled Task parameters are editable.

Task Description: Click inside the text box to edit or change the Scheduled Task

description.
Task Procedure: Click on the drop-down menu to change the Scheduled Task Procedure

Procedure Parameters: Click on the parameters and then click Modify to edit or change
the Scheduled Task Parameters.

Priority — If more than one Scheduled task is available for a table, this will allow users to
set the order in which the tasks are executed.

Task Enabled — Allow users to enable or disable a scheduled task.
Schedule — Allows the task to be run on a Daily, Weekly or Monthly

3  Click OK to save changes to the Edit Scheduled Task.

Deleting Scheduled Tasks

Custom Scheduled Tasks can be deleted if they are unused or no longer required. Some tasks
are managed by other tools with the Munsys application and these cannot be deleted.

1  To Delete a Custom Scheduled Task, right click on a Scheduled Task and select the Delete
Scheduled Task option that appears on the context-sensitive (right-click) menu.

t_‘i Munsys Management Console (MCITY15INT) - m]
File Action  Help
+|§ Applications D Description Enabled Schedule Name Values Priority
@ I"-:E Kok ) 1000 Log Attribute Changes for SP_WATPIPE ¥ Daily MP_ADLOG POPULATE  SP_WATPIPE 1
i 14 SQ“”"_' Falegorier 1001 Log Attribute Changes for SP_WATNODE ¥ Daily MP_ADLOG_POPULATE  SP_WATNODE 1
'_*; Eff P:‘Vi:t’a 1002 Log Attribute Changes for SP_WATSYM Daily MP_ADLOG_POPULATE  SP_WATSYM 1
:% Table:“ews 1003 Log Attribute Changes for SP_WATLABEL Daily MP_ADLOG_POPULATE  SP_WATLABEL 1
- B Lineage Log Attribute Changes for SP_WATN y Daity MP ADLOG_POPULATE  SP_WATNOTE 1
il & Scheduled Tasks 1005  Log Attribute Changes for SP_WATN Add Scheduled Task... | ADLOG_POPULATE  SP_WATNOTE 1
1 Edit Scheduled Task...
(% Delete Scheduled Task...
Deletes an existing scheduled task.
Figure 8 Delete Scheduled Task
The Delete Scheduled Task confirmation dialog box will appear:
Delete Scheduled Task
0 Are you sure you want to delete the scheduled task: ‘10077
Deleting the scheduled task cannot be undone.
Figure 9 Delete Scheduled Task notification
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If the task you selected to delete cannot be deleted from this dialog, a message will be shown

indicatin

g where to edit that scheduled task.

<

Delete Scheduled Task - Lineage X

Scheduled task is managed by Lineage and cannot be
deleted.

Please use Lineage to configure this.

Figure 10

Cannot Delete Scheduled Task notification
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